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Introduction / How To Use This Manual 
 
GypsES System Overview 
GypsES (Gypsy Moth Expert System) is a computerized decision support system developed by the 
USDA Forest Service for natural resource managers in federal, state, and local pest management 
programs. GypsES provides decision support tools that help you evaluate your pest management 
situation and make better decisions. GypsES’ geographic information system (GIS) lets you create 
and analyze complex map sets as well as digitize maps using topographic map backdrops or aerial 
photography. GypsES operates under the WindowsNT® operating system. Although GypsES was 
developed to support gypsy moth management programs, it can be used for other pest and nonpest 
resource management programs. Some practical applications of GypsES include: 
 
��Drawing treatment blocks using topographic map backdrops (Section 7) 
��Editing or viewing egg mass or pheromone trap data (Section 10) 
��Predicting defoliation (Section 10) 
��Creating, editing, or viewing treatment block GIS layers (Section 11) 
��Predicting insect development stage to determine a treatment schedule (Section 11) 
��Predicting spray deposit, drift, and efficacy of treatment (Section 11) 
��Uploading/downloading treatment blocks to and from aircraft navigation systems via GPS files 

(Section 11) 
��Displaying spray lines over treatment areas (Section 11) 
��Evaluating treatment effectiveness using defoliation, egg mass, or trap data (Section 11) 
��Overlaying defoliation and treatment areas (Section 11) 
��Overlaying pheromone trap data and treatment areas (Section 11) 
 
The Geographic Information System 
A geographic information system (GIS) provides an organized method of entering, developing, 
and displaying geographically referenced data in one or more map layers. A GIS gives you a visual 
representation of data because each map layer represents a data element that can be viewed as a 
picture rather than a table of values. A GIS also gives you the ability to create, edit, and delete 
geographically structured data, link locational data to data tables, analyze data from a geographical 
perspective, and visually display data. 
 
GypsES uses formats from a GIS system called GRASS (Geographic Resources Analysis Support 
System). GRASS is a GIS system developed by the U.S. Army Construction Engineering Research 
Laboratories (USACERL). GypsES currently uses GRASS version 4.0, which was released in May 
1991. Considerable enhancements have been made to the basic GRASS formats. 
The Database 
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GypsES maintains database information in *.dbf files. These files can be created by many of the 
commonly used PC database systems including dBaseTM , Microsoft AccessTM and the ESRI ARC 
shape files. The GypsES database is capable of reading *.dbf files created internally or imported 
from an outside program. 
 
How To Use This Manual 
This manual has 11 sections that describe GypsES and its menu options. Section include an 
Introduction and How To Use This Manual (Section 1), Running GypsES in the WindowsNT® 
Environment (Section 2), Using GypsES (Section 3), The GypsES Main Screen (Section 4), GypsES 
Mapping Concepts (Section 5), and the six primary menu bar options (Sections 6-11). Each of the 
last six sections lists all functions in that option in the order that they appear within pull-down 
menus. For reference, there is also a standard names list (Appendix A), color chart (Appendix B), 
references (Appendix C), credits and acknowledgments (Appendix D), and a glossary and index. 
 
User Tips 

 
Section 5 (GypsES Mapping Concepts)         Page  
Categories in Raster Files.........................................................................................................5-7 
Categories in Vector Files.........................................................................................................5-9 
 
Section 6 (The File Menu)           Page  
How A Mask Layer Might Be Used with Raster Reporting.....................................................6-38 
Merging Categories.................................................................................................................6-11 
ΑWhat are TIFF and JPEG files?≅ ........................................................................................6-41 
ΑWhat is a DXF file and how might it be used?≅ ...................................................................6-18 
ΑWhat is a surface?≅ ..............................................................................................................6-13 
When to Make A New Location ...............................................................................................6-49 
ΑWhy use a data link?≅ ............................................................................................................6-4 
Working With Reclassified Raster Map Layers.........................................................................6-9 

 

Shaded boxes containing User Tips that describe concepts and provide helpful tips occur 
throughout the manual. An icon in the left margin designates them. All User Tip titles are 
listed below in alphabetical order within each section: 
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Section 7 (The Edit Menu)           Page 
Changing the Resolution of A Raster File...............................................................................7-15 
Creating and Changing Colors...............................................................................................7-38 
“What is the difference between labels and the label display 
options for Vector and SiteData files?”..................................................................................7-34 
 
Section 8 (The Window Menu) 
Fixed and Variable Site Display ...............................................................................................8-7 
Map Background Color.............................................................................................................8-2  
Work Window Composite Files .................................................................................................8-3  
 
Section 10 (The Survey Menu) 
Trap ID Duplication..............................................................................................................10-12 
“What is a delimiting grid?” ..................................................................................................10-9  
“What is a surface?”...............................................................................................................10-2 
 
Manual Conventions 
 
��Bold text introduces words and phrases that are defined either in the Glossary or immediately 

following the use of the word or phrase. For example: feature lines and volatile fraction. 
 
��Bold Italic text designates all GypsES primary menu bar options, pull-down menu buttons, and 

push buttons. For example: File, File Control, and Accept. 
 
��Italic text is used for dialog box titles and to emphasize important words. Notes to the reader are 

also in Italics. For example: Graphics Output Setup dialog box, with caution, and [Note: GypsES 
only imports lines that intersect your current location’s boundaries.] 

 
��Double quotation marks (“ ”) are used to indicate push button palette titles, messages from 

GypsES, headings within a GypsES dialog box, and occasional terminology. For example: “Trap 
Database” palette, “Congratulations! You have reclassed...”, “Select SiteData File” and “cookie 
cutter,” respectively. 

 
��Characters to be typed are enclosed in box brackets [ ].  For example: Type [y]. 
 
��Keys and key sequences appear enclosed in angled brackets < >. For example: Press <Enter>. 
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Running GypsES in the WindowsNT® Environment 
 
GypsES was originally developed under the UNIX operating system. At the beginning of the GypsES 
project in the early 1990’s, UNIX was the only operating system that supported a public-domain GIS 
system (GRASS). By choosing UNIX, early GypsES developers hoped to avoid burdening GypsES 
users with the expense of purchasing a GIS system.  For several years, GypsES was used on personal 
computers using a “dual-boot” environment. Users could run GypsES under UNIX or boot to 
Windows and use word processing, spreadsheet, and other PC productivity software. This was 
certainly an inconvenience, and as time went on, problems with obtaining drivers for new hardware 
in PC-based UNIX multiplied.   

 
The Move to WindowsNT 
By 1998, the GypsES program consisted of over 250,000 lines of programming code, compiled into 
a single executable file. To modify this code to execute in the native Windows environment would 
have been a massive job, taking years. GypsES developers therefore turned to a software tool from 
Data Focus, Inc. called Nutcracker. The Nutcracker system provides a development environment that 
enables programs written for UNIX to be compiled in WindowsNT, creating a Windows ‘exe’ file. 
When run in WindowsNT using the Nutcracker Operating Environment, GypsES behaves almost 
exactly as it did in UNIX. The Operating Environment (OE) provides dynamic link libraries and 
other mechanisms to handle such things as differences in path names, calls to system commands, etc.  

 
The Nutcracker Operating Environment 
When installed, the Nutcracker OE is started as a “service” within the NT system. It does not affect 
any other Windows applications. You will probably not be able to tell it is there. There is a 
Nutcracker icon in your WindowsNT control panel that, if clicked, gives you some version and status 
information, but you probably won’t ever have to do anything with it. 
 
The XVision X-Server 
In addition to the Nutcracker service, GypsES must run with an X-Server because GypsES uses the 
X-Windows system to display graphics. Again, converting to native Windows graphics would entail 
an enormous programming effort, so an X-Server is necessary. We are presently distributing the X-
Vision Server from Santa Cruz Organization (SCO) as part of the Nutcracker Operating 
Environment. Other X-Servers are available and, in theory, any one of them should work. Basically, 
an X-Server runs as a separate service in NT, much as it did in UNIX. The GypsES program passes 
commands to the X-Server, and the X-Server displays the GypsES Main Screen window and dialog 
boxes, passing both keyboard entry and mouse click responses you make back to GypsES. The X-
Vision X-Server as installed usually starts up when you log on. You know that it is running if you 
see a green ‘XV’ next to the time display in the lower right-hand corner of your screen. If it isn’t 
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running when you log on, it starts when you double-click the GypsES icon. All X-Servers require 
that the Network TCP/IP module be installed. When you set your NT system up, be sure to install 
Networking, even if you don’t have a network card or a modem. (See the Appendix on Installation 
for more details.) Three icons in the WindowsNT control panel represent the X-Vision server 
controls. As with the Nutcracker icon, you probably won’t need to do anything with them. 
 
Directory and File Structure for GypsES in WindowsNT 
GypsES is installed on one of your hard disks as a main directory, X:\Gypses, where X is the drive 
designation. A system variable, “GYPSES_DIR” is set to this path. There are two sub-directories in 
this directory (Fig. 2-1): 

 

GypsES/NT File System

Fixed or 
Removable
Drives

GypsES

GypsES

System_Files

Data_Files

Data_Files

Additional GypsES Location Folders

GypsES Location Folders

(No GypsES files on this drive)

(Main Folder)

(GypsES Program and settings files)

Your
Computer

Figure 2-1. Illustration of the GypsES/NT file system. 



GypsES User’s Manual v1.0             Section 2: WindowsNT® 

 2-3 GypsES: Decision Support and Project Mgt.  

��System_Files: This directory contains all GypsES programs and control information for GypsES. 
You should normally not change anything in this directory. GypsES upgrades usually replace the 
contents of this directory. 

��Data_Files: This directory contains your GypsES GIS location data. Each location you establish 
in GypsES creates a sub-directory with the location name and all information for that location.  
 

[Note:  The terms “directory” and “folder” are used synonymously.] 
 
You can store location data on other drives in your system, even removable volumes. GypsES checks 
all system drives for the directory path X:\GypsES\Data_Files. It automatically recognizes any 
location data contained on any drive with this path. When you establish a new location in GypsES, 
you are asked to designate a drive. If the drive you designate does not currently have a 
\GypsES\Data_Files directory, it is created. You can move location directories from one drive to 
another using the following procedure in Windows Explorer:   

  
��If the drive you want to move location information to does NOT have a GypsES\Data_Files 

folder, you can make one. Just click on the drive, then click the File menu option and select New 
/ Folder. A folder will appear under the drive with the words “New Folder” highlighted. Just 
type [GypsES] and press <Enter>. Create the Data_Files folder the same way by clicking on the 
GypsES folder and then clicking on File, New, and Folder and typing [Data_Files]. 

 
��Once the GypsES\Data_Files folder is in the drive where you want your location folders, click on 

the location folder you are moving and drag it over to the Data_Files folder on the destination 
drive while holding the mouse button down. Be sure the Data_Files folder is highlighted before 
you lift your finger off the mouse button; Windows Explorer then moves the folder to the drive. 

 
Be sure that the location directory gets moved to a X:\GypsES\Data_Files directory so that the 
information is available when you start GypsES. It is a good idea to NOT make changes within a 
location folder outside of GypsES. The file organization within the folder is somewhat complex, the 
files may be inter-related, and some of the data is in non-ASCII files.   

There may be some special image directories within a GypsES Data_Files folder that do not show up 
as a location within GypsES. These directories are named ‘ImagesZoneXX’, where XX is a UTM 
zone designation. These directories contain backdrop images imported using the File menu / Import 
option / Import Image Backdrops option (see page 6-24 in Section 6). Images in these directories are 
available to any location whose UTM zone matches the zone and whose boundaries overlap images 
in the directory. Typically, smaller scale images, such as 1:250,000 backdrops, can be stored in these 



Section 2: WindowsNT®  GypsES User’s Manual v1.0 

GypsES:  Decision Support and Project Mgt.   2-4 

directories and used by multiple locations. This is a more efficient use of disk space when your 
installation consists of several contiguous locations, such as multiple counties within a state. 
   
Using WindowsNT 
This manual cannot provide detailed information on using WindowsNT. In many ways, WindowsNT 
is similar to Windows 95/98. Many useful books that describe the WindowsNT operating system are 
available at bookstores or can be ordered through the Internet. The help system available from the 
Windows Start menu may provide some assistance. We have found that most software that runs on 
Windows 95/98 also runs under WindowsNT. You are most likely to encounter problems with 
hardware drivers. In most cases the hardware vendor can provide WindowsNT drivers that can 
usually be downloaded from the Internet. As Microsoft evolves their operating systems into 
Windows 2000 (which was renamed from WindowsNT 5.0), the problems with drivers should 
disappear. 
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Using GypsES  
 
GypsES Startup 
When you double-click the GypsES (tree) icon, an MS-DOS window first appears. This window 
displays a few startup messages before the GypsES window comes up. If GypsES doesn’t start up, 
this window may indicate what the problem is. This initial window stays on the desktop while 
GypsES is active and is there when you exit with the message “Press any key to continue.” When 
you select this window and press any key, it goes away. If GypsES hangs up, or if you want to abort 
GypsES in the middle of a long process, select this window and cancel GypsES either by typing 
<Control C> or by clicking the “x” box in the upper right hand corner. If GypsES aborts, a message 
in this window may indicate the problem. Please make a note of the message and what you were 
doing at the time and let a GypsES programmer know so that bugs can be tracked and fixed. 
 
Main Screen 
GypsES has a Main Screen for working with map layers and files, a primary menu bar across the top 
with pull down menus and sub-menus, and a status bar at the bottom of the screen that displays 
processing and informational messages. (See Section 5 for more information about the GypsES Main 
Screen.) When an option is selected in the primary menu bar, a pull-down menu of options (buttons) 
appears (e.g., File Control, Create New, and Save are some of the pull-down menu buttons that 
appear when the File option is selected). Some pull-down menu buttons contain other pull-down 
menus; these are indicated with a | (Fig. 3-1). 
 
 

 
 

Figure 3-1. Illustration of pull-down menu buttons. 
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Dialog Boxes 
Dialog boxes appear on the screen as you work with GypsES. A dialog box has two characteristics: 
(1) you can click on the bar at the top and drag it to another location by holding down the left mouse 
button, and (2) you must respond to or exit the dialog box before you can use other GypsES 
functions.   
 
Some dialog boxes simply tell you about an action you need to take or condition that GypsES has 
encountered. More complex dialog boxes may contain several types of objects, including text entry 
windows, toggle buttons, push buttons, and choice buttons. 
 
��Text Entry Windows 

Text entry windows look like slightly indented rectangles (Fig. 3-2). To enter text, click inside 
the rectangle; this activates a blinking cursor (vertical I) that indicates where the next character 
you type will be inserted. To over-write text in the text entry window, first use the mouse pointer 
to highlight the text you want to over-write. Anything you type then replaces the highlighted text. 
The <Backspace> key deletes the character to the left of the cursor. The <Delete> key deletes the 
character to the right of the cursor. If text is highlighted, the <Delete> key deletes it. To insert 
text, place the cursor where you want to insert text and type. Note that there is usually a limit on 
the number of characters allowed in a text entry window. If you try to insert or add more text 
than allowable, you hear a computer “beep” and the text is not added. 
 

 

Figure 3-2.  Illustration of text entry windows 
(“Layer” and “Title”) in the Reclass dialog box. 
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��Toggle Buttons 
Toggle buttons appear next to a text label describing a choice. The button appears to be “pushed 
in,” or indented, when you choose the option. If only one option is available (the button is either 
clicked or not) (Fig. 3-3) or if multiple options can be chosen and processed (Fig. 3-4), the button 
appears as a square.  If multiple choices are available but only one can be chosen and processed, 
the button is displayed as a diamond (Fig. 3-5). 
 

 
 

 
 
Figure 3-4.  Illustration of multiple choice, square 

toggle buttons in the Raster Layer Area Report 
Definition dialog box. 

Figure 3-5.  Illustration of diamond toggle buttons in 
the Reclass dialog box. 

Figure 3-3.  Illustration of a one-choice, square toggle button 
(“Display Site Label”) in the Site Display Options dialog box. 
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��Push Buttons 
Push buttons are rectangles that appear to stand out from the dialog box and have one or 
more words describing the action that occurs if you click them (Fig. 3-6). A palette is a group 
of push buttons that remains on the GypsES screen while a specific GypsES function is being 
used (Fig. 3-7). 

 
 

 
 

 

Figure 3-6. Illustration of push buttons at the bottom of a dialog box. 

Figure 3-7. Illustration of the “Spray Advisor” 
palette of push buttons. 
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��Choice Buttons 
Choice buttons are either downward-pointing arrows (for text choices) or small rectangles (for 
either text or color choices) (Fig. 3-8). When you click on the arrow or rectangle, possible 
choices are displayed in a list bar. Once you click on something in a list bar, the bar disappears 
and your choice is displayed in the dialog box. 
 

 
GypsES File Names 
GypsES file, mapset, and location names are limited to 14 characters. Database and SiteData file 
names are limited to 10 characters. If a file is created outside GypsES with more than 14 characters, 
it is NOT recognized. 
 
GypsES Window Size and Color 
These options can be changed using the Edit menu / Administrative Profile option / User Profile 
option / Global dialog box (see pages 7-40 and 7-41 for changing screen dimensions and 
background/text colors, respectively). 
 
Backups 
The Archive option has been removed from the GypsES File menu in the WindowsNT version. Use 
the WindowsNT operating system backup facility (Start / Programs / Administrative Tools / 
Backup) to back up your data onto tape (if you have a tape drive), copy your data to removable 
media using Windows Explorer, or utilize a network to make copies of your data folders on another 
system. The need to have a systematic backup process is essential; bad things happen at the least 
convenient times, and it is best to be prepared. 

Figure 3-8.  Illustration of both arrow and rectangle choice 
buttons in the MapEdit: Vector Edit Options dialog box. 



GypsES User’s Manual v1.0     Section 4: The GypsES Main Screen 

 4-1 GypsES: Decision Support and Project Mgt.  

The GypsES Main Screen 
 
The GypsES Main Screen has a primary menu bar across the top, a work area (Work Window) in the 
middle, and a status bar and information / settings bar across the bottom (Fig. 4-1). The primary 
menu bar has the following buttons: File, Edit, Window, Forest, Survey, Treatment, and Help. Each 
button is described in a separate section of this manual (with the exception of Help, which is 
described later in this Section). 
 

Primary 
Menu 
Bar

Legend 
Area

Information/ 
Settings 

Bar

Work 
Window #

Geographic 
Coordinates 

of the Current 
Cursor 

Position

Help 
Button

Work 
Window

Info 
Button

Output 
Mapset

Location Geographic 
Coordinate 

System

Status Bar

Figure 4-1.  GypsES Main Screen components. 



Section 4: The GypsES Main Screen  GypsES User’s Manual v1.0 

GypsES:  Decision Support and Project Mgt.   4-2 

The status bar near the bottom of the screen is a message area that turns yellow when messages 
pertinent to what you are doing are displayed. The information / settings bar just below the status bar 
displays (from left to right) the current location and output mapset names and the Work Window 
number. It also displays the geographic coordinate system being used, the geographic coordinates of 
the current cursor position when the cursor is on a map in a Work Window, and the Info button. The 
location, mapset, Work Window number, and geographic coordinate system can be changed by 
clicking on the respective button in the information / settings bar and choosing the item you want 
from the list that appears in the dialog box. For location and mapset changes, click on Accept to 
complete the new selection or on Cancel to keep the current selection. 
 
The Menus 
To access any of the seven main functions in the primary menu bar at the top of the GypsES Main 
Screen, move the mouse pointer (arrow) to the button you want and click once. A pull-down menu of 
options appears. There are two types of menu option buttons: 
 
��Plain Menu Buttons perform the function defined by the label. 
 
��Menu Buttons with a triangle (|) to the right of the label produce another pull-down menu of 

options when clicked once. 
 
There are times when certain menu buttons in GypsES are not available or should not be used until 
the current operation is complete. In these cases, the text in the menu boxes is “greyed out,” or 
desensitized, so that you can not choose these options. 
 
Info Button 
This button displays information about a selected point in a SiteData map layer or Raster map 
layer. [Note: If multiple SiteData and/or Raster data layers are displayed, you must choose what 
layer to use for an Info query.] If you click the Info button once, a message in the status bar prompts 
you to select a point on the current map layer by clicking with the left mouse button. If you are 
working with a Raster map layer, a dialog box with the data point’s location (Northing and Easting 
UTM coordinates) and category number and description appears. Click Continue to close the dialog 
box and choose another point. The right mouse button terminates the Info option. If you are working 
with a SiteData map layer, clicking on a point brings up a Database dialog box (see the Edit menu / 
Database option / Edit/View Data File option on page 7-24). By default, the data that first appears is 
for the selected data point; you can toggle to a spreadsheet view of the entire database of all points on 
the map layer. Point data includes Northing and Easting UTM coordinates and data values. Click on 
OK to close the dialog box and choose another data point. The right mouse button terminates the 
Info option. 
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Error Messages 
When GypsES doesn’t function as it should, there may be error messages explaining or indicating 
the problem. GypsES maintains an ongoing log for each session that includes error messages. You 
can review this log using the File menu / View GypsES Log option (see page 6-49). Check error 
messages from the crashed session by viewing the GypsES log using the Previous Log option. 
Checking for error messages and saving log files that contain error messages helps GypsES 
developers correct problems with the program.  If GypsES does “crash” (i.e., is no longer running), 
re-start GypsES. There is no need to re-start the computer. 
 
The Help Menu 
The Help button is available throughout the GypsES session. The Help pull-down menu contains the 
following options: Context, Help How-To, File Menu, Edit Menu, Window Menu, Forest Menu, 
Survey Menu, Treatment Menu, Version, and Credits. The pull-down menu options give you a 
starting point for finding information related to the current topic or related topics. Selecting any of 
the above options, excluding Version and Credits, invokes the Help system. 
 
��Context 

This invokes the Help system with help text that is pertinent to what you are currently working 
on. For example, if you are currently editing a data table and click on Context, the first page of 
help text you see refers to editing a data table. 

 
��Help How-To 

This option brings up a single dialog box of general information on using the Help system. 
 
��Menu Buttons 

Clicking on any of the following six options (File, Edit, Window, Forest, Survey, or Treatment) 
brings up help text for that option. This allows you to quickly view help text for any menu while 
working anywhere within GypsES. 

 
��Version 

This option displays the current version of GypsES being used. When calling for technical 
support, please know the version number of the GypsES system. To display the version number, 
click the Version button; a message box is displayed in the center of the screen. Click the 
Continue button to remove the version message. 
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��Credits 
This lists people involved in GypsES development. The first page lists the current developers, 
contributors, and initial users. Click on Copyright to read a Copyright Notice. Click on More to 
view a list of other contributing cooperators. Click on Software Credits for a listing of all 
software acknowledgments and copyrights. Click on Close to remove the Credits dialog box. 

 
How to Use Help 
Once an initial topic is selected in Help, a Help dialog box is displayed (Fig. 4-2). Each Help dialog 
box has two sections: the menu bar along the top and a display area below to display the text for the 
selected help topic. Use the scroll bar on the left side to move up and down through the displayed 
text by clicking the arrows at the top and bottom of the bar. The Help menu bar contains five push 
buttons: Other Topics, Next, Prev, Master List, and Exit Help. 
 

Figure 4-2.  Sample Help menu dialog box. 
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��Other Topics 
This push button lists topics that are related to the current topic. For example, if you are currently 
viewing help related to the File menu, the Other Topics list may have the names of each of the 
menu options available under the File menu. Click on a new topic from the Other Topics list to 
select it and new help text is displayed. 

 
��Next and Prev 

The Help system maintains a list of the help text pages you view. You can move through this list 
using the Next and Prev push buttons. 

 
��Master List 

This push button displays a menu of all major help topics outside the scope of the initial help 
topic. To change topics, click the Master List push button and select a new topic from the menu. 
The new help text is displayed. 

 
��Exit Help 

This push button removes the Help dialog box and returns you to the current GypsES Work 
Window. 
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GypsES Mapping Concepts 
 
Locations and Mapsets 
GypsES organizes data into locations and mapsets. A location is a specific area that you are 
responsible for, for example, a county or a ranger district. Geographically, the location represents a 
rectangular region on the Earth's surface defined by the UTM (Universal Transverse Mercator) 
coordinates of the four sides of the rectangle. You initially define a location by its latitude and 
longitude coordinates that GypsES then converts to UTM coordinates. GypsES can display the 
geographic coordinates of map locations using either system, however (see Geographic Projection 
and Coordinate Systems Used by GypsES on page 5-5 for more information). UTM coordinates are 
classified as either “Northing” or “Easting,” which indicates how far north and east a point on the 
Earth is in meters relative to a grid system of zones that covers the Earth (see Table 5-1 listing UTM 
zones). Although you can move between several locations during a GypsES session, only one 
location can be worked with at a time. 
 
Within a location, data layers are organized into mapsets. A mapset is a directory (or folder) used to 
organize data layers within a location. The PERMANENT mapset contains data that usually doesn’t 
change and is available to all users working in the location, such as elevation, soil conditions, roads, 
and waterways. The PERMANENT mapset is automatically created when you set up a new location. 
You can create and name other mapsets at any time. Mapsets can be used for “what if” analysis to 
see what happens when certain parameters are changed or to separate data from different years. For 
example, if gypsy moth treatment projects occur regularly, mapsets can be used to keep annual egg 
mass counts, defoliation prediction, and spray block information separate for each spray season (Fig. 
5-1). 
 
While using GypsES, you work with a selected location and mapset. The mapset you are working 
with is known as the output mapset or current mapset; its name is always displayed in the 
information / settings bar. You can change output mapsets at any time by clicking on the output 
mapset button in the information / settings bar. Any files you create are written to the current mapset. 
You can modify or delete only those files that are stored in the output mapset. Information in 
mapsets other than the current mapset is available for display and copying during the GypsES session 
on a read-only basis. 
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Table 5-1.  Zone numbers and longitude ranges for UTM zones. All values are in full degrees east (E) 
and west (W) of Greenwich (0 degrees).       
        

 
ZONE 

NUMBER 
RANGE IN 

LONGITUDE 
ZONE 

NUMBER 
RANGE IN 

LONGITUDE 
1 180W – 174W 31 0 – 6E 
2 174W – 168W 32 6E – 12E 
3 168W – 162W 33 12E – 18E 
4 162W – 156W 34 18E – 24E 
5 156W – 150W 35 24E – 30E 
6 150W – 144W 36 30E – 36E 
7 144W – 138W 37 36E – 42E 
8 138W – 132W 38 42E – 48E 
9 132W – 126W 39 48E – 54E 
10 126W – 120W 40 54E – 60E 
11 120W – 114W 41 60E – 66E 
12 114W – 108W 42 66E – 72E 
13 108W – 102W 43 72E – 78E 
14 102W – 96W 44 78E – 84E 
15 96W – 90W 45 84E – 90E 
16 90W – 84W 46 90E – 96E 
17 84W – 78W 47 96E – 102E 
18 78W – 72W 48 102E – 108E 
19 72W – 66W 49 108E – 114E 
20 66W – 60W 50 114E – 120E 
21 60W – 54W 51 120E – 126E 
22 54W – 48W 52 126E – 132E 
23 48W – 42W 53 132E – 138E 
24 42W – 36W 54 138E – 144E 
25 36W – 30W 55 144E – 150E 
26 30W – 24W 56 150E – 156E 
27 24W – 18W 57 156E – 162E 
28 18W – 12W 58 162E – 168E 
29 12W – 6W 59 168E – 174E 
30 6W - 0 60 174E – 180E 
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Location:  PrinceWilliamLocations

    Location:
Prince William

Mapset: 
PERMANENT

Mapset: 
Year1996

Mapset:  
Year1997

Mapset 
PERMANENT 

contains static data

Mapset Year1996 contains 
data for the 1996 program 

year.

Mapset Year1997 contains 
data for the 1997 program 

year.

Elevation

Roads

Streams

1996 Defoliation Prediction

1996 Spray Blocks

1996 Egg Mass 
Cts.

1997 Defoliation Prediction

1997 Spray Blocks

1997 Egg Mass 
Cts.

Mapsets

A location specifies a fixed rectangular region on the Earth's surface.
All map layers within a location describe data within this rectangle.

A single GypsES computer system can store more than one location, but
the user may only work in one location at a time.

Mapsets provide a means of organizing GIS map layers.
A location may contain any number of mapsets.

All layers in all mapsets in a given location describe data for that location.
Mapsets can be thought of as folders holding papers or as

directories holding files.

Figure 5-1.  Organization of geographic data within the GypsES system. 
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The current location and output mapset names are displayed in the lower left corner of the GypsES 
Main Screen. (Fig. 5-2).  The location or mapset can be changed either right on the screen (click on 
the location/mapset name button to change it) or within the File menu (see the File / Location / 
Mapset options listed on page 6-46). 
 

Geographic Views 
You can either view the whole location (full View) or view selected portions using the Zoom In and 
Zoom Out capabilities of the GIS system. The current view of the location is a Geographic View. 
When you view a smaller area within the entire location, you can work with greater detail, precision, 
or both. Geographic views can be saved and retrieved so that they can be quickly redrawn later (see 
the File menu / Save option / View option on page 6-14 and the Window menu / Change View / 
Recall View option on page 8-1 for more information on saving and retrieving Views, respectively). 

Figure 5-2. GypsES Main Screen illustrating current location (WVUFOREST”) 
and mapset (“demo”) names. 
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Geographic Projection and Coordinate Systems Used by GypsES 
A geographic projection is a way to “flatten” the surface of the Earth so that some or all of it can be 
shown in two dimensions on a map. There are many ways of projecting the Earth’s surface onto a 
map. To help you understand some of the terms you encounter when using GypsES, here are some 
brief definitions: 
 
��Latitude / Longitude 

When locating a point on the Earth’s curved surface, we sometimes use the terms latitude and 
longitude. Latitude is the distance from the Earth’s equator to both poles. It is represented as 
degrees north or south of the equator (0 degrees); the north and south poles are therefore 90 
degrees north and south, respectively. Longitude is defined as the number of degrees east or west 
of an imaginary line running from the North Pole through Greenwich, England to the South Pole. 
This line is called the Greenwich, or Prime, Meridian and is defined as longitude 0 degrees. 
Longitude ranges from 0 degrees at the Greenwich Meridian to 180 degrees on the opposite side 
of the Earth.  

 
Latitude and longitude can be expressed using either decimal degrees or degrees, minutes, and 
seconds; there are 60 minutes in a degree and 60 seconds in a minute. The direction (East or 
West for longitude, North or South for latitude) should be specified using either format. 
Sometimes West longitude is expressed as a negative number.   

 
��UTM System and UTM Zones 

There are many systems for projecting latitude and longitude coordinates to flat surface 
coordinates so distances and areas can be calculated and a map can be drawn. One system that is 
used throughout the world and that is reasonably accurate is the Universal Trans Mercator 
Projection. This is the projection most commonly used for world maps. It divides the surface of 
the Earth into 60 North-South rectangular strips 6 degrees of longitude wide. These strips are 
called Zones and are numbered starting at longitude 180 degrees. Within each zone, every point 
on the Earth is represented by coordinate values X (Easting) and Y (Northing); these are usually 
expressed in meters. Table 5-1 on page 5-2 provides a complete listing of UTM Zones and 
associated longitude ranges.  

 
When a location in GypsES spans two UTM zones, the zone that covers the majority of the 
location’s area is assigned to the location. Distance and area calculations using UTM coordinates 
should be reasonably accurate as long as the area covered by the location does not cover too 
many zones. To translate between latitude/longitude values and UTM meter coordinates, some 
estimate of the shape of the Earth is necessary, which brings us to another term used in 
geographic projection, the ellipsoid. 
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��Ellipsoid 
The Earth is round, but not a perfect sphere. The distance around the Earth is greater at the 
equator than at the poles, so the Earth’s shape can more accurately be described as an ellipsoid. 
When converting latitude and longitude values to flat coordinates for mapping, some assumption 
must be made about the shape of the ellipsoid, since the Earth is really not a perfect ellipsoid, 
either. There are many ellipsoid estimates available for use in projections, some of which work 
better for different parts of the Earth. Some ellipsoid estimates are actually less accurate because 
they were developed before the era of satellites, but are still used to provide continuity with 
existing maps. GypsES won’t ask you about ellipsoids, but you need to be aware that they exist 
and are being used.  

 
��Datum 

A datum is a set of points that more precisely defines the shape of the Earth’s surface by taking 
elevation into account. Since the Earth is not a perfect ellipsoid, using a datum further refines 
very precise conversion of latitude and longitude to UTM values. Latitude and longitude values 
vary with the datum you are using. GypsES recognizes and uses two North American Datums 
(NADS): 

 
��NAD27: This datum is based on an ellipsoid developed by Alexander Ross Clarke in 1866 

(Clarke66). It is the datum used for most topographic paper maps currently issued by the 
United States Geological Survey (USGS).  

 
��NAD83: This datum is based on an ellipsoid developed using satellite data. It is more 

accurate and is used internally by GypsES. When importing data, GypsES asks you to 
describe the coordinate system used and automatically converts to NAD83.  

 
[Note: It is very important to specify the datum correctly when importing or exporting data.  
Differences between coordinates can vary up to 300 meters in some parts of the United States.] 

 
Conversion of GIS Data Outside North America 
If you attempt to import GIS data from outside North America and it is projected using either the 
WGS84 or the GRS80 Ellipsoid, set the Datum to NAD83 and the conversion should work properly. 
If another ellipsoid was used, you may encounter problems and should probably check with your GIS 
or GypsES coordinator. 
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Types of GIS Data Layers 
 
��Raster Layers 

A Raster layer is a map that is divided into rows and columns of cells, similar to the organization 
of a database spreadsheet. Each cell represents a square on the surface of the Earth. The 
dimension of this square is called the resolution, which in this case is expressed in meters. In a 
Raster layer, each cell is assigned an integer value. Using elevation as an example, the integer 
value represents the actual elevation within that square. In other cases, the integer value may be a 
code linked to a data table. Raster data is stored internally in a compressed form, but can be 
visualized as a very large spreadsheet with the rows and columns of cells representing the 
geographic location and the category number associated with that point representing the data. 

 

 

 

User Tip: Categories in Raster Files 
 
A category number is an integer "code" used to associate Raster file cells with descriptions, 
databases, and colors. Sometimes the category number itself has a meaning.  For example, in a Raster 
elevation layer, each "category" represents the average elevation in meters in that cell. In this case, no 
description or database is necessary. In the case of elevation, colors are usually assigned in Αcolor 
ramp≅  mode, so the changes from blue to green to yellow to red represent increasing elevation. 
 
In some cases, for instance in Hazard Rating, a category number represents a degree of Hazard, for 
example, 5 = very high, 4 = high, etc. In this case, a cell coded 5 would indicate that the trees in that 
cell would be at considerable risk of mortality if there were a gypsy moth outbreak. A category 
description for each code would provide a legend for a map showing this Raster layer. Color 
assignment for this type of Raster map layer is standardized with very high assigned to red and very 
low to blue. 
 
A third use of categories in Raster layers is for linking to a database. An example would be a National 
Forest stand. All cells contained in a stand are coded to a category number that is the stand number. 
For instance, Compartment 21 Stand 59 would be category 21059. A database containing information 
about the stand and containing a field with the stand number can be Αlinked≅  to the layer, so that by 
clicking on the stand map, the database for the stand can be retrieved for viewing. Color assignment in 
this type of file, where there are a large number of categories, is usually established randomly. 
 
In all cases, Raster categories and descriptions used in legends can be changed using the Edit menu / 
Map Features option / Edit Categories option described on page 7-36. 
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A key concept in working with Raster layers is that of resolution, or the size of the cells that 
GypsES uses for display and analysis of Raster information. The choice of resolution is 
dependent on the size of the location, the accuracy of the source data, and the accuracy required 
in the results. All Raster files in a location or mapset do NOT have to have the same resolution. 

 
��The resolution of a Raster file is determined when it is created.  If you are creating a new 

Raster layer using calculations within the GypsES system, the current resolution applies to 
the resulting layer.  If the resolution is relatively large (i.e., the dimension of the region on 
the Earth represented by the Raster layer cell is relatively large), newly created layers look 
Αboxy.≅   If the resolution is very small, newly created layers look less boxy, but it takes 
longer to create a new layer because a larger array with more elements must be processed. 
 

��A Raster file can be displayed in a resolution larger than the resolution at its creation. The 
file does not change; GypsES just regroups the data for display purposes. Setting the 
resolution smaller than the resolution when the file was created does NOT give a better 
resolution and does NOT reduce “boxiness.”  A map’s resolution can be no smaller than 
what it was when it was created. 

 
GypsES takes advantage of Raster layer data organization to produce new layers by analyzing the 
content of existing layers. For instance, the Hazard option in the Forest menu examines species 
composition and stand age information to produce a new map layer that predicts stand 
susceptibility. The data values in a given cell for each input (antecedent) layer are examined, 
then an algorithm or Αrule≅  is used to produce a susceptibility rating code (1 = low, 2 = 
moderate, 3 = high, 4= very high) for that cell in the resultant layer. 

 
��Vector Layers 

A Vector layer consists of lines defined by UTM coordinates. Each line is made up of one or 
more points (or vertices) connected by segments.  The first and last points of a line are called 
nodes (Fig. 5-3). Feature lines represent features on the Earth (for example, roads, streams, and 
power lines), and polygon lines are boundaries of areas (for example, spray blocks, political 
boundaries, and forest stand boundaries). One or more lines can define polygons. If the lines 
bounding a polygon do not intersect and are joined at nodes with no gaps, the polygon is closed; 
if there is a gap between polygon line nodes or if lines intersect at non-node points, the polygon 
is open or unclosed. Vector layers can be imported from other systems, such as ARC/INFO or 
U.S. Geological Survey DLG files, or sketched with the mouse using MapEdit editing features. 
The GypsES System can convert vector information that defines polygons to Raster form for 
analysis. Vector files also utilize categories (see User Tip: Categories in Vector Files on the 
next page). 



GypsES User’s Manual v1.0  Section 5: GypsES Mapping Concepts 

 5-9 GypsES: Decision Support and Project Mgt.  

 
��SiteData Layers 

A SiteData layer is a database file that has as data fields geographically located points identified 
by UTM coordinates (Northing and Easting). Other fields in the data file can contain information 
about that point, such as egg mass count and ownership information. A SiteData layer can be 
displayed by itself or used to develop Raster layers that can be used for analysis. GypsES can 
extrapolate between individual data points to develop a surface map layer that estimates a given 

 

User Tip: Categories in Vector Files 
 
Categories are also used to assign descriptions and colors to Vector layer elements. The assignment of 
categories to Vector layers is referred to as “labeling” in MapEdit. Feature lines and polygons are 
handled somewhat differently.  Categories for feature lines are assigned by choosing a point on the 
line to “attach” a label. The coordinates of the point and the category number are established as a part 
of the layer information. A description, color, or both can be assigned to the line. Categories for 
polygon lines are NOT established for each line, but for each polygon. A point within the polygon is 
selected, and a category number is associated with it. A description for the polygon can be established, 
but color assignment really has no meaning except when rasterizing the polygons. (See the Edit menu / 
MapEdit option / Convert to Raster option on page 7-15.)  The reason for this is that a single polygon 
line can be used to define two or more contiguous polygons, so there would be no way of determining 
which color to draw the lines in. 
 

Line

Segments

Points

Nodes

Figure 5-3.  Components of a line. 
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parameter over the entire map (e.g., the average number of egg masses per acre) (see the File 
menu / Create New option / Create Surface option on page 6-11). 

 
��Composite Maps 

A Composite map can have any combination of Raster, Vector, and SiteData layers with optional 
labels, backdrop images, grids, or scales. Once you have created a map that has multiple layers 
in a Work Window, it can be saved as a Composite file (see the File menu / Save option / 
Composite option on page 6-14 for more information). You can retrieve this composite file at 
any time in the current or future GypsES working sessions using the Window menu / 
Build/Update Map option described beginning on page 8-2. 

 
Masks 
A special kind of data layer, called a Mask, can be used as a Αcookie cutter≅  to display only a 
selected portion of a location (the rest of the location appears in black). When a Mask is activated, 
not only is the selected portion of the map the only portion displayed, it is also the only portion used 
to perform calculations; this can be beneficial when the calculation is time consuming. 
 
Any Raster map layer can be used as a Mask. A Mask can be activated or cleared using the Window 
menu / Change View option / Set Mask option described on page 8-11. When a map layer is selected 
as a Mask, those areas that are non-zero in the layer are selected.  A Mask does not affect non-Raster 
map layers. 
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The File Menu 
 
Use this menu option to work with files (File Control); create new GypsES layers (Create New); 
save composite files or views (Save); import data, vector, shape, and image backdrop files (Import); 
export data, SiteData, vector, and graphics files (Export); work with reports (Reports); produce 
graphics output (Graphics Output); select, change, create, and delete locations and mapsets 
(Location/Mapset); view the GypsES log (View GypsES Log); and quit GypsES (Quit GypsES). 
Pull Down Menu: 
��File Control  (6-1) 
��Create New  (6-5) 
��Save  (6-14) 
��Import  (6-15) 
��Export  (6-30) 
��Reports  (6-37) 
��Graphics Output  (6-39) 
��Location/Mapset  (6-46) 
��View GypsES Log  (6-49) 
��Quit GypsES  (6-49) 
 
I. File Control (File) 

Use File Control to manipulate (delete, rename, copy, restore, shred, etc.) files that are stored in 
the current location and output mapset only. You can copy a file from another mapset to the 
current output mapset, but can delete or rename files within the current output mapset only. After 
clicking on File Control, a File Control dialog box appears; the current location name is listed in 
the upper left corner below the File menu button (Fig. 6-1). 

 
A list of all GypsES mapset files by type (Raster, Vector, Composite, Data, SiteData, and View) 
appears on the left side of the dialog box. Click the mouse on the folder icon just to the left of a 
file type name to produce a list of mapsets within that file type just below and indented to the 
right.  [Note: Only those mapsets that contain that file type are listed.] Clicking on a mapset 
folder icon produces a list of all the files of that type within that mapset on the right side of the 
dialog box under the title “Contents of [Location: Mapset: File Type].” Use the Wastebasket 
(depicted on the left side of the dialog box by a wastebasket icon) to store, restore, and shred 
deleted files. 
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To select a file to work with using File Control, click once on the filename in the list on the 
right; the filename is highlighted.  Once a file is selected, click once on File in the upper left 
corner of the dialog box to generate a menu of file options. These include: 

 
A. Delete 

This option sends the selected file to the WasteBasket. Click on Delete; GypsES checks to 
see if that file has any dependencies (is linked to any other GypsES files). If dependencies 
exist, a message appears telling you that you cannot remove the file. If there are no 
dependencies, GypsES prompts you with the message: “ABOUT TO DELETE [filename]: 
Click Ok to confirm, Cancel to abort.” Choose to delete the file or cancel the delete function. 
If you are working with a WasteBasket file, choosing Delete actually shreds the selected file; 
GypsES prompts you to confirm the deletion (click on Ok to shred or Cancel to stop the 
shred). 

Figure 6-1.  File Control dialog box. 
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B. Rename 
Use this option to rename a file. After clicking on Rename, a text entry window appears. 
Type in the new name and press <Enter> to accept the new filename. 

 
C. Copy 

Use this option to copy a selected file to the current output mapset. A text entry window 
appears prompting you to type in the name for the [new] file being copied. Press <Enter> 
when the filename is typed in; GypsES responds if the copy function was successful. 

 
D. Show Properties 

This option gives you information about GypsES files. A Show Properties Dialog dialog box 
appears with three dialog boxes: General, Data Link, and Advanced. 

 
1. General: This dialog box lists the filename; file type (Raster, Vector, Composite, View, 

Data, or Windows); location and mapset names; the owner (= the log-in name typed in); 
file size; resolution (if applicable); and the dates and times the file was created, modified, 
and last accessed.   

 
2. Data Link: This dialog box shows existing links between database files and Raster files 

only (see Show Data Link below). 
 

3. Advanced: This dialog box provides information on pathnames for WasteBasket files 
only that can be restored. 

 
If you are working with a WasteBasket file, choosing Show Properties brings up the same 
Show Properties Dialog dialog box described; however, the Advanced dialog box now shows 
the pathnames for files stored in the WasteBasket. 

 
E. Show Data Link 

This option becomes available if a Raster file is selected. This option brings up the Show 
Properties Dialog dialog box and Data Link dialog boxes described above. If a data link has 
been defined for the selected file, it is described; GypsES tells you if no link exists. 

 
F. Set/Unset Data Link 

This option becomes available if a Raster file is selected. This option brings up a Data Link 
Selection dialog box so you can set (or clear) a link between a data file and a Raster file. To 
select a data file to link to a Raster file, click on the box to the right of “Linked Data File;” 
you see a dialog box (Choose Raster link file) that lists all data files within each mapset. 
Choose the data file you want to link by clicking on the filename, then click on Accept to 
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select the file. The filename just chosen appears in the “Linked Data File” box. Choose the 
data field to link to the Raster layer by clicking on the choice button to the right of “Field.” 
All data fields in the file are listed; choose the field to link by clicking with the mouse. Then 
click on Accept to set the link, on Clear Link to unset the link, or on Cancel to close the 
Data Link Selection dialog box. 

 
G. Empty Wastebasket 

This option becomes available when you click on the wastebasket icon. This option shreds 
all files in the WasteBasket, not just a selected file. 

 
H. Restore File 

This option becomes available when you work with files stored in the WasteBasket directory. 
This option puts a file back in its original mapset within the location. 

 
I. Close 

This option closes the File Control menu and returns you to the GypsES Main Screen. 
 

Several shortcuts have been built into the File Control dialog box. 
 

��Multiple File Selection Shortcut: To select multiple files, hold down the <CTRL> key and 
click on all the files you want to select. You can delete multiple files; however, you still have 
to confirm the deletion of each file separately. 

 
��File Menu Options Shortcut: If you have selected a file, you can quickly access the File 

menu options by clicking the right mouse button. A pop-down menu appears next to the 
cursor; select the action you want for the selected file(s). 

 
 
 

 

User Tip:  “Why use a data link?” 
 
In order to associate (link) a database file with a Raster file, GypsES needs to know what field in the 
database represents the Raster category number used in the Raster layer. The data link is the way to 
establish this. 
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II. Create New � 
Use this option to create new Raster map layers by reclassifying categories (Reclass), merge 
Raster or Vector map layers (Combine), create a surface layer from a SiteData file (Create 
Surface), or create a Vector map layer of quadrangle map boundaries (Create Quad Outline). 
Pull Down Menu: 
��Reclass  (6-5) 
��Combine  (6-10) 
��Create Surface  (6-11) 
��Create Quad Outline  (6-14) 

 
A. Reclass 

Use this option to create a new Raster map layer with reclassified categories. You can either 
(1) reclassify the categories of a Raster map layer for the first time, (2) modify a previous 
reclassification of a Raster map layer, or (3) create a new Raster map layer based on a 
reclassified map layer. For example, if you had a Raster map layer of egg hatch that was 
classified (color-coded) by week, the egg hatch data could be reclassified (regrouped) into 
monthly intervals (or any other time frame chosen by you). In a similar way, a Raster map 
depicting predicted defoliation could be reclassified to reflect different category groupings 
(i.e., defoliation levels). 

 
When the Reclass option is chosen, a Choose Raster File for Reclass dialog box appears. 
Select the appropriate mapset on the left and Raster filename on the right to be reclassified. 

 
1. First-Time Reclassification of a Raster Map Layer: If a Raster map layer chosen is an 

original raster file (as opposed to a reclassified file), a Reclass dialog box appears for you 
to “create a new [Raster map] layer whose category values are based upon the 
reclassification of categories in an existing Raster map layer” (Fig. 6-2). Information 
about the “Existing (Input) layer” is listed on the left side of the dialog box, including the 
map layer name, mapset name, and title. Type in the new map layer name in the “Layer” 
text entry window on the right side of the dialog box under “New (Output) layer;” typing 
in a title is optional. [Note: If the new Raster layer name already exists, a warning 
message appears asking if the file should be overwritten.] 
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Use the “Default Reclass Options” section in the lower left of the dialog box to choose 
between three different reclassification options: 

 
a. Same as Input: This option copies the exact same category numbers, descriptions, 

and colors defined in the existing Raster map layer to the new Raster map layer. 
 

b. Specified Category: This option sets the reclass definition so that all categories in the 
new layer are initially reclassed to a single category. This would be useful, for 
example, if you want to group many categories together and then reclassify relatively 
fewer categories in the following dialog box. Choosing this option activates a 
“Specified Category Definition” area to the right; enter or select the category number, 
description, and color that you want. 

 
 

Figure 6-2.  Opening Reclass dialog box. 
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c. No Data: This option essentially does the same thing as Specified Category, except 
the “Specified Category” is the 0 (“No Data”) category. You can then selectively 
choose specific categories from the new map layer to define and assign a color to; all 
other categories remain black (“No Data”). This provides a useful way for you to pull 
out specific areas of interest while leaving the rest of the map layer black (for 
instance, to create a Raster map layer that can be used as a Mask). 

 
Click on Next to continue or on Cancel to cancel the reclassification process. If you 
chose Next, a new dialog box appears (Fig. 6-3) with a list of category numbers, 
descriptions, and colors for the existing (input) Raster map layer on the left. A list of 
categories for the new (output) Raster map layer appears to the right. (New categories 
that appear depend on what reclassification option you chose in the opening Reclass 
dialog box.) 

Figure 6-3.  Reclass dialog box with all categories listed, both existing (left) and new (right).
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Individually select categories to be reclassified by clicking once on the category 
description line itself; to deselect a category, just click on the category line a second time. 
As categories are selected, their category numbers are simultaneously listed at the bottom 
of the dialog box to the right of “Selected Categories.” Categories can also be selected by 
typing in their numbers in this text entry window.  [Note: When doing this, be sure to 
separate the category numbers by semicolons; you can specify either individual category 
numbers or a range of numbers, for example, “1-4; 5; 12; 18-20.”] 

 
Once a group of categories has been selected for reclassification, click on Set Reclass to 
the right of the “Selected Categories” text entry window.  Another dialog box appears to 
define the new category number, description, and color (Fig. 6-4). 
 

 
To define a new category number, type in a new (or previously defined) number.  If a 
category number is already established, the previously assigned description and color are 
displayed.  Type a new category description in the text entry window to the right of 
“Description.” Define the new color by sliding the double-cursor along each color bar to 
change the mix of red, green, and blue. (See Appendix B: Color Value Chart, for sample 
colors.)  Click on Accept to accept the edits or on Cancel to cancel any edits. 

Figure 6-4.  Reclass dialog box for modifying a given category. 
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Use the Edit (New) Categories push button at the bottom of the Reclass dialog box (Fig. 
6-3, page 6-7) to review all category attributes defined for the new Raster map layer. This 
dialog box is described under the Edit menu / Map Features option / Edit Categories 
option description starting on page 7-36. 
 
Once all appropriate categories have been accurately redefined (reclassified), click on 
Execute Reclass to complete the Reclass function.  If it worked, a message appears: 
“Congratulations!  You have reclassed [existing Raster map filename] in mapset [mapset 
name] to [new Raster map filename] in mapset [current output mapset name].”  By 
default, GypsES displays the newly reclassified Raster map layer; if you choose not to 
view the new map layer, deselect the square toggle button to the left of “Display New 
Reclass File?” so that it does not appear indented. Then click on Done. 

 
2. Reclassifying a Map Layer That Is Itself a Reclassification: If you choose to reclassify 

a Raster map layer that is itself a reclassification, there are two options: (1) modify the 
existing reclass of the original Raster map file, or (2) define a new reclassification based 
on the reclassified map layer.  If this is the case, a message appears stating “[Raster map 
filename just selected] is a reclass of [original Raster map filename] in mapset [mapset 
name].  Do you want to Modify the reclass of [original Raster map filename] or define a 
New reclass of [Raster map filename just selected]?”  Response options include Modify, 
New, Cancel, or Help.  Choosing either Modify or New brings up the same Reclass 
dialog boxes as described on pages 6-6, 6-7, and 6-8. [Note: If you choose to modify an 
existing reclass file, the Default Reclass Options are not displayed.] 

 

User Tip: Working With Reclassified Raster Map Layers 
 
Once a Raster map layer is reclassified, the resultant Raster map layer can be worked with and 
displayed just like any other Raster file.  However, it is important to remember that the new Raster 
map layer is always “tied” (referenced) to the Raster file from which it was created.  Therefore, 
GypsES does not allow you to delete a Raster file that is the basis of a reclassification. 
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B. Combine | 
This function merges two or more Raster or Vector map layers. 
Pull Down Menu: 
�� Raster  (6-10) 
�� Vector  (6-10) 

 
1. Raster: This option appends additional Raster data to the original Raster layer in those 

cells that have a “no data” value. 
 

2. Vector: This option appends line data. 
 

Click on the Combine function to combine two or more Raster or Vector files.  Any number 
of Vector files can be combined, but there is a limit of 10 files for a single combination of 
Raster files.  A Combine Raster (or Vector) Files dialog box appears (Fig. 6-5); select the 
appropriate mapset name from the choices listed at the top left of the dialog box; this 
produces a list of associated files on the right.   

 

Figure 6-5.  Combine Vector Files dialog box. 
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Clicking on a specific filename selects this file while simultaneously listing it under the 
“Selected Files” box below.  Select as many files as you want.  You can merge the categories 
of all selected files or use the categories of only the first file selected.  (See User Tip: 
Merging Categories below).  Click on Clear to clear all file selections.  You need to specify 
an output filename before the combine function is executed.  Click on Execute to combine 
the files or on Cancel to cancel the function. 

 
C. Create Surface 

This option generates a Raster surface (continuous layer) from a point file (SiteData file) by 
interpolating values between points for a specified database field. (See User Tip: “What is a 
surface?” on page 6-13.)  Click on Create Surface to bring up a Create Surface dialog box 
(Fig. 6-6). 
 

 

User Tip: Merging Categories 
 
Whether categories should be merged, or whether the categories for the first layer chosen should be 
used, really depends on the content of the layers being combined.  If you were combining several 
layers of spray block polygons, and the polygons in each layer had already been labeled and had 
descriptions set up, you would want to merge the categories so as not to lose the descriptions.  If you 
were merging elevation layers for different sections in a location, merging categories would not be 
necessary, since all category information is carried in the category number itself. 
 

Figure 6-6. Create Surface dialog box. 
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First select a SiteData file to generate the surface layer from by clicking on the box to the 
right of “Select Site Data File;” this brings up a Select SiteData File to make Surface From 
dialog box.  Select the mapset and SiteData file you want and click on Accept to accept the 
selection, on Clear to cancel any selections, or on Cancel to quit the selection process. When 
you have selected a file, the choice button next to “Database Fields:” is activated. Click once 
on this choice button to list all database fields; select a database field for generating a Raster 
surface layer. [Note: Only database fields with numeric values are really appropriate for 
surface generation.]  
 
When you select a database field for creating a surface layer, GypsES scans the file to 
examine the data in that field.  If any values in the selected database field contain decimals, a 
“Define Ranges for Surface Generation” box is activated (Fig. 6-7). 
 
 

 

Figure 6-7.  Create Surface dialog box: “Define Ranges for Surface Generation” box.



GypsES User’s Manual v1.0         Section 6: The File Menu 

 6-13 GypsES: Decision Support and Project Mgt.  

Because a raster layer must be based on integer categories, GypsES must develop a set of 
“categories” that relate to ranges of decimal values.  The “Define Ranges for Surface 
Generation” block tells you what the highest and lowest values are for the selected database 
field.  Choose how many categories you want the resultant raster layer broken into by 
modifying the value in the text entry window provided. 
 
If the SiteData file contains only integer values in the database field you have chosen, the 
“Define Ranges for Surface Generation” box does not appear and the actual values in the 
database field are used as categories. 
 
Use the “Set Radius for point inclusion” box to specify how far away data (sample) points 
can be and still affect the value in a given raster cell. To generate a surface layer, GypsES 
goes through the raster layer row by row and raster by raster. For each raster row/column, 
GypsES examines the values of the 12 closest data points.  The radius value specifies a limit 
for this process. If no data points lie within the radius value you specify, the raster cell is set 
to “No Data.” 
 
Name the new surface layer in the text entry window to the right of “New Surface Layer 
Name.” Then click on Accept to create the surface layer.  [Note: The current resolution 
determines both the resolution of the output surface layer and the time it takes to create the 
surface layer. The surface is created only for the current View, so if you want to create the 
surface layer for the entire location, be sure to be in Full View mode before you use the 
Create Surface option.] 
 

 

 

User Tip:  “What is a surface?” 
 
In many cases, pest management involves sampling (pheromone traps, egg mass counts, etc.) where a 
systematic sampling layout has been used over an entire area. This information can be used to make 
assumptions about an area. The conversion of point data (site data) to a Raster layer is called surface 
generation, and the Raster layer is called a surface. The raster cells that coincide with the sample 
points are assigned the values of the actual samples. The values of those raster cells that fall between 
sample points are estimated using a least squares interpolation method using all sample points 
surrounding them. Once a Raster surface layer has been generated, it can be used in conjunction with 
models (such as Defoliation Prediction) or rule bases (such as Risk). 
 



Section 6: The File Menu  GypsES User’s Manual v1.0 

GypsES:  Decision Support and Project Mgt.   6-14 

D. Create Quad Outline 
This option creates a Vector map layer of the 7.5-minute quadrangle map boundaries in the 
location. If you choose this option, you are prompted to type in a name for the Vector quad 
outline file. Labels and names can be added using either the Edit menu / MapEdit option / 
Revise Existing Vector Layer option / “General Functions” palette / Edit Features option or 
the Edit menu / Map Features option / Map Labels option. 

 
III. Save � 

This option saves certain types of GypsES files to the hard drive. 
Pull Down Menu: 
��Composite  (6-14) 
��View  (6-14) 

 
A. Composite 

A Composite file is a saved list of map layers (for example, hydrology, flight lines, and spray 
block map layers). You can uniquely name Composite files when you save them; when you 
recall a Composite file, GypsES produces a Work Window that has all saved map layers. To 
recall a Composite file, click on the Window menu / Build-Update Map option / Composite 
Map option and choose from the list of Composite files. [Note: The list of all map layers 
drawn in each of the four Work Windows is also automatically saved under the name 
Work_Window[x] where x is the Work Window number. If you change the Work Window 
content, the Work_Window[x] file is modified to reflect your changes. To copy the map layer 
content of one Work Window to another Work Window, use the Window menu / Build-
Update Map option / Composite Map option and select the Work_Window[x] file that you 
want.] 

 
B. View 

A View file saves a specific “view” (rectangle) within a location. A View file does not save 
map layers. For example, if a location was defined as a county, you can define a view as a 
city within the county. You can uniquely name View files when you save them; when you 
recall a View file, GypsES produces a Work Window that has the saved view. To recall a 
View file, click on the Window menu / Change View option / Recall View option and choose 
from the list of View files. [Note: The view in each of the four Work Windows is also 
automatically saved under the name Work_Window[x] where x is the Work Window number. 
If you change the Work Window view, the Work_Window[x] file is modified to reflect your 
changes. To copy the view of one Work Window to another Work Window, use the Window 
menu  / Change View option / Recall View option and select the Work_Window[x] file that 
you want.] 
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IV. Import  
Use this option to import data, DXF Vector files, Arc Info Shape files, and image backdrops into 
GypsES. If a database file contains UTM coordinate fields, it can be imported as a SiteData 
layer. While importing or creating a database, GypsES asks whether UTM coordinate fields exist 
and then classifies the file as a SiteData file, which makes it possible to display the information 
as a map layer. 
Pull Down Menu: 
��Import Data Files (*.dbf)  (6-15) 
��Import DXF Vector File (AutoCAD Drawing Interchange File)  (6-16) 
��Import Shape File  (6-18) 
��Import Image Backdrops  (6-24) 

 
A. Import Data Files 

Use this option to import database (*.dbf) files. An Import Database File dialog box appears 
(Fig. 6-8).  To select one or more database files to import, click on Select File(s). A File 
Selection dialog box appears (Fig. 6-9). 

Figure 6-8. Import Database File dialog box. Figure 6-9. File Selection dialog box. 
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Select the appropriate drive(s) using the choice button and select the database file(s) you 
want to import by clicking on the filename under “Files.” As you select files, they are listed 
below in the “Files Selected” box. Click on Accept once your selections are complete. The 
selected files now appear in the box under “Files to Import” in the Import Database File 
dialog box. Click on Accept to import the file(s) you have selected. 
 
After a file has been read in, you are asked to choose the fields in the database file that 
represent the location (UTM Easting and Northing coordinates).  If such fields exist, select 
them and click on Accept.  If the imported data file is not a SiteData file, click on Cancel. 
[Note: In the latter case, the file is imported as a data file.  It can be viewed using the Edit 
menu / Database options, but not displayed as a map. See page 7-24 for a description of 
these options.] 

 
B. Import DXF Vector File 

Choosing this option brings up an Import DXF Vector File dialog box (Fig. 6-10).  (See the 
User Tip: “What is a DXF file and how might it be used?” on page 6-18.)   
 

Figure 6-10. Import DXF Vector File dialog box.
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Click on Select File to bring up a File Selection dialog box to select a DXF file to import 
(Fig. 6-11). Click on the choice button to select a drive, then click on a filename to select it. 
The filename appears in the box below “File Selected.” Click on Accept to complete the 
DXF Vector file selection. 
 

 
Once you select a DXF Vector file for importing, GypsES examines the file and lists all the 
line and label layers that make up that DXF Vector file. A DXF Vector file can have any 
number of line and label layers. Line layers that can be used to make a GypsES Vector file 
are listed in a choice box to the right of “Line layer in DXF.”  Layers that can be used to label 
a GypsES Vector file (if any exist) are listed in a choice box to the right of “Label layer in 
DXF.” Manually choose the line and label layer you want from the respective lists to the 
right, select the line type of the new GypsES Vector file (polygon or feature), and name the 
Vector file you are creating. Click on Accept to import the DXF Vector file or on Cancel to 
quit. 

Figure 6-11. File Selection dialog box. 
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C. Import Shape File 
GypsES can import Arc Info Shape files into Vector (line or polygon) and SiteData (point) 
files. To import a shape file, select Import from the File menu and click on Import Shape 
File. An Import Arc Shape File dialog box appears (Fig. 6-12): 

 

 

User Tip:  “What is a DXF file and how might it be used?” 
 
DXF files contain graphical information in a standard file format used by CAD (Computer-Aided 
Drawing) programs such as AUTOCAD.  Many GIS systems can read and create DXF files, so the 
DXF format is commonly used to transfer geographically referenced information between GIS 
systems. You may have a local GIS system that has vector (line) information that could be used in 
GypsES, such as roads, rivers, spray blocks, etc. The local system could create a DXF file on diskette 
that can then be imported into GypsES. Conversely, you may have created layers in GypsES (for 
example, spray blocks) that you decide to transfer to another GIS system. You can use the Export 
DXF Vector File option to put the information on diskette in order to transfer it to another system.  In 
transferring to and from other systems, it is important that you check the projection and coordinate 
system for compatibility. 
   
GypsES uses the UTM (Universal Transverse Mercator) system in meters. [Note:  At this time, the 
DXF Import / Export options in GypsES work only with line (Vector) files.] 
 

Figure 6-12. Import Arc Shape File dialog box. 
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Click on Browse to select the shape file you want to import. [Note: Shape files have the same 
prefix and three different suffixes:  *.shp, *.shx, and *.dbf.  Always click on the file with the 
*.shp suffix. GypsES imports *.shp files without the *.dbf and *.shx files. If the *.dbf files are 
missing, Vector files are imported without any labels, and SiteData (point) files will have no 
database information other than the record number.] 
 
1. Importing Arc Info Shape Line/Polygon Files 

If the shape file describes either lines or polygons, the Import Arc Shape File dialog box 
changes depending on the object type (Fig. 6-13). 

 

Figure 6-13. Import Arc Shape File dialog box: polygon file. 
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The first line in the box under the “File to Import” box tells you what type of objects 
were in the shape file. “Poly Line” indicates that the shape file contains lines that ARE 
NOT polygons (for example, roads). “Polygon” means that the shape file contains 
polygons (for example, spray blocks or county boundaries). You must use this dialog box 
to tell GypsES what coordinate types are in the shape file and how to set up the labeling 
of your imported Vector file. When you have selected a shape file, the dialog box 
changes to provide the options you need for the object type in the specified shape file.  
  
a. Vector File Name: Type the Vector filename in the text entry window provided. The 

default is the name of the shape file. 
 

b. View Database: Click this push button to view the database associated with this file. 
A database ‘spreadsheet’ dialog box appears (Fig. 6-14). 

 

The N:/S:/E:/W: coordinates in the upper right-hand corner of the dialog box are the 
outermost boundaries for the shape file contents. This information helps you make 
sure that the shape file objects you are importing are completely within the 
boundaries of your current location. [Note: GypsES does not import data that isn’t 
located within your current location.] In addition to displaying the contents of the 

Figure 6-14. Import Arc Shape File: database spreadsheet dialog box (left side). 
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database, the coordinate boundaries of the line or polygon are in the right-hand 
columns of the spreadsheet (Fig. 6-15).  This may help determine how to specify the 
coordinate system. When you are through viewing the database, click on Done. 

c. Database Field for Category Number: Use this option to specify a database field for 
category numbers. At this time, GypsES does not have database information 
associated with vector file objects. You can, however, assign a category number and 
category description for labeling each line or polygon. You can assign colors to 
feature lines. You have the following choices for assigning category numbers: 

 
(1) No Category Assignment: Use this option to import lines with no categories.  

You cannot show labels or assign colors. 
 

(2) Assign for Unique Descriptions: With this option, GypsES generates category 
numbers for each unique value of the category description database field. Use this 
option when there is no database field that provides a number that is unique to 
each different value of the category description field. 

 
(3) Database Fields: Choose a database field that has numeric (integer) values. 

 

Figure 6-15. Import Arc Shape File: database spreadsheet dialog box (right side). 
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d. Database field for Category Description: Choose the database field for describing 
(labeling) your lines or polygons. If you have chosen a category number assignment 
such that the same category number has two or more different description values, 
GypsES alerts you and asks you to change your choices. This is because there is one 
and only one category description for each category number. 

 
e. Coordinate Type: You must tell GypsES what coordinate type was used when the 

shape file was created. You should consult the individual or company that provided 
the shape file to be sure you specify the information correctly. Choices include UTM 
coordinates, Latitude/Longitude coordinates, or State Plane coordinates. 

 
f. Datum: Choices include NAD83 or NAD27.  

 
g. Units: Choices include meters or feet.  For Latitude/Longitude coordinates, this field 

is de-sensitized. 
 

h. UTM Zone: If your coordinate type is UTM, enter the numeric UTM zone used.  For 
Latitude/Longitude coordinates or State Plane coordinates, this field is de-sensitized. 

 
i. State Plane Zone: If the coordinate type is State Plane, choose the zone from the list 

provided. For UTM and Latitude/Longitude coordinates, this field is de-sensitized.  
 

When you have set the category assignments and specified the coordinates, click on 
Accept to import the file.  [Note: GypsES only imports lines that intersect your current 
location’s boundaries.  If GypsES doesn’t find any lines in the file that can be imported 
into your current location, it tells you.  In this case, you may not have specified the 
coordinate parameters properly.] 

 
2. Importing Arc Info Shape Point Files 

If the shape file describes points, the Import Arc Shape File dialog box (Fig. 6-16) 
changes. Arc Info shape point files are imported as GypsES SiteData files.  
 
a. Point File Import: You can choose to import all fields in the shape database (Copy 

Shape Database) or you can select only certain fields (Select Data Fields). 
 

b. View Database: As with Vector file imports, use this push button to examine the Arc 
Shape file database. In addition to the values in the database field, this display 
provides the X and Y coordinates associated with each point. 
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c. SiteData File Name: Type the SiteData filename you want to give the imported 

shape file in the text entry window provided. The default is the name of the shape 
file. This name must be a standard DOS file name (8 characters or less and 
alphanumeric). 

 
d. SiteData File Database Fields: The middle section of the dialog box shows the 

SiteData file database fields (on the right) and their types and sizes (on the left). If 
you have elected to select what database fields to import, use the scrolling window on 
the right to click on those fields you want to include in your GypsES SiteData file 
database.  GypsES automatically adds the UTMN and UTME fields and translates the 
coordinates in the shape file to UTM NAD83 values. 

 
e. Coordinate Type: You must tell GypsES what kinds of coordinates were used when 

the shape file was created. You should consult the individual or company that 

Figure 6-16. Import Arc Shape File: point file. 
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provided the shape file to be sure you specify the information correctly. Choices 
include UTM coordinates, Latitude/Longitude coordinates, or State Plane 
coordinates. 

 
f. Datum: Choices include NAD83 or NAD27.  

 
g. Units: Choices include meters or feet.  For Latitude/Longitude coordinates, this field 

is de-sensitized. 
 

h. UTM Zone: If your coordinate type is UTM, enter the numeric UTM zone used.  For 
Latitude/Longitude coordinates or State Plane coordinates, this field is de-sensitized. 

 
i. State Plane Zone: If your coordinate type is State Plane, choose the State Plane zone 

from the list. For UTM coordinates and Latitude/Longitude coordinates, this field is 
de-sensitized.  

 
When you have specified the database fields to import and the coordinate type, click on 
Accept to import the shape file as a GypsES SiteData file.  [Note: Only those points that 
lie within the boundaries of the current location will be imported.] 

D. Import Image Backdrops 
A new feature of GypsES/NT is the ability to do your own image imports.  You can order 
map backdrops from Land Info or Vargis and import the images yourself. It is important to 
understand that importing images into GypsES usually involves some sort of re-projection of 
the image, and this takes time.  For some types of imports, you may want to set the import up 
and let it run overnight.  GypsES attempts to estimate how long it will take to import an 
image backdrop, but this ultimately depends on the speed of your processor, the amount of 
memory (RAM) you have, and the speed of your CD-ROM and hard disk. 

 
To import an image, select Import Image Backdrops; an Import Image Backdrop dialog box 
appears (Fig. 6-17). [Note: The settings you select in this dialog box are extremely critical to 
getting a backdrop image that provides the correct geographic reference. GypsES expects all 
internal geographic data to use the Universal Transverse Mercator projection, NAD83 
Datum. GypsES attempts to re-project the images based on the settings in this dialog box. If 
these settings do not represent the information in the source images, the imported image 
backdrops will not be properly geographically referenced and this will cause untold grief. 
Please read the information provided with your images and set this dialog box up 
accordingly before importing!] The dialog box parameters include the following: 
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1. Image Type 

There are presently six types of images that can be imported.  
   

a. USGS 1:24,000 (Land Info): These are 16-color 7.5-minute quadrangle maps. 
Resolution is about 8 ft per pixel. Imported images require 2-8MB of hard disk space 
per quadrangle map, depending on the amount of detail in the image (urban areas 
take up more space).  [Note: In some areas, the 7.5-minute maps are of slightly 
different resolution (1:25,000, for instance). These are usually in a separate 

Figure 6-17. Import Image Backdrop dialog box. 
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directory and can be imported separately and then merged with the 1:24,000 
quadrangle maps.] 

 
b. USGS 1:50,000 (Land Info): These are 16-color maps used in Canada. Resolution is 

3.2 m (10.4 ft) per pixel.  These images require 0.5-1MB of disk storage space for 
each 7.5-minute quadrangle map.  

 
c. USGS 1:100,000 (Land Info): These are 16-color 30x60 minute quadrangle maps. 

Resolution is about 10 m (32.8 ft) per pixel. These images require 0.1-0.5 MB of disk 
storage space for each 7.5-minute quadrangle map, or 3.2-16MB for each 30x60 
minute quadrangle map. 

 
d. USGS 1:250,000 (Land Info): These are 16-color 1x2 degree quadrangle maps.  

Resolution is about 25.4 m (83.3 ft) per pixel. These images require 2-5MB of disk 
storage space for each 1-degree square, or 4-10MB for each 1x2-degree quadrangle 
map. 

 
e. SPOT [Aerial] Photography: These are black and white images. Resolution is about 

10 m (32.8 ft) per pixel.  Spot images require 1-3 MB of disk storage space for each 
7.5-minute quadrangle map. 

 
f. Vargis .2 Meter Photography: This is color aerial photography distributed by Vargis 

Inc., of Herndon, VA.  This is very high-resolution photography (0.2 meters (8 
inches) per pixel). These images require 2-10 MB of disk storage space for each 30-
second quadrangle map; that translates to 4-40MB of disk storage space for each 1-
minute quadrangle map, or 225MB-562MB of disk storage space for each 7.5-minute 
quadrangle map. 

 
We will probably be adding additional image types to this list. If you have geographically 
referenced images you would like to use in GypsES, please let us know.  

 
2. Image Source Directory 

This is the directory that contains the images you want to import.  Click on Browse to 
bring up a dialog box to choose the drive and (sub)directory. The directory you specify 
should contain the images you want to import. LandInfo and Vargis images have files 
with *.tif and *.tfw suffixes.  For SPOT images, there are directories with the scene 
names. 
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3. Image Source Geographic Reference 
The entries you make in this section MUST mirror the information you receive with your 
images. When you choose an image type, GypsES attempts to set these fields to the most 
common settings for the image type.  However, variations exist, so be sure to check! 

 
a. Coordinate Type: This is specified with your source images.  If you have any doubts, 

check with the image supplier.  SPOT imagery always provides latitude/longitude 
coordinates, so all other coordinate specification fields are de-sensitized for SPOT. 
Coordinate type choices include UTM, State Plane and Latitude/Longitude. For 
UTM, the UTM zone must be specified.  For State Plane, you must specify the State 
Plane Zone. The appropriate input fields are sensitized for the coordinate type 
selected.  For ALL Coordinate types, the Datum should be set. 

 
b. Datum: A datum is a set of points that describes the shape of the earth’s surface for a 

given part of the earth.  The NADXX Datum, for instance, is short for ‘North 
American Datum’. A datum is associated with an ellipse or geoid that is a 
mathematical approximation of the shape of the earth.  If you specify NAD83, 
GypsES assumes that your image is already adjusted for a datum and projects it using 
the GRS80 ellipsoid, which is applicable to all parts of the earth.  Most Land Info 
USGS maps are created using the NAD27 Datum, which should be specified so the 
image can be re-projected.  Errors in specifying the datum can result in 200+ meter 
differences between the coordinates shown in GypsES and the readings you would 
get, for instance, from a GPS unit. [Note: For locations outside the North American 
Continent, always specify NAD83. This will force NO datum shift.] 

 
c. Units: Some coordinates are supplied in meters, others in feet. Check the image 

specifications carefully to be sure the correct units are selected.   
 

d. UTM Zone: If your coordinate type is UTM, enter the numeric UTM zone specified 
by the supplier of the images. For State Plane Coordinates, this field will be de-
sensitized. 

 
e. State Plane Zone: If your coordinate type is State Plane, choose the state plane zone 

from the list. Check with your supplier to be sure that you are using the right zone. 
 

4. Import for Specific Location / Import All Images in Source Directory 
This choice determines whether the images you are importing are placed within a 
specified location’s folder (Import for Specific Location) or in a general folder of all 
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images for a specified UTM zone (Import All Images in Source Directory). In general, 
for higher resolution images, it is best to locate the images within the location. Then, if 
you want to transfer the location to another computer, the images are part of the location 
folder and you can just move the folder. 

 
For lower resolution images such as the 1:100,000 and 1:250,000 USGS maps, there is 
some benefit to using the Import All Images in Source Directory option.  The images 
are built seamlessly for the entire region or state and are available to all locations on the 
system after a single import. Because these images take up less disk space, the 
“imagesZoneXX” folder can also be moved to another machine. There is an exception to 
this; see Image Destination Drive below. 

 
The choice of import method is something that must be evaluated for each installation 
and varies with how you are going to use the system. If you choose the Import for 
Specific Location method, choose the location to which you want to import your images 
in the choice box to the right. GypsES automatically picks up the UTM zone for that 
location and places it in the “Image Destination UTM Zone” text entry window. If you 
choose the Import All Images in Source Directory option, you must specify a destination 
zone in the “Image Destination UTM Zone” text entry window. [Note: Images imported 
for a given zone are NOT available to a location that has been set up in another zone.] 
 

5. Image Destination Drive 
Choose the disk drive on your system to place the images. [Note: If you use the Import 
for Specific Location option but choose a drive other than where your location resides, 
the images are imported to an “imagesZoneXX” folder, where XX is the location’s zone. 
GypsES does not allow a location to be set up on more than one drive in a single system. 
In this case, only those images that overlap the location boundaries are imported, but 
they are placed in the X:\Gypses\Data_Files\ImagesZoneXX folder.] 

 
When you have specified the image type, source directory, geographic reference information, 
import type and destination drive, click on Accept to start the import.  GypsES first examines 
the files in the source directory. It then calculates the image tiles needed to cover the 
destination directory.  It estimates how much disk space is needed and gives a warning 
message if it looks like the destination drive does not have enough space to import the tiles. 

 



GypsES User’s Manual v1.0         Section 6: The File Menu 

 6-29 GypsES: Decision Support and Project Mgt.  

If everything looks OK, GypsES provides a very rough estimate of the time required to 
import. If you elect to continue, the import begins. A scrolling window shows the progress of 
the import (Fig. 6-18).  It shows each tile being built, the sequence of the tile, and the source 
tiles being accessed to build it. [Note: Image imports from source images with State Plane 
coordinates or UTM coordinates in another zone take MUCH longer.  This is because to 
build an image row in the destination tile, multiple rows in the source tile must be read.] 

 

 
 
When the import is completed, a message is displayed in the scrolling window. Click on 
Close and then on Cancel to exit the Import Image Backdrop dialog box. 

Figure 6-18. Sample scrolling window of an image backdrop being imported. 
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V. Export 
Use this option to export data, DXF Vector files, and graphics files. GypsES databases can be 
copied to other devices and/or folders on your computer using the Export option.  You can place 
GypsES graphics files elsewhere in your system. 
Pull Down Menu: 
��Export Data Files (*.dbf)  (6-30) 
��Export SiteData File to Shape  (6-32) 
��Export DXF Vector File (AutoCAD Drawing Interchange File)  (6-33) 
��Export Vector File to Shape  (6-35) 
��Export Graphics File  (6-36) 

 
A. Export Data Files 

Selecting this option brings up an Export Data Files dialog box (Fig. 6-19). Under “Data File 
Choice,” select the mapset (listed on the left) and database file (listed on the right) you want 
to export. [Note: The file can be either a data file or a SiteData file; no distinction is made in 
the list.]   
 

Figure 6-19. Export Data Files dialog box. 
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Then indicate the drive (device) and/or subdirectory where you want to put the exported data 
file. Do this by either typing the information in the “Device/Directory” text entry window or 
by clicking on Browse, which brings up a Select Device/Directory for Data File Export 
dialog box (Fig. 6-20). Select the appropriate drive letter using the choice box to the right. 
The drive letter appears on the left under “Directory:” and all files and directories on this 
drive appear on the right under “Files.” Double-click on a directory name to list 
subdirectories. As you choose a directory and subdirectories, they simultaneously appear to 
the left under “Directory.” Click on Accept to return to the Export Data Files dialog box. The 
drive and directory chosen should appear in the “Device/Directory” text entry window. Click 
on Accept to export the data file. 

Figure 6-20. Select Device/Directory for Data File Export dialog box. 
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B. Export SiteData File to Shape 
SiteData files can be exported to Arc Info shape file format.  This is a relatively simple 
process because both GypsES and Arc Info shape files utilize the same *.dbf database 
format. The shape file created using this process is almost the same as your GypsES SiteData 
file except that: 

 
��The coordinate information is transferred to the *.shp file. 
��The database fields that contained the UTM coordinate values in GypsES are not 

transferred to the *.dbf file created as part of the shape file set. 
 

When you select the Export SiteData File to Shape option, an Export SiteData to Arc Shape 
File dialog box appears (Fig. 6-21). 

 
 

 
Click on Select to choose the SiteData file to export. The Browse push button brings up a 
Select Destination Device/Directory for Shape File Export dialog box.  Choose the device 
(drive) and directory (folder) into which to export the shape file set. Enter a prefix for the 
exported shape files in the text entry window to the right of “Export File Prefix.” [Note:  Arc 
Info shape file conventions require a DOS-compatible name in lower case.  If you enter 
upper case letters, they are automatically changed to lower case when the file is exported.] 

Figure 6-21. Export SiteData To Arc Shape File dialog box. 
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Click on Accept to create the shape files. [Note:  Coordinates provided in shape Files 
created by GypsES are NAD83 Datum, UTM Meters, for the zone used by the location.] 

 
C. Export DXF Vector File 

Clicking on this option brings up an Export Vector File to DXF dialog box (Fig. 6-22). (See 
the User Tip on page 6-18 for information about DXF files.)  Select a Vector file to export by 
first clicking on a mapset name (left side of the dialog box) and then on a Vector file within 
that mapset (right side of the dialog box).  Clicking on a filename selects it for exporting. 
Type in a destination drive (device) and directory in the “Device/Directory:” text entry 
window or click on Browse to choose.  
 

Figure 6-22. Export Vector File to DXF dialog box. 
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This brings up a Select Destination Device/Directory for DXF File Export dialog box (Fig. 6-
23). Select the appropriate drive letter using the choice box to the right. The drive letter 
appears on the left under “Directory:” and all files and directories on this drive appear on the 
right under “Files.” Double-click on a directory name to list subdirectories. As you choose a 
directory and subdirectories, they simultaneously appear to the left under “Directory.” Click 
on Accept to return to the Export Vector File to DXF dialog box. The drive and directory you 
chose should appear in the “Device/Directory” text entry window. Click on Accept to export 
the Vector file or on Cancel to quit. 

 
 

 
 
 
 
 
 

Figure 6-23. Select Destination Device/Directory for DXF File Export dialog box.
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D. Export Vector File to Shape 
Choose this option to export a GypsES Vector or line file to Arc Shape file format. An 
Export Vector To Arc Shape File dialog box first appears (Fig. 6-24). 

 

First choose the Vector file to export by clicking on Select and using the Select Vector File to 
Export dialog box. GypsES Vector files do not have database information associated with 
them. There may be, however, a category description field that can be transferred to the shape 
database file along with the category number. Type the database field name in the text entry 
window to the right of “Shape File Database Field Name.” Database field names are limited 
to 10 characters and must start with an alphabetic character. 

 
Click on Browse to choose the device (drive) and/or directory (folder) in which to place the 
shape files. Enter a prefix name for your shape files in the text entry window to the right of 
“Export File Prefix.” The exported files are <prefix>.shp, <prefix>.dbf and <prefix>.shx, 
where <prefix> is the name you type.  This name must be a valid DOS file name with eight 
characters or less. When you have completed the setup, click on Accept to export your file. 
[Note: Coordinate information in the shape files is NAD83 Datum, UTM Meters, for the zone 
used in the current location.] 
 

Figure 6-24. Export Vector To Arc Shape File dialog box. 
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E. Export Graphics File 
Choosing this option brings up an Export Graphics Files dialog box (Fig. 6-25). You are 
prompted to select one or more graphics files to export from a list of graphics files stored in 
GypsES. Clicking on the appropriate mapset listed on the left produces a list of graphics files 
within that mapset on the right. Click to select one or more graphics files to export. Enter a 
directory path in the “Device/Directory” text entry window or click on Browse to select a 
file. This brings up a Select Device/Directory for Graphics File Export dialog box. Click on 
Accept to export the graphics files to the directory, on Reset to clear the graphics file choices, 
or on Cancel to quit. 
 

Figure 6-25. Export Graphics Files dialog box. 
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VI. Reports � 
Use this option to create, view, print or delete Raster map layer area reports. 
Pull Down Menu: 
��Generate Raster  (6-37) 
��View Report  (6-38) 
��Print Report  (6-39) 
��Delete Report  (6-39) 

 
A. Generate Raster 

Use this option to choose a Raster map layer for which GypsES produces a summary report 
file of areas by category number. Clicking on the Generate Raster option brings up a Raster 
Layer Area Report Definition dialog box (Fig. 6-26). Select the Raster layer you want to 
summarize by clicking once on the box to the right of “Raster layer” and select the mapset 
and file you want from the lists. You can select a Mask map layer to exclude those areas in 
the Mask layer that are coded “No Data” from area calculations. Click on Accept to finish the 
file selection or on Clear to clear the selection. Choose one or more unit(s) of area 
measurement for the report under the heading “Choose columns for report” by clicking once 
on the unit of measurement you want (the square toggle button next to the unit is indented 
once you select it). Give the report a filename by clicking once in the text entry window to 
the right of “Report filename” and typing in the filename. Click on Execute to generate the 
Raster layer area report. This summary file can either be viewed on the screen or printed to 
the default printer, if any, that has been defined. 
 

Figure 6-26.  Raster Layer Area Report Definition dialog box. 
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B. View Report 

Use this option to view a Raster layer area report that has been previously generated on the 
computer screen and saved. Click on View Report to bring up a Select Report to View dialog 
box. Select the appropriate mapset on the left and click on the report filename on the right. 
The area report is displayed on the screen (a sample is shown in Fig. 6-27). Click on Print to 
print the report or Exit to close the dialog box. 
 
 

 

User Tip: How A Mask Layer Might Be Used With Raster Reporting 
 
Suppose you have two Raster layers: one is a layer that shows those areas of the location that contain 
trees (for example, “ForestCover”), and another layer contains spray blocks that have been rasterized. 
You can print a Raster report of the spray blocks using the “ForestCover” layer as a mask. The 
resulting report shows the area of each spray block that contains trees. 
 

Figure 6-27.  Sample Raster Layer Area Report viewed on the screen. 
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C. Print Report 
This option prints a previously generated Raster layer area report to the default printer. 
 

D. Delete Report 
This option deletes an existing Raster layer area report. Highlight the name of the report and 
click on Accept to delete the report. 

 
VII. Graphics Output 

This option prints the contents of a Work Window to a file or output device (printer). If you have 
never used this option in GypsES or have never saved a graphics output setup file, a Graphics 
Output Setup dialog box appears (Fig. 6-28). 

 
 

 

Figure 6-28. Graphics Output Setup dialog box: file output. 
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If you have saved a graphics output setup file, you can either use the default settings (shown in 
Figure 6-28) or choose a previously saved setup. If you choose a previously saved setup file, the 
Graphics Output Setup dialog box changes to reflect the settings you saved.  

 
[Note: The Graphics Output Setup dialog box options are somewhat different for creating 
graphics output files versus hard-copy maps, so they are described in different sections: 
Graphics Output: File and Graphics Output: Printer.] 

 
A. Graphics Output: File 

 
1. Choose Type of Output: To create a graphics output file, click the diamond toggle button 

beside “File.”  
 

2. Graphics File Options: Click on Graphics File Options to bring up a Graphics File 
Output Options dialog box (Fig. 6-29).  

 

Figure 6-29. Graphics File Output Options dialog box. 
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a. File Type: The output file type is either TIFF or JPEG (see User Tip: “What are 
TIFF and JPEG files?” below). Click on the choice button to the right of “File 
Type” to choose a file type. 

 
 

b. Graphics File Dimensions: Type in the width and height (in pixels) of your graphics 
output file in the respective text entry windows. The default graphics output file size 
is 640x480 pixels. 

 
c. Background Color: Specify a background color for your file; the default is white.   

 
d. Output File: This is where you specify a path and filename for your graphics output 

file.  Click on Browse, select a directory to place the file in, and type in a filename. 
TIFF files normally have the suffix *.tif and JPEG files have the suffix *.jpg. 
GypsES does not supply a suffix, and the files can be created with other (or no) 
suffixes.  It is then up to you to keep track of the file type. 

 
Once you have specified the options in this dialog box, click on Accept to exit. 

 
 
 

3. Map Size Options: You can specify map size in three different ways. 
 

a. Scaled Map: You can use this option to relate the actual distance on the map to 

 

User Tip: “What are TIFF and JPEG files?” 
 
TIFF and JPEG are commonly used graphics file formats.  A graphics file is basically an array of 
codes that represent colored pixels (squares).  When these pixels are printed or displayed, they 
reproduce an image.  Depending on the number of pixels used, and the size of the screen or paper used 
for display or printing, the image produced from a graphics file is sharper (higher resolution, more 
pixels) or more blurry (lower resolution, fewer pixels).  As one might imagine, larger images with 
higher resolutions create very large files.  TIFF and JPEG formats attempt to compress the images so 
that they take up less disk space.  TIFF files are not as compact as JPEG files, but the TIFF format is 
more commonly used by standard PC graphics systems.  The decision to use one or the other, as well 
as the image dimensions chosen, is really dependent on what you plan to do with the graphics file. 
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pixels in your image. For example, if you decide that you want your map to be 500 
pixels wide in the file image and the actual width of the area you are going to place in 
the image is 50,000 feet wide, the settings illustrated in Figure 6-30 could be used. 

 

 
b. Fit To Page: This option is the easiest to use. GypsES takes into account the width 

and height of the image as well as text size (in pixels) and sizes the map to fit.  
 

c. Set Map Size: Use Set Map Size to specify the size of your map in pixels (Fig. 6-31). 
This should be compatible with the overall size of the graphics file you specified in 
the Graphics File Output Options dialog box. [Note: GypsES always retains the 
relationship between map width and height, so the program sizes the output map to 
be as large as it can be and still maintain the width:height ratio.] 

 
 

 
4. Text Options: If you want just a map with no text in your output file, click the diamond 

toggle button next to “Map Only.” If you want text (headings, legend, footings, etc.), 
click the diamond toggle button next to “Map With Text.” To specify text content and 

Figure 6-30. Graphics Output Setup dialog box: Map Size Options, Scaled Map 
option for file output. 

Figure 6-31. Graphics Output Setup dialog box: Map Size Options, Set Map Size 
option for file output. 
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font size, click Modify Text. A Graphics Output Text Options dialog box appears (Fig. 6-
32). 

 

 
 

Choose whether to print any of the text items in this dialog box by clicking the diamond 
toggle buttons next to “Print” or “Don’t Print.” To specify text size, enter the height in 
pixels for those text elements you want to print. 
 
a. Legend: Legends can be printed on the left (On Left) or the right (On Right) side of 

the map. 

Figure 6-32. Graphics Output Text Options dialog box. 
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b. Heading / Footing Text: Enter heading and footing text by clicking in the text entry 

windows provided and typing. There is no limit to the number of lines you can have 
in headers and footings, but the total number of characters (including spaces) in 
either can’t exceed 180 characters. 

 
c. Date: The date is printed below the scale and above the footing text. 

 
d. Scale: The scale, if specified, is printed below the map and above the date and/or 

footing (if specified). 
 

Once the settings are complete, click on Accept to close the Graphics Output Text 
Options dialog box. [Note: GypsES takes the font size specified into account when 
calculating the total size of the output.] 

 
B. Graphics Output: Printer 

 
1. Choose Type of Output: To create a hard-copy map on a printer, click the diamond 

toggle button beside “Printer.” The Graphics Output Setup dialog box changes for you to 
specify a printer and its settings (Fig. 6-33). 

 
2. Choose Printer: To specify printer output, you must have at least one printer installed on 

your computer.  If you do not, GypsES gives you a warning message and changes back to 
the file output option when you attempt to specify printer output. The program looks up 
all printers that are installed on your system and lists them. The default printer is your 
system’s default printer unless another printer was specified in a graphics output setup 
file that you recalled. To choose a printer, click on the choice button to the right of 
“Choose Printer” and select from the list of available printers. 

 
3. Setup Printer: Use this option to specify orientation (portrait or landscape), resolution 

(dots per inch) and paper size for the selected printer, among other options. The system 
setup dialog box for your printer appears. When you have completed your printer setup, 
click on OK to continue setup for your graphics output.  GypsES retains your settings and 
formats the output based on them. 
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4. Map Size Options: These options are the same as those for graphics output files; 

however, map dimensions are expressed in distance units rather than pixels (Fig. 6-34). 
 

 
5. Text Options: These options are the same as those for the graphics output file section; 

however, font sizes are expressed in inches or centimeters. 

Figure 6-33. Graphics Output Setup dialog box: printer output. 

Figure 6-34. Graphics Output Setup dialog box: Map Size Options, Set Map Size 
option for printer output. 
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C. Graphics Setup File Name 
Once you have set up the file or printer output, you should save your settings if you might 
use the same settings, map size options, and/or text options again. To do this, enter a 
filename in the text entry window provided and click on Save Setup.  The next time you 
select Graphics Output from the File menu, GypsES asks you to choose between using a 
saved setup file or using default settings. 
 

D. Preview 
To view the graphics output you are going to print on a printer or send to a file, click on 
Preview.  The output is displayed in a dialog box. If you are creating a very large map, the 
preview function scales down the size so the computer doesn’t use too much memory.  If 
necessary, the dialog box has vertical and horizontal sliding bars for viewing the entire 
output. When you are finished with the preview, click on Done to go back to the Graphics 
Output Setup dialog box. 

 
E. Print 

When you click on Print, GypsES attempts to create the graphics output file or send the file 
to the printer. If the settings entered are not compatible with the file or printer paper size, you 
are asked to revise your settings. Otherwise, progress bars are displayed to let you know the 
progress of the output. [Note: Working with large graphics output files and printing to large-
scale printers takes a while.] 

 
F. Cancel  

To exit the Graphics Output Setup dialog box at anytime, click on Cancel. [Note: Save your 
settings if you want to use them again because they are not otherwise retained.] 

 
VIII. Location / Mapset  

Use this option to work with mapsets and locations. 
Pull Down Menu: 
��Change Output Mapset  (6-47) 
��Make New Mapset  (6-47) 
��Delete Mapset  (6-47) 
��Change Location  (6-47) 
��Make New Location  (6-47) 
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A. Change Output Mapset 
When changing locations, you are prompted to select the output mapset from a list of 
previously created mapsets.  Work that is done during the current GypsES session is saved to 
that mapset.  Thus, any spray blocks drawn, reports generated, maps edited, and Views or 
Composite files saved are saved to the designated output mapset.  Select an existing Output 
Mapset name from the list on the dialog box and click Accept to complete this function.  You 
can also change mapsets within the current location right on the Main Screen by clicking the 
mapset name button at the bottom of the screen and choosing a new mapset from the list of 
available mapsets.  You are able to choose from a list of all available mapsets.  ONLY ONE 
OUTPUT MAPSET CAN BE DESIGNATED AT ONE TIME. 
 

B. Make New Mapset 
Use this option to create a new mapset. First enter a new mapset name, then press <Enter>. 
The new mapset is created and GypsES brings up a User Profile dialog box for that mapset. 
(See the Edit menu / Administrative Profile option / User Profile option on page 7-39 for 
more complete information about the User Profile dialog box.) 

 
C. Delete Mapset 

Mapsets can be deleted; however, you cannot delete a mapset if it is the current output 
mapset or mapset PERMANENT.  Select the mapset to delete within the �Select Mapset to 
Delete� list and click on Accept to delete it.  GypsES checks for the existence of files in the 
mapset and asks for confirmation of deletion if they exist. 

 
D. Change Location 

A location is a user-defined rectangular region on the face of the Earth defined by latitude 
and longitude values for the sides of the rectangle. GypsES converts the latitude and 
longitude values to UTM coordinates but can display either type of coordinate. You can work 
with any previously defined location stored in GypsES.  To choose a different location, 
highlight a location name from the “Choose Location” list and click on Accept. You can also 
change the location right on the Main Screen by clicking the Location button at the bottom 
of the screen and choosing a new location from the displayed list of available locations. 
 

E. Make New Location 
This option brings up a Create New Location dialog box (Fig. 6-35) to define a new location. 
Type in a location name, its UTM zone (see Table 5-1 on page 5-2 for a complete list), and 
the boundaries of the location in degrees, minutes, and seconds. Click on the choice button to 
the right of each boundary coordinate line to toggle between North/South or East/West. Use 
<Tab> to move from one entry field to the next.  
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Once you have specified the location’s boundaries and UTM zone, click on Check Area and 
Dimensions to calculate the area of the location just created and make sure you have defined 
a valid location. If the boundaries have been incorrectly specified (for example, if the east 
boundary was placed west of the west boundary, or if the wrong UTM zone was used), 
GypsES displays a dialog box specifying the error and prompts you to correct the problem.  
 
The area of the location appears to the right of “Area:”. You can display the new location’s 
area in either square miles or square kilometers by clicking on the choice button to the right 
of the area number. The North-South and East-West distances are also displayed below the 
area in either miles or kilometers (toggle between the two units using the choice button). 
Choose where to put the new location by clicking on the choice button to the right of the 
drive letter below “Put on Drive:” and selecting a drive from the list; then click on Accept.  
 
 

Figure 6-35. Create New Location dialog box. 
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[Note: If the drive you specify does not contain any GypsES data, the directories (folders) 
X:\GypsES and X:\GypsES\Data_Files (where X: is the drive) are created. Your location will 
be a folder in X:\GypsES\Data_Files.] 
 

IX. View GypsES Log: The GypsES log is an important trouble-shooting tool. Messages are saved to 
a log during every GypsES session. When there is a problem with the GypsES software, use this 
option to view or save either the current log or the log from the last (previous) session of GypsES 
(the log does not go back any farther than this). To save a log to a file, click on Save Log File; 
GypsES prompts you to type in a name for the log file. If you do not specify a full directory path, 
your file is saved in the X:\GypsES folder, where X is the drive in which the main GypsES 
directory resides. Then press <Enter> to save the file. GypsES automatically adds a “.log” 
extension to the filename. (See Error Messages on page 4-3.) To print the log to the default 
GypsES printer, click on Print. Click on Exit to close this dialog box. 

 
X. Quit GypsES: This option exits GypsES and returns you to the MS-DOS window that first 

appears when GypsES is started. 

 

User Tip: When to Make A New Location 
 
You will want to make a new location when you want to manage an area not currently contained in a 
location available in the GypsES system.  To determine the bounds of the new location, consult USGS 
or other maps. Remember that latitude gets larger from south to north, and longitude get smaller from 
east to west. 
 
It is probably a good idea to make the location a little larger than the area you are managing -- for 
instance, make the bounds whole or half minutes.  In some cases, you may want to expand an existing 
area.  There are ways to do this, but not within the GypsES program.  Check with GypsES user 
support personnel to expand a currently defined location. 
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The Edit Menu 
 
Use this menu option to work with map layers (MapEdit), edit databases (Database), define map 
features (Map Features), set Standard Name Linkages (Standard Name Linkages) and define your 
own user profile and management objectives (Administrative Profile). 
Pull Down Menu: 
��MapEdit  (7-1) 
��Database  (7-24) 
��Map Features  (7-34) 
��Standard Name Linkages  (7-38) 
��Administrative Profile  (7-39) 
 
I. MapEdit  

Use this option to create or edit (revise) Vector and SiteData map layers using MapEdit, the 
GypsES map-editing tool. 
Pull Down Menu: 
��Create New Vector Layer  (7-3) 
��Create New SiteData Layer  (7-20) 
��Revise Existing Vector Layer  (7-3) 
��Revise Existing SiteData Layer  (7-20) 

 
MapEdit Overview 
The MapEdit dialog box has a map display/work area on the left, a palette of functions on the 
right, and a status bar below the map display area for prompts and messages.  A UTM geographic 
coordinate display (in meters) in the lower right-hand corner changes simultaneously as the 
mouse pointer is moved.  A box showing the name of the layer being edited is in the top middle 
of the dialog box, and a help box is in the upper right corner (Fig. 7-1). 

 
Some editing functions are the same for both Vector and SiteData map layers.  These functions 
are grouped in the “General Functions” palette in the top right corner of the MapEdit dialog box. 
Functions that are unique to only one map layer type are in a separate palette below the “General 
Functions,” i.e. Vector Edit Functions (described starting on page 7-11) and Site Edit Functions 
(described starting on page 7-22). 

 
Working With Vector Map Layers 
A Vector map layer consists of lines defined by UTM coordinates (points) (Fig. 7-2).  Each line 
is made up of one or more points connected by segments.  The first and last points 
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of a line are called nodes.  Feature lines represent features on the Earth (e.g., roads, streams, and 
power lines), and polygon lines represent boundaries of areas (e.g., spray blocks, political 
boundaries, and forest stand boundaries).  One or more lines can define polygons. If the lines 
bounding a polygon do not intersect and are joined at nodes with no gaps, the polygon is closed; 
if there is a gap between polygon line nodes or if lines intersect at non-node points, the polygon 
is referred to as open or unclosed.  MapEdit does not properly recognize polygons unless they 
have non-intersecting polygon lines joined at nodes. 

 
You can label both feature lines and polygons. A label consists of two pieces of information. The 
first is a category number (integer) that may or may not have significance.  The second is a line 
of text called a category description.  Once you establish a link between a category number and a 
category description, MapEdit assumes that whenever that category number is used, you are 
referring to the previously assigned category description.  You can modify category descriptions 
associated with category numbers by selecting the Edit menu / MapEdit option / Vector Edit 
Functions palette / Tools palette / Edit Vector Categories option (see page 7-17). 

 
A. Create New Vector Layer / Revise Existing Vector Layer 

Within the MapEdit menu, you have the option of either creating a new Vector map layer 
(Create New Vector Layer) or editing an existing layer (Revise Existing Vector Layer). 
Choosing to edit an existing Vector map layer brings up a Select Vector File for MapEdit 
dialog box; select the map layer you want and click on Accept. Choosing to either create a 
new Vector map layer or edit an existing Vector map layer brings up a dialog box titled 
MapEdit: Vector Edit Options (Fig. 7-3).  [Note:  Once the options in this dialog box are 
defined, click on Accept to move into MapEdit.] 

 
1. MapEdit: Vector Edit Options 

Use these options when working with Vector map layers.  
 
When you select a Vector file for editing, you can change the Vector editing options prior 
to loading the Vector file.  [Note:  You can also modify the options at any time during the 
editing process by clicking on Set Vector Options within the “Vector Edit Functions” 
palette; this returns you to the MapEdit: Vector Edit Options dialog box.]  GypsES 
retains the most recently used Vector edit option settings for each unique output mapset.  
If you use locations or output mapsets that do not already have these options defined, the 
default options appear in this dialog box.   
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The edit option values that are defined before loading the map layer into MapEdit 
(especially the Node Consolidation Distance) affect how the file is loaded and how the 
Vector layer is displayed on the screen.  Options include: 

 
a. Default Line Type: Use this option to select the type of line to draw when using the 

Draw Line function within MapEdit. Three options are available: Ask Each Time, 
Polygon Line, or Feature Line. MapEdit needs this information so that it can 
identify polygons and determine whether they are closed. Polygon lines compose the 
sides of a polygon. Categories define what is inside the polygon (e.g., treatment block 
boundaries and spray block numbers). Feature lines cannot be part of a polygon and 
usually define some linear feature like roads or streams. The default is Polygon Line. 

 
b. Node Consolidation Distance: This value is expressed in meters and allows MapEdit 

to consolidate nodes that are within this defined distance of each other as it loads the 
Vector file.  If you are creating a new Vector file, the node consolidation distance is 
set to the same value as the Line/Node Selection Tolerance (see section c. on the 
next page for an explanation).  If you are editing an existing file, the node 
consolidation distance value should be initialized to zero, which means that no node 

Figure 7-3.  MapEdit: Vector Edit Options dialog box. 
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consolidation is done when the file is loaded.  It is recommended that you leave this 
value set to 0 when first loading an existing Vector file into MapEdit; the value can 
be changed later.  If an existing file is loaded with a non-zero node consolidation 
distance, the file may be corrupted.  This can happen if you are editing a file that has 
been imported from another system (e.g., ArcInfo) and the geographic coordinates of 
the nodes are slightly different; the Vector layer may have open-ended polygon lines 
and unclosed polygons as a result.  If the node consolidation distance is too large, 
information may be lost because MapEdit may collapse lines into points or join lines 
that should not be joined. 

 
It is important to note that consolidation of existing nodes occurs ONLY at load time. 
If the Vector file is loaded into MapEdit and nodes are not being consolidated 
properly, exit MapEdit and re-load the file using a different node consolidation 
distance.  Again, remember that MapEdit makes all its changes to a working copy of 
the original file, so the choice of an inappropriate consolidation distance does not 
change the original file UNLESS the file is saved under the same name prior to 
exiting.  Anytime you change the node consolidation distance and have chosen Yes 
for the Circle Nodes or Circle Points options (see section f. on the following page for 
a description), the screen is re-drawn to reflect the new consolidation distance. 

 
c. Line/Node Selection Tolerance: This is the radius in meters around lines or nodes 

within which they can be selected when you click the mouse on a map layer. If a very 
small selection tolerance is being used and the area being edited is relatively large, 
you may have problems selecting lines or connecting newly drawn lines to existing 
nodes. This is because the screen coordinates delivered to MapEdit from a mouse 
click and converted to geographic coordinates may not be within the line/node 
selection distance of the line or node being selected. After a Vector file is loaded into 
MapEdit, you can adjust the line/node selection distance at any time during the 
editing session to help draw new lines and select lines or nodes. To do this, click on 
Set Vector Options within the “Vector Edit Functions” palette within MapEdit. This 
returns you to the MapEdit: Vector Edit Options dialog box that precedes the loading 
of a Vector file. Alternatively, use the Edit menu / MapEdit option / General 
Functions palette / Change View option / Zoom In option (see page 7-8). 

 
d. Select Color: This is the color used to highlight a selected object (e.g., line, node, 

point, polygon, etc.). Click on the square under the “Color” column and choose a 
color from the palette. 

e. Polygon and Feature Line Specification: Use this option to select colors, line width, 
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and line style for polygon lines and feature lines. Click on the square under the 
“Color” column to select a color, click on the text entry window under the “Line 
Width” column and type in a line width, and click on the text entry window under the 
“Line Style” column to choose either a solid or dashed line style. 

 
f. Circle Nodes and Points: To have all node and point locations highlighted with 

circles, click on the square under the “Show” column to toggle between Yes (show 
circles) or No (do not show circles).  If Yes is selected for either nodes or points, 
select the circle color by clicking on the square under the “Color” column.  The 
radius of the circle represents the node consolidation distance in meters. 

 
g. Polygon and Feature Label Display: Choose Yes or No to display category labels for 

all polygons and feature lines by clicking on the square under the “Show” column. 
[Note: Each line type can have an assigned category value, or number, that must be 
numeric.  Category numbers can be unique or repeated.  Each category number is 
paired with a category description that can be an alphanumeric value.] To choose a 
label color, click on the square under the “Color” column and select a color.  Click on 
the square under the “Content” column to toggle between showing category numbers 
(Cat No.) or descriptions (Cat Desc.).  Click on the square under the “Font Weight” 
column to choose either normal (Normal) or bold (Bold) label text.  Click on the 
square under the “Font Height” column and type in the font size you want (in pixels). 
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2. General Functions.  These general editing functions apply to both Vector and SiteData 
map layers and are located in a palette in the top right corner of the MapEdit dialog box 
(Fig. 7-4). 
Palette Buttons: 
��Change View  (7-7) 
��Edit Features  (7-9)  
��Draw Backdrop  (7-9) 
��Catalog Composite  (7-9) 
��Save  (7-9) 
��Show Distance  (7-10) 
��Graphics Output  (7-10) 
��Exit  (7-10) 

 
 
 
 
 
 
 
 
 
 
 
 
 

a. Change View.  When you click on this push button, another palette of push buttons 
titled “Change View Functions” appears below the “General Functions” section of 
the MapEdit dialog box. 
Palette Buttons: 
�� Change Res[olution]  (7-8) 
�� Save View  (7-8) 
�� Full View  (7-8) 
�� Recall View  (7-8) 
�� Zoom In  (7-8) 
�� Zoom Out  (7-8) 
�� Previous View  (7-9) 
�� Set Mask  (7-9) 
�� Cancel Change View  (7-9) 

Figure 7-4.  MapEdit: General 
Functions palette. 
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(1) Change Resolution: There are two types of resolution: Raster File Resolution 
and Viewing (Screen) Resolution. Raster File Resolution is the resolution of the 
Raster map layer when created and is expressed in meters; it can never be smaller 
than what it was at the time of creation. Viewing (Screen) Resolution is the 
resolution of the map layer that is displayed on the screen and is also expressed in 
meters.  See the Change Resolution option under the Window menu / Change 
View option on page 8-12 for more information. 

 
(2) Save View: This option saves a View so that you can quickly return to a specified 

portion of the map. Views are saved in the current output mapset. After clicking 
Save View, you are prompted to enter a name for the View. Saved Views can be 
retrieved with Recall View (see the description below). Once you have saved 
your View, you are returned to the “General Functions” and “Vector Edit 
Functions” palettes. 

 
(3) Full View: This option displays the map layer using the default View for the 

current location. Once you click on this push button, you are returned to the 
“General Functions” and “Vector Edit Functions” palettes. 

 
(4) Recall View: Use this option to select a View that you already saved. Clicking on 

this option brings up a Select View File dialog box to select a saved View file. 
Click on the View file you want, then click on Accept to draw this View on the 
screen. Once your View is recalled, you are returned to the “General Functions” 
and “Vector Edit Functions” palettes. 

 
(5) Zoom In: Use this option to zoom in on a particular section of the current View. 

Click once to establish a corner, release the mouse button, then stretch the box in 
any direction by moving the mouse pointer to the opposite corner to define the 
rectangle that represents the new View. When the mouse is clicked a second time, 
GypsES prompts you to accept or cancel the new View. If accepted, the current 
map is redrawn showing the area selected. 

 
(6) Zoom Out: See the Zoom Out option under the Window menu / Change View 

option on page 8-12 for a description of this function. Once you have zoomed 
out, you are returned to the “General Functions” and “Vector Edit Functions” 
palettes. 
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(7) Previous View: This option changes the current View to the last defined View. 
Once this option is selected, you are returned to the “General Functions” and 
“Vector Edit Functions” palettes. 

 
(8) Set Mask: A special kind of data layer, called a Mask, can be used as a “cookie 

cutter” to display only a selected portion of a location while “hiding” the rest of 
the map layer. This function applies only to Raster layers. (See the Set Mask 
option under the Window menu / Change View option on page 8-11 for a 
description.) 

 
(9) Cancel Change View: This returns you to the “General Functions” and “Vector 

Edit Functions” palettes. 
 

b. Edit Features: This brings up a palette of push buttons (“Feature Functions”) for 
creating and editing map labels. (See the Edit menu / Map Features option / Map 
Labels option on page 7-34 for more information.) These functions do NOT label 
polygons or feature lines. 

 
c. Draw Backdrop: Use this option to choose what map layers, images, and other 

mapping options are in the background while working in MapEdit. A Build/Update 
Map dialog box appears to build a backdrop from existing Raster, Vector, SiteData, 
and Composite map layers. (See page 8-2 for more information on using this dialog 
box.) The presence of additional layer data does not affect editing of the current file. 

 
d. Catalog Composite: This option saves the current map display as a Composite layer 

in the current output mapset. You are asked to enter a name for the Composite file. If 
the filename already exists in the mapset, you are asked if you want to overwrite the 
file or enter a new name. Once you type in a filename, the Composite file is saved. 
This file can now be used as an overlay in MapEdit or viewed in the Work Windows. 
[Note: The file itself being edited is NOT saved as part of the composite.] 

 
e. Save:  This option saves the current work file.  As with any data entry operation,  if 

you are making a large number of changes, it is recommended to save the file often. 
The first time you click on Save, GypsES prompts you for a filename. If the filename 
you type in already exists, GypsES warns you that the file will be overwritten. You 
can then confirm or cancel this function.  The new file is stored in the current output 
mapset.  After the first save, GypsES asks whether to save the file using the name 
previously specified or a new name. 
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f. Show Distance: This option calculates the distance on a map between two selected 
points; you choose the unit of measure.  A Distance Calculation dialog box appears 
(Fig. 7-5).  You are prompted to click the left mouse button once on one point to start 
the distance calculation, then click on a second point. The “Current Distance” 
between these points appears in the dialog box. A “Cumulative Distance” is also 
displayed if you select more than two points. You can set all distance calculations to 
0 by clicking on Reset. To exit the Show Distance calculation, either click the right 
mouse button or click on Quit in the Distance Calculation dialog box. 

 

 
g. Graphics Output: This option displays a Graphics Output Setup dialog box (see the 

Graphics Output option under the File menu on page 6-39 for information about this 
dialog box). 

 
h. Exit: This option exits MapEdit and returns you to the GypsES Main Screen. 

Figure 7-5. MapEdit: Distance Calculation dialog box. 
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3. Vector Edit Functions 
Use these editing functions when working with lines, nodes, and other features of Vector 
files.  These functions are located in a palette in the lower right corner of the MapEdit 
dialog box (Fig. 7-6). 
Palette Buttons: 
��Draw Line  (7-11) 
��Define Label  (7-12) 
��Delete Line  (7-13) 
��Un-Delete  (7-13) 
��Snap Line to Node  (7-13) 
��Insert Node  (7-13) 
��Set Vector Options  (7-13) 
��Move Node  (7-14) 
��Tools  (7-14) 
��Re-Draw Screen  (7-19) 
 

 
 
 
 
 
 
 
 
 
 
 

a. Draw Line: Use this function to draw polygon or feature lines. When you click on 
Draw Line, you are asked what type of line is to be drawn if the Default Line Type 
option within the Vector Edit Options dialog box is set to Ask Each Time.  Once you 
select either feature or polygon, the line drawing function of MapEdit takes over; 
MapEdit interprets the movement of the mouse pointer and behaves accordingly. 

 
As long as the mouse pointer is in the map display window, you can click the mouse 
to establish points on the line.  You can click the right mouse button at any time to 
open the “Draw Line Functions” palette that provides the following options: 

 
 

Figure 7-6. MapEdit: Vector 
Edit Functions palette. 
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(1) Accept Line - Continue Drawing: Clicking this push button catalogues the line 
you just drew; GypsES assumes that you want to draw another line of the same 
type specified in the Vector Edit Options dialog box or when the Draw Line 
mode was first selected. The “Draw Line Functions” palette is removed, and you 
can begin a new line. 

 
(2) Erase All Segments - Exit: This option erases all segments you drew in the 

current line and exits the Draw Line function. The “Vector Edit Functions” 
palette is re-displayed. 

 
(3) Erase Previous: Clicking this push button erases the previously drawn segment, 

removes the “Draw Line Functions” palette, and lets you re-specify the last point. 
 

(4) Continue Drawing: This resumes the Draw Line operation. The “Draw Line 
Functions” palette is removed and you can keep drawing. 

 
(5) Accept Line - Exit: Clicking this push button catalogues the line you just drew 

and exits the Draw Line mode. 
 

(6) Erase All Segments - Continue: This option removes all segments in the last line 
being drawn and lets you try again. 

 
b. Define Label: Use this option to define a label (a category number and a line of text) 

for a polygon or feature line. You are prompted to click on the line or in the polygon 
you are labeling. You can exit the labeling function at any time by clicking the right 
mouse button. When a line or polygon has been selected, MapEdit highlights it and 
asks whether you want a label (e.g., “Label polygon 3?” or “Label Line 43?”).  
Confirm by clicking the left mouse button. GypsES then prompts you to type in a 
category number and category description. 

 
Use the Vector Edit Options dialog box to choose between showing category 
numbers or category descriptions on the map layer. A GypsES message tells you 
what the current label is if the line or polygon is already labeled. [Note: Even though 
you did not choose to display polygon or feature line labels in the Vector Edit 
Options dialog box, the label is displayed temporarily. You can remove it by clicking 
Re-Draw Screen.] 
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c. Delete Line: Use this option to delete lines.  MapEdit asks you to click on the line to 
delete. MapEdit re-draws the line in the highlight color and asks if the highlighted 
line is the one you want to delete. Clicking the left mouse button or pressing <Enter> 
confirms the deletion selection. Clicking the right mouse button or pressing <Esc> 
cancels the selection and prompts you for another line. An additional right mouse 
click takes you out of “delete” mode. If no line becomes highlighted after clicking, 
MapEdit did not find a line within the line/node selection tolerance distance of where 
you clicked. Use either the Set Vector Options function to increase this distance or 
use the Zoom In function to make line selection easier. 

 
d. Un-Delete: This option restores the last delete. 

 
e. Snap Line to Node: Use this option to join a line to a node. When this is done, the 

selected line moves, but the node you snap it to does not. The line moves from the 
last point or vertex defining the line. This function is very useful to close polygons 
and join lines. 

 
To snap a line to a node, first click on Snap Line to Node.  MapEdit then asks you to 
select the line to snap by clicking on it with the mouse. Since every line has two ends, 
MapEdit assumes that the end that is snapped is the one closest to the place where 
you clicked it. Both the line and the node that change are highlighted, and you are 
prompted to select the node to which to attach the line. The selected node is then 
highlighted; if you confirm that it is correct by either clicking the left mouse button 
or pressing <Enter>, the line is snapped to the node. To end the Snap Line to Node 
option at any time, click the right mouse button. 

 
f. Insert Node: Use this option to insert a node in an existing line. This effectively 

creates two new lines and allows you, for instance, to join a third line to the new node 
at that point. MapEdit asks you to select a line by clicking on it. (As with the Delete 
Line function, you may need to adjust the geographic View or the line/node selection 
tolerance distance to select the line.) MapEdit then highlights the line and asks you to 
place the cursor on the new node location and click. Confirm the new node placement 
by clicking the left mouse button or pressing <Enter>. Clicking the right mouse 
button effectively erases the last left mouse click and eventually cancels the insert 
node operation. 

 
g. Set Vector Options: This option returns you to the Set Vector Options dialog box. 
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h. Move Node: Use this option to move a node. Once this push button is selected, click 
the mouse once on the node you want to move. Release the mouse button and drag 
the mouse pointer (+) to the new node location (a highlight line moves with the 
pointer). Click the left mouse button when the move is done; confirm the move with 
another left mouse button click or press <Enter>. Clicking the right mouse button at 
any time exits the node move function.  [Note: Only the segments closest to the node 
move.] 

 
i. Tools: MapEdit provides several tools to help make sure that the Vector layer is 

"clean."  Clicking on the Tools option brings up a new palette of functions titled 
�Vector Edit Tools� in the lower right corner of the MapEdit dialog box (Fig. 7-7). 
Palette Buttons: 
�� Find Open Polygon Lines  (7-15) 
�� Convert to Raster  (7-15) 
�� Find Degenerate Line  (7-17) 
�� Edit Vector Categories  (7-17) 
�� Find Intersects  (7-18) 
�� Calculate Polygon Area  (7-18)  
�� Find One-Line Nodes  (7-19) 
�� Save Labeled Lines  (7-19)  
�� Find Un-Labeled Polygons  (7-19) 
�� Re-Draw Screen  (7-19) 
�� Re-Build Polygons  (7-19) 
�� Exit Tools Menu  (7-19) 

 
 
 
 
 
 

Figure 7-7. MapEdit: Vector Edit Tools palette. 
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(1) Find Open Polygon Lines: An open polygon line does not have a closed polygon 
on either side of the line. When you select this option, GypsES highlights all 
open polygon lines in the selection color and tells you how many open polygon 
lines were found in the working View. Click on Re-Draw Screen in the Tools 
palette to clear the highlighting of open polygon lines. Sometimes it is difficult to 
see why a polygon is not closed: 

 
(a) There may be a degenerate line at a node. You can ask MapEdit to identify 

any degenerate lines by clicking the Find Degenerate Lines option (see 
description on page 7-17). 

 
(b) A node may not be connected to at least two lines. You can usually spot these 

by choosing the option to find one-line nodes. Any nodes with only one 
polygon line attached are circled in the selection color. 

 
(c) There may be an intersection of lines with no node.  You can find intersecting 

lines by clicking on Find Intersects within this Tools palette.  Once the 
points of intersection are located (a circle in the selection color is displayed 
around each intersection), you must Zoom In to spot the problem.  After 
zooming in, however, you need to prompt GypsES to highlight the line 
intersections again; this information does not carry over during the Zoom In 
function. 

 
(2) Convert To Raster: This push button converts polygons to Raster format. The 

first thing you should probably do when converting to Raster format is be sure 
that the proper geographic View is on the GypsES screen. The Raster conversion 
is only done for that part of the layer that is visible on the screen. You will 
usually want to be at Full View for Raster conversion. 

 

 

 

User Tip: Changing the Resolution of A Raster File 
 
The resolution of a Raster file you create can be modified using the Edit menu / MapEdit option / 
“General Functions” palette / Change View option / Change Res[olution] option (see pages 7-8 and 
8-12 for more information). 
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When Convert to Raster is clicked, MapEdit first warns you if you are not at Full 
View. You can then choose to exit and change the View or to continue.  MapEdit 
then checks for open area lines. These are lines that have been designated as 
polygon lines, but that are not recognized as a boundary for at least one polygon. 
If MapEdit finds any of these lines, it highlights them and refuses to proceed with 
the conversion. If this happens, you should carefully examine the highlighted 
lines, perhaps zooming in on their nodes. Sometimes saving the layer, exiting, 
and re-loading with a larger node consolidation distance cures the problem.  
Sometimes you need to use the Vector Edit Functions to attach lines. Use the 
Tools palette functions to highlight open polygon lines and degenerate lines. If 
changes have been made, use the Tools function to re-build polygons. This 
sometimes closes polygons properly. 

 
Once all open polygon lines are resolved, MapEdit checks to be sure that you 
have labeled all polygons. If they are not labeled, unlabeled polygons are 
highlighted and you have three options: 

 
(a) Specify Default: If you select this option, you are prompted to specify a 

default category number and text for any unlabeled polygons. 
 

(b) Treat as No Data: This option labels any unlabeled polygons as "No Data" 
when converting them to Raster. 

 
(c) Cancel: This option cancels the Raster conversion function. 

 
Once the labeling issue is resolved, MapEdit asks you about colors for the Raster 
file. You have the following options: 

 
(d) Exit to Set: This option gets you out of the Convert To Raster option. You 

can then set category colors for the Raster conversion using Edit Vector 
Categories in the “Vector Edit Tools” palette (see the description under 
section (4) on the following page). 

 
(e) Use as Set: If you have already set the colors, this tells MapEdit to use them. 

 
(f) Random Colors: MapEdit uses a random selection of colors for the 

categories established when the polygons were labeled. 
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Once you have specified color assignment, MapEdit asks for the name of the new 
Raster layer. The Raster layer can have the same name as the Vector layer, or a 
new name can be provided. When the conversion to Raster is complete, MapEdit 
asks if you want to display the Raster layer as a background. If Yes is selected, 
the Raster version of the Vector layer is drawn in the background. 

 
(3) Find Degenerate Lines: A degenerate line is one in which all points in the line 

are within the node consolidation distance of each other. Depending on how other 
lines connect to the degenerate line, its presence may prevent a polygon from 
being closed. Clicking on Find Degenerate Lines causes MapEdit to circle all 
degenerate lines in the selection color. In general, it is best to delete these lines. 
They serve no useful purpose and tend to be confusing. 

 
(4) Edit Vector Categories: Use the Edit Vector Categories option to change the text 

associated with an existing category number, to add a new category, and to set 
category colors for Raster map layer conversion. When you click Edit Vector 
Categories, an Edit Categories dialog box appears on the screen. This dialog box 
can be used to: 

 
(a) Add New Categories: If you know that you are going to use certain categories 

to create polygons or feature lines, categories can be set up ahead of time. To 
add a category, click on New Category at the bottom of the dialog box. 
MapEdit prompts you for a category number and associated category 
description. The new categories are added to the bottom of the list. 

 
(b) Change the Text Line Associated with an Existing Category: Click on the 

line you want to change and type the new text in the text entry window in the 
“Description” column. Click on Accept to accept the new description text. 

 
(c) Assign Colors to Existing Categories: This has meaning only if you are 

about to convert to Raster. As you click on the box to the right of each 
category text line in the “Color” column, the red, green, and blue color bars at 
the bottom of the dialog box change to reflect the color mix. Slide these color 
bars back and forth until you get the color mix you want. 

 
When you have edited the categories, click on Accept to save your edits or on 
Cancel to cancel your edits. 
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(5) Find Intersects: This function locates any intersection of lines and circles them 
in the selection color. The intersection of feature lines may be perfectly 
legitimate, but the intersection of polygon lines inevitably causes problems.  In 
the case of two lines intersecting where there should be a node, the problem is 
easily corrected by using the Insert Node function in the �Vector Edit 
Functions� palette on both lines. Sometimes an intersection is the result of a line 
draw operation that overshot a node. The intersection is very close to the node 
and is hard to see unless you use the Zoom In function. If this happens, you can 
insert a node on the line before the intersection and delete the part of the old line 
that is intersecting another line connected to the node. Then use the Snap Line to 
Node function (page 7-13) so that the line correctly ends at the node. 

 
(6) Calculate Polygon Area: This function can calculate both the area of a single 

polygon and the cumulative area of several polygons, similar to the Show 
Distance calculation described on page 7-10. An Area Calculation dialog box 
appears (Fig. 7-8); choose a unit of area measurement. Clicking inside a polygon 
displays its area within the “Current Area” section of the dialog box; you can 
calculate a cumulative polygon area by clicking on any number of polygons. 
Click on Reset to set all area calculations to 0. To get out of this dialog box, 
either click the right mouse button or click on Quit. 

 

Figure 7-8.  MapEdit: Area 
Calculation dialog box. 
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(7) Find One-Line Nodes: This function locates polygon line nodes attached to only 
one line and highlights them as described on page 7-15 under Find Open 
Polygon Lines.  Once one-line nodes have been found, you can either delete the 
line or close the polygon using the Draw Line or Snap Line to Node functions. 

 
(8) Save Labeled Lines: Used in feature line mode, this function selectively saves a 

unique combination of feature line categories as a Vector layer. This subset of all 
feature lines can be retrieved and viewed at any time by adding the Vector layer 
to the current map. 

 
(9) Find Un-Labeled Polygons: This function highlights all polygons that are not 

labeled. 
 

(10) Re-Draw Screen: This function re-draws the GypsES screen. Although MapEdit 
attempts to re-draw the screen whenever major changes to the display have been 
made, the screen can be re-drawn at any time during the session. 

 
(11) Re-Build Polygons: This option causes MapEdit to re-build all polygons. This is 

useful if you have made many changes. As you draw and change individual lines, 
MapEdit does not always recognize that a polygon has been closed. The Re-
Build Polygons function completely re-builds all polygon structures. 

 
(12) Exit Tools Menu: This function returns you to the �Vector Edit Functions� 

palette. 
 

j. Re-Draw Screen: MapEdit attempts to re-draw the screen whenever major changes 
to the display have been made. However, click this push button anytime you want to 
be sure that what is seen is what is really there. This function is particularly useful in 
clearing highlighted lines from some of the “Vector Edit Tools” options. 

 
Working With SiteData Map Layers 
SiteData files have a set of x,y geographic (UTM) coordinates that define points within a 
location; any database file can be formatted to create a SiteData file as long as it contains fields 
that have UTM coordinates. These points can represent trap sites or other sampling locations and 
may contain other data located at these points.   
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B. Create New SiteData Layer / Revise Existing SiteData Layer 
Within MapEdit, you have the option of either creating a new SiteData layer (Create New 
SiteData Layer) or editing an existing layer (Revise Existing SiteData Layer). If you need to 
create a new SiteData layer, a Select SiteData File to use as Template dialog box appears for 
selecting a SiteData file.  A useful template to use would be another SiteData file that has 
field definitions that are suited to the new SiteData layer. If such a template does not exist, 
one must be created. To create a database file, open the GypsES Edit menu and choose the 
Database / Create New Data File option.  To make edits to an existing database file, open 
the Edit menu and choose the Database / Edit/View Data File option. 
 
Choosing to edit an existing SiteData map layer brings up a Select SiteData File for MapEdit 
dialog box; select a map layer and click on Accept. Choosing to either create a new SiteData 
map layer or edit an existing SiteData map layer brings up a dialog box titled MapEdit: 
SiteData Edit Options (Fig. 7-9).  [Note: Once the options in this dialog box are defined, 
click on Accept to move into MapEdit.] 

 
 
 

Figure 7-9.  MapEdit: SiteData Edit Options 
dialog box. 
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1. MapEdit: SiteData Edit Options 
Use these options when working with SiteData map layers. 

 
a. Highlight (Selected) Display: Use this option to edit options for displaying 

information about selected sites only on the screen. Click on Modify to the right of 
“Selected Display” to bring up the Site Display Options dialog box. (See the 
Selecting a SiteData Map Layer option under the Window menu / Build/Update 
Map option on page 8-6 for a description.) In general, the highlight display should be 
fixed, i.e., a single color, symbol, and size. The database field should be left as 
“UNASSIGNED.” The labeling of selected sites is probably unnecessary. 

 
b. SiteData Display Parameters: Use this option to edit options for displaying 

information about all sites on the screen. Click on Modify to the right of “SiteData 
Display Parameters” to bring up the Site Display Options dialog box. The options 
you select in this dialog box affect the display of all sites, not just those selected. (See 
the Selecting a SiteData Map Layer option under the Window menu / Build/Update 
Map option on page 8-6 for a description.) 

 
c. Selection Tolerance Distance: This is the distance in screen pixels within which a 

site is selected when you click the left mouse button once on a map layer; 5 is a 
recommended default value. 

 
2. General Functions Palette: See the “General Functions” section starting on page 7-7 for 

a description of these functions. 
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3. Site Edit Functions (Fig. 7-10). 
Use these editing functions when working with SiteData map layers. 
Palette Buttons: 
��Add Site  (7-22) 
��Edit Site Info  (7-22) 
��Select Single Site  (7-22) 
��Select Sites in Polygon  (7-23) 
��Move Selected Sites  (7-23) 
��Clear Selected Sites  (7-23) 
��Delete Selected Sites  (7-23) 
��Un-Delete  (7-23) 
��Set Site Options  (7-23) 
��Re-Draw Screen  (7-23) 

 
 
 
 
 
 
 
 
 
 
 

a. Add Site: Use this option to add sites to a SiteData layer. To add a site, click on the 
new site location on the map; a DataBase dialog box appears with the new site’s 
UTM coordinates that were detected when the site was clicked. Values for other 
fields in that database record can be added now or later; for instance, sampling 
locations for an egg mass survey might be established in MapEdit, and survey 
information added later using the database update function. 

 
b. Edit Site Info: This option brings up the DataBase dialog box to view or change data 

associated with a site you have selected.  Once the Edit Site Info option is selected, 
click on a site to select it and display its data.  Clicking once with the right mouse 
button ends the Edit Site Info function. 

 
c. Select Single Site: Use this option to choose single sites by clicking on the site. Sites 

selected are highlighted with a set highlight color and symbol (see the Highlight 

Figure 7-10.  MapEdit: Site Edit 
Functions palette. 
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(Selected) Display description on page 7-21). Be sure to make the selection tolerance 
distance small enough so that when the mouse button is clicked to select a site, the 
site closest to the mouse pointer is selected. 

 
d. Select Sites in Polygon: Use this option to draw a polygon around sites to select them 

as a group (similar to the “group selection” function in slide presentation software). 
Each click of the left mouse button defines a corner of a polygon drawn around sites 
you want to select; move the mouse pointer between corners. Click the right mouse 
button to end the selection process and highlight selected sites. 

 
e. Move Selected Sites: This option moves selected sites as a group. After selecting this 

option, place the mouse pointer anywhere on the map and hold the left mouse button 
down to move the group of selected sites; release the left mouse button to stop the 
move. GypsES prompts you to click Complete if the move is complete, Cancel to 
cancel the move function, and Continue to continue the move. 

 
f. Clear Selected Sites: This option deselects sites.  After sites are cleared, none are 

considered “selected.”  Do not confuse this with Delete Selected Sites described 
immediately below; the Clear Selected Sites function only deselects selected sites, 
but does not delete them. 

 
g. Delete Selected Sites: This option deletes all selected sites (see the Un-Delete 

function to keep deleted sites after they have been deleted). Do not confuse this with 
Clear Selected Sites; the Delete Selected Sites function actually deletes selected sites. 

 
h. Un-Delete: This option restores the SiteData layer to its status before the last delete. 

 
i. Set Site Options: This option brings up the SiteData Edit Options dialog box (see 

pages 7-20 and 7-21 for a description). 
 

j. Re-Draw Screen: This option refreshes the MapEdit screen with any changes you 
have made. 
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II. Database 
Use this option to edit, view, create or modify database files or to create a SiteData file from a 
database file. 
Pull Down Menu: 
��Edit/View Data File  (7-24) 
��Create New or Modify Existing Data File ��(7-26) 
��Make SiteData File from Database File  (7-33) 

 
A. Edit/View Data File 

Use this option to edit or view a data file from within available mapsets. [Note: The data file 
has to be located in the current mapset to edit the database.   If a file is located outside the 
current mapset and you receive a GypsES message that the “Data Entry Mode [is] set to 
VIEW,” then the data can be viewed but not changed.] A Select .DBF file to Edit/View dialog 
box appears; select the appropriate mapset and file and click on Accept to accept the 
selection, on Clear to clear the selection, or on Cancel to end the selection process. A 
Database dialog box then appears with individual data records. Within the Database dialog 
box, you can toggle between viewing the entire spreadsheet (“Spreadsheet View,” Fig. 7-11) 
or viewing individual records (“Record View,” Fig. 7-12) by clicking on the appropriate tabs 
in the upper left corner of the dialog box. The database record number of the record currently 
highlighted (e.g., Record “x” of the total number of records) is listed in the lower left corner 
of the dialog box. Clicking on OK removes the Database dialog box. Options available 
within the database edit mode include: 

 
1. Add New: Click on this option to add a new database record (one click adds a new record 

to the bottom of the database). 
 

2. Delete: Choose this option to delete a database record; select the data record you want to 
delete and click once on Delete. 

 
3. Restore Field: Use this option to restore the content of a data field cell that you erased. 

 
4. Restore File: Click on this option to restore the file by clearing all edits made since the 

file was opened for editing; GypsES warns you that all changes will be lost. 
 

5. Modify Fields: Choose this option to modify existing data fields; this brings up a 
Create/Modify Database dialog box described on page 7-28 under the Edit menu / 
Database option / Create New or Modify Existing Data File option / Modify Existing 
Database option. 
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Figure 7-11.  Database dialog box: Spreadsheet View. 

Figure 7-12.  Database dialog box: Record View. 
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6. Find: Use this option to find a specific data record within the database by either 
matching a whole word or by matching case. 

 
7. Spreadsheet Scrollbar: Use the spreadsheet scrollbar function to “freeze” (hold constant 

on the screen) a defined number of data fields when scrolling from the left side (“Front”) 
and/or right side (“Trailing”) of the database.  The number of fields frozen is controlled 
by sliding the double-box cursor with the number above it to the right or left; the number 
that appears above this cursor is how many fields are frozen on the screen when scrolling 
through the database. 

 
8. Clear Database Field on Entry: Checking this option provides a shortcut that clears cell 

contents when you click on the cell to add new data. 
 

B. Create New or Modify Existing Data File 
Use this option to create and modify both databases and templates. 
Pull Down Menu: 
�� Create New Database  (7-27) 
�� Modify Existing Database  (7-28) 
�� Make New Database from Template  (7-29) 
�� Create New Template  (7-30) 
�� Modify Existing Template  (7-31) 
�� Create Template from Database  (7-32) 
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1. Create New Database: This option brings up a Create/Modify Database dialog box to 
create a new database from scratch (Fig. 7-13).  Define new data fields in the “Field 
Properties” box in the lower left corner of the dialog box. For each field, type in the field 
name, select the data type (click on the choice button to the right of “Data Type” for an 
options list), and specify field size and the number of decimal places you want.  Your 
choices simultaneously appear in the field name list above. Once these properties are 
defined, click on Next Field to define the next field. Edit data field entries by selecting 
the data field (click once on the data field line above) and editing the appropriate “Field 
Properties” cells.  

 

Scroll through the database field name list by using the down arrow key, clicking on Next 
Field, or by clicking on the arrows on the right side of the field name box. A data field 
can be selected by clicking on its line once. To delete a selected data field, click once in 
the small cell just to the left of the field name cell; you are then asked, “Delete Current 
Field?”  Click Yes to delete or No to retain the data field. Once the database is created, 

Figure 7-13.  Create/Modify Database dialog box: 
Create New Database. 
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type in a filename in the text entry window below “New Database Name in [mapset 
name].”  Click on Accept to complete the database creation or on Cancel to abort the 
process. 

 
2. Modify Existing Database: This option is used to add or delete fields in an existing 

database.  A Select Existing database file dialog box first appears to select a mapset and 
database file. Click on Clear to clear the current selection, on Accept to complete the 
selection, or on Cancel to abort the selection process. The Create/Modify Database 
dialog box then appears (Fig. 7-14).   

 

New data fields can be added to the list (the word “Add” appears in the small cell to the 
left of the field name cell).  To modify added data fields, click once on the data field line 
to select it, then click on the appropriate box in the “Field Properties” section to make 
changes (use the backspace key to delete text or highlight the entire entry and hit 
<Delete>).  Delete existing data fields by first selecting the data field line; if data exists 

Figure 7-14. Create/Modify Database dialog box: 
Modify Existing Database. 
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in the field, “Del” appears in the square just to the left of the field name cell.  If you click 
the data field line again, GypsES warns you that data does exist in the field and asks if 
the field and data should still be removed.  If no data exists, GypsES simply asks “Delete 
Current Field?” Click on Yes to delete the field or on No to retain it.  Once the database 
is modified, type in a filename in the text entry window below “Existing Database 
Name.”  Click on Accept to complete the database modification or on Cancel to abort the 
process. 

 
3. Make New Database from Template: You can use a template to create a new database; a 

template is basically an empty database file stored in a location that protects it from being 
updated.  This would be useful if you build the same database for every year (e.g., egg 
mass counts).  A Select Existing TEMPLATE file dialog box first appears to select a 
mapset and template file. Click on Clear to clear the current selection, on Accept to 
complete the selection, or on Cancel to abort the selection process. The Create/Modify 
Database dialog box then appears (Fig. 7-15).  

 

Figure 7-15. Create/Modify Database dialog box: Make 
New Database from Template. 
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You can add new data fields to the list (the word “Add” appears in the small cell to the 
left of the field name cell).  Modify existing data fields by clicking once on the data field 
line to select it, then clicking on the appropriate box in the “Field Properties” section to 
make changes (use the backspace key to delete text or highlight the entire entry and hit 
<Delete>).  To delete existing data fields, first select the data field line; after clicking 
again, GypsES asks “Delete Current Field?”  Click on Yes to delete the field or on No to 
retain it.  Once the database is created, type in a filename in the text entry window below 
“New Database name in [mapset name].”  Click on Accept to complete the database 
creation or on Cancel to abort the process. 

 
4. Create New Template: Use this option to create a template from scratch. The same 

Create/Modify Database dialog box described under Create New Database (page 7-27) 
appears (Fig. 7-16).  After defining all data fields for the new template, type in a template 
filename in the text entry window below “New Template Name in [mapset name].  Click 
on Accept to complete the template creation or on Cancel to abort. 

 

Figure 7-16. Create/Modify Database dialog box: Create 
New Template. 
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5. Modify Existing Template: Use this option to make changes to an existing template file. 
A Select Existing TEMPLATE file dialog box first appears to select a mapset and 
template file. Click on Clear to clear the current selection, on Accept to complete the 
selection, or on Cancel to abort the selection process. The Create/Modify Database 
dialog box then appears (Fig. 7-17).   

 

 
You can add new data fields to the list (the word “Add” appears in the small cell to the 
left of the field name cell).  Modify existing data fields by clicking once on the data field 
line to select it, then clicking on the appropriate box in the “Field Properties” section to 
make changes (use the backspace key to delete text or highlight the entire entry and hit 
<Delete>).  To delete existing data fields, first select the data field line; after clicking 
again, GypsES asks “Delete Current Field?”  Click on Yes to delete the field or on No to 
retain it.  Once the template is modified, type in a filename in the text entry window 
below “Existing Template Name.” Click on Accept to complete the template 
modification or on Cancel to abort the process. 

 

Figure 7-17. Create/Modify Database dialog box: Modify Existing Template. 
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6. Create Template from Database: Use this option to create a template from an existing 
database.  A Select Existing database file dialog box first appears to select a mapset and 
database file. Click on Clear to clear the current selection, on Accept to complete the 
selection, or on Cancel to abort the selection process. The Create/Modify Database 
dialog box then appears (Fig. 7-18).   

 

 
You can add new data fields to the list (the word “Add” appears in the small cell to the 
left of the field name cell).  To modify added data fields, click once on the data field line 
to select it, then click on the appropriate box in the “Field Properties” section to make 
changes (use the backspace key to delete text or highlight the entire entry and hit 
<Delete>).  To delete existing data fields, first select the data field line; after clicking 
again, GypsES asks “Delete Current Field?”  Click on Yes to delete the field or on No to 
retain it.  Once the template is created, type in a filename in the text entry window below 
“New Template Name in [mapset name].”  Click on Accept to complete the template 
creation or on Cancel to abort the process. 
 

Figure 7-18.  Create/Modify Database dialog box: 
Create Template from Database. 
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C. Make SiteData File from Database File 
Use this option to create a SiteData file from a database file by specifying what database 
fields to use as geographic coordinates so that the file can be displayed on a map.  This may 
be useful if you didn’t already specify the coordinate fields when creating or importing a 
database file or if you need to correct improperly specified fields. A Select Database [to] 
Convert to SiteData dialog box appears; select the mapset and database file you want from 
the appropriate lists and click on Accept to select the file, on Clear to clear the selection, or 
on Cancel to terminate the selection and close the dialog box. 

 
If a database file is selected, a Site Data Fields Linkage dialog box appears to select fields 
from the database file to use as UTM Easting and Northing coordinates (Fig. 7-19).  A 
message appears at the top of the dialog box: “Select Fields from Data File: [x] in Mapset: 
[y] to use as coordinates.”  Click on the choice buttons to the right of “UTM Easting Field” 
and “UTM Northing Field” to view the list of available field names.  Choose the fields you 
want and click on Accept to complete the selection or on Cancel to abort the process. 

Figure 7-19.  Site Data Fields Linkage dialog box. 
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III. Map Features : Use this option to add or modify text, labels, and other features within a Work 
Window. 
Pull Down Menu: 
��Map Labels  (7-34) 
��Edit Categories  (7-36) 

 
A. Map Labels  

Use this option to add, move, delete or change labels on the Work Window screen. When 
you select an existing label for moving, deleting or changing, the label is first outlined by 
dashes; you are then asked if the outlined label is the correct label for that function. Click on 
OK to proceed with the label function or on No to cancel the selection. When you use the 
move and delete options, you are prompted for another label before exiting; when you use the 
change option, however, you are not prompted for another label before exiting. 
Pull Down Menu: 
�� Define New Label  (7-35) 
�� Move Label  (7-36) 
�� Delete Label  (7-36) 
�� Change Label  (7-36) 

 

 

User Tip: What are the differences between labels and the label display options for Vector 
and SiteData files? 
 
This map label option creates text that is displayed on the Work Window. It is geographically placed, 
i.e., the label's upper left corner is associated with a specific UTM Northing and Easting coordinate. Its 
size can also be tied to the geographic View by using a Resize on View Change option (see page 7-
35).  However, it is not associated with any geographic layer, and if you clear a Work Window, the 
labels drawn in it are removed. You can save labels by saving the Work Window as a composite file 
(see the File menu / Save option / Composite option described on page 6-14). 
 
Labels displayed in conjunction with Vector or SiteData files are associated with category information 
(Vector) or a database (SiteData). The information displayed is part of the layer information and can 
be altered using the edit categories options of MapEdit (Vector) or by editing the database information 
(SiteData). To display these types of labels, you must select the display label option in the Vector 
Display Options dialog box (page 8-4) or Site Display Options dialog box (page 8-6). 
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1. Define New Label: After selecting this option, a Label Definition dialog box (Fig. 7-20) 
appears to create labels for any map layer.  Options include: 

 

a. Label Text: Click once inside the text entry window to the right of “Label Text” to 
type in the new label’s text. 

 
b. Change Font: Selecting this option brings up a Label Font Selection dialog box. You 

can define a font weight (normal or bold) and size for the label text.  A “Font 
Preview” section of the dialog box previews the selected font.  Click on Accept when 
the font selection is complete. 

 
c. Resize on View Change: You can decide whether to resize the label with each View 

change (Yes or No). 
 

d. Text Color: Click on the choice button to the right of the color cell to bring up a 
menu of color options from which to choose the label text color. 

 
e. Label Background / Border: These are both Yes or No options; choose Yes to show 

a label background or border (click on the choice button to the right of the 
appropriate color cell to bring up color options for a label background, border, or 
both). 

Figure 7-20.  Label Definition dialog box. 



Section 7: The Edit Menu  GypsES User’s Manual v1.0 

GypsES:  Decision Support and Project Mgt.   7-36 

Click on Accept to close the Label Definition dialog box, then move the label to where 
you want it to go.  By default, the new label is initially located in the upper left corner of 
the screen. Place the mouse pointer in this corner and hold the left mouse button down to 
drag the label to where you want it. Only the outline of the label is visible while it is 
being dragged across the screen, and even the outline may not be visible depending on 
what background color is being used. Release the left mouse button to stop the move. 
Click on Complete if the label is located correctly, click on Continue to continue moving 
the label, or click on Cancel to cancel the new label. 

 
2. Move Label: To move a label, first select Move Label from the options list. Then click 

on the label you want to move to select it; clicking the right mouse button cancels the 
selection process. Once you have confirmed that you have selected the label you want to 
move, place the mouse pointer on the label and hold the left mouse button down to move 
the label to a new location; release the left mouse button to stop the move. Click on 
Complete if the move is complete, click on Continue to continue moving the label, or 
click on Cancel to cancel the label move. 

 
3. Delete Label: To delete a label, first select Delete Label from the options list. Then click 

on the label you want to delete to select it; clicking the right mouse button returns you to 
the Work Window without deleting any labels. Once you have confirmed that you have 
selected the label you want to delete, click on OK to delete the label. 

 
4. Change Label: To change label attributes, first select Change Label from the options 

list. Then click on the label you want to change to select it; clicking the right mouse 
button cancels the selection process. Once you have confirmed that you have selected the 
label you want to change, that label’s definition dialog box appears for editing. Once 
changes are made, click on Accept or on Cancel to cancel any label attribute changes. 

 
B. Edit Categories 

This option is used to create or edit category descriptions within a Raster or Vector layer of 
the (current) output mapset only.  After clicking on Edit Categories, you are prompted to 
select a file type (Raster or Vector) for category edits.  This brings up a dialog box titled 
Select Raster (Vector) File for Category Edit; select the current output mapset name on the 
left and filename on the right. Click on Accept to complete the selection, on Clear to clear 
the selection, or on Cancel to end the selection process. An Edit Categories -- Mapset: [x] 
File: [y] dialog box appears (Fig. 7-21). 



GypsES User’s Manual v1.0        Section 7: The Edit Menu 

 7-37 GypsES: Decision Support and Project Mgt.  

 
[Note:  A Vector file, when created, does not necessarily have categories associated with it. 
Feature lines are the only lines that can be labeled and color coded.  In order to color code 
lines, each line must be labeled. This may already be done if GypsES support personnel have 
supplied a map layer, or you can add labels using MapEdit (see Define Label on page 7-
12).] 
 
Each category is listed on a separate line; category number (far left column) lists all 
categories from the top of the dialog box to the bottom.  To edit the category description 
label in the column immediately to the right of the category number, click inside the 
description cell and edit the description text. The current category color is displayed in the 
cell to the far right on the dialog box.  There are three color bars below (R=Red, G=Green, 
and B=Blue) that contain a double-box cursor with a number on top. When a given category 
color is selected above, the cursor settings on each color bar below change to illustrate the 
unique mix of red, green, and blue that makes up the selected category color.  To edit the 
category color, first click over one of the double-box cursors and hold the left mouse button 
down; the cursor can then be moved left or right along the color bar to edit the strength of 
that color in the resulting category color.  As the color mix is edited for a category, the color 
cell on the category line above simultaneously changes. 

 

Figure 7-21. Edit Categories – Mapset: [x] File: [y] dialog box. 
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You can add new categories by clicking on New Category. Select a category number and 
type in a text description for the new category in the New Category dialog box that appears. 
Click on Accept when the dialog box is edited to return to the Edit Categories dialog box. 
[Note: The new category color is black by default; edit the category color as described 
above.] Click on Accept to accept the category edits or on Cancel to cancel the editing 
function. 

 
IV. Standard Name Linkages 

Selecting this option brings up a “Standard Name Linkage Edit” table.  The purpose of this 
option is to link (associate) a GypsES map layer file (named by you) with a Standard Name 
within this table. A Standard Name is a unique filename that is used for specific internal 
calculations by GypsES; it is a specific type and does not change. If a map layer file is linked to a 
Standard Name, GypsES uses this file to perform the specific calculations. Each time GypsES 
performs an internal calculation that requires a specific file, GypsES can “look it up” in this 
linkages table (see Appendix A for a complete list of Standard Names). By setting the links here, 

 

User Tip: Creating and Changing Colors 
 
You can make new colors or change existing ones using the red, green, and blue components of a 
color. Some key concepts include: 
��Higher color values tend to give a lighter color; conversely, lowering all color values makes a 

color darker. 
��The basic eight colors that can be mixed using the highest value of each color component include: 

Red Green Blue      Resulting Color 
 

255 255 255  white 
255   0   0  red 
255 255   0  yellow 
255   0 255  magenta 
  0 255   0  green  
  0 255 255  cyan 
  0   0  255  blue 
  0   0   0  black 

��Gray can be made in any hue from white to black by just choosing the same value for the red, 
green, and blue component. 

��The same red, green, and blue combination may look different on different monitors. 
��Colors do not always transfer well to hard copy. You may have to experiment to achieve 

acceptable colors for graphics output. 
 
Appendix B shows color component values for a range of colors. 
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GypsES does not need to prompt you for a filename each time it performs internal calculations. 
The Standard Names listed down the left side of the dialog box represent data elements used 
internally by the GypsES system; linked GypsES map layer files are listed on the right. To select 
or change a map layer file to link to a given Standard Name, click on the box on the right side of 
the dialog box under “Map Layer” and select the map layer name you want. Click on Exit when 
edits to this dialog box are completed. 

 
V. Administrative Profile  

Use this option to customize the GypsES session and define management objectives. 
Pull Down Menu: 
��User Profile  (7-39) 
��Management Objectives  (7-43) 

 
A. User Profile 

Use the User Profile dialog box to customize settings for your GypsES sessions at the global, 
location, and mapset levels.  This dialog box has four dialog boxes to toggle between by 
clicking on the appropriate tabs: Global, Location, Mapset, and Pest.   

 
1. Global: Information in the Global dialog box (Fig. 7-22) applies whenever you run 

GypsES, regardless of what location or mapset is selected.  The Global dialog box 
includes the following features: 

 
a. Initial Window Display Mode: Use this option to specify how Work Windows are 

initially displayed when GypsES is started: Tiled Screen (all four Work Windows 
appear on the screen at the same time) or Full Screen (only one Work Window is 
displayed at a time). The Work Window display mode can be changed during a 
GypsES session using the Windows menu (toggle between Tile Work Windows and 
Make Work Windows Full Screen on the top line of the pull-down menu). 

 
b. Initial Display Map: This option specifies what map is initially displayed when 

GypsES starts: Last (the last map drawn in the current location/mapset) or None (no 
map). 

 
c. Default Unit of Measure: Choose the default unit of measurement (English or 

Metric) used by GypsES when displaying areas and distances. 
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d. Screen Width and Height: Use this option to choose the size of the GypsES window 
in screen pixels. Click on the up (�) and down (�) triangles to increase or decrease, 
respectively, the window size in each dimension. The GypsES screen always retains a 
width-to-height ratio of 4:3, so if you change one value, the other will automatically 
be adjusted. GypsES will not let you change the window dimensions to values greater 
than that of your computer screen. 

 
e. Initial Drive Access Query: GypsES default behavior in accessing data on computer 

systems with multiple disk drives (floppy, hard disk, CD-ROMs, etc.) is to allow 
access to (and attempt to read) all available drives on your system.  For some lap-top 
computer systems where the floppy drives are swappable or can be plugged in (or 
not), this results in delays in starting GypsES because it takes GypsES a while to 
figure out the drive isn’t there. To address this problem, the user profile now allows 
you to set what drives to access and, if desired, have GypsES query you for what disk 
drives to access when it starts up. If Initial Drive Access Query is set to Yes, GypsES 
displays a Set Drive Access dialog box when GypsES starts up (Fig. 7-23). [Note: 
You can also click the Set Drive Access push button in the Global dialog box to bring 
up the Set Drive Access dialog box at any time.] 

Figure 7-22.  User Profile dialog box: Global dialog box. 
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The Set Drive Access dialog box lists all available drives on your computer on the left 
and Yes / No diamond toggle buttons on the right under “Access.”  Clicking the No 
diamond toggle beside a disk drive tells GypsES to ignore the drive; this drive will 
not appear as a drive choice in any file selection dialog box and there will be no 
delays in starting GypsES. You can also use this dialog box to avoid accessing or 
writing to specified drives on your computer system.  
 

f. Set Drive Access: You can set the access to drives on your computer system by 
clicking on this push button to bring up the Set Drive Access dialog box described 
under section e. above. 

 
g. GypsES Background and Text Color: Use the Click to Change push buttons to 

choose the background and text colors for GypsES menus, dialog boxes, etc.  The 
currently selected color choice is illustrated in the button itself.  When you click on 
the push buttons, a Color Selection Dialog dialog box appears with separate sliding 
bars for the red, green, and blue components of the color. By clicking on and sliding 
the color component bars back and forth, you can change the resulting color, which is 
previewed for you in a box in the upper left corner of the dialog box. Click on Accept 
to accept the new color or on Cancel to end the color selection process with no 
change. 

 

Figure 7-23.  Set Drive Access dialog box. 
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h. Set Color Selection: You can customize the 16 color choices available within 
GypsES menus by clicking on Set Color Selection; this brings up a Color Selection 
Dialog dialog box that shows 16 colors in a “Custom Palette” in the upper right 
corner. Modify any of these colors by clicking on the color you want to change and 
adjusting the mix of red, green, and blue in the color bars below. Click on the double-
square cursor and hold the mouse button down while dragging the cursor within each 
color bar to create the mix you want; the resulting color simultaneously changes in 
the preview box in the upper left corner of the dialog box. Click on Accept to save 
the customized color palette settings or on Cancel to quit with no color changes. 

 
2. Location: Enter a description of the location in the text entry window to the right of 

“Location Description.” 
 

3. Mapset: Enter a description of the Mapset in the text entry window to the right of 
“Mapset Description.” Enter the year the current mapset represents either by typing in the 
text entry window or by clicking on the up or down triangles to change the year 
incrementally. 

 
4. Pest: Use this dialog box to specify information for processing a specific pest (Fig. 7-24). 

Currently, the only choice is a Gypsy Moth Defoliation Prediction Model. [Note: Pest 
information is global in nature and will affect all locations and mapsets on your system.] 
You can specify what defoliation prediction method (Montgomery or Gansner) to use by 
clicking on the appropriate diamond toggle button. 

 

Figure 7-24.  User Profile dialog box: Pest dialog box. 



GypsES User’s Manual v1.0        Section 7: The Edit Menu 

 7-43 GypsES: Decision Support and Project Mgt.  

B. Management Objectives 
Use this option to describe and prioritize categories for managing land within the current 
location and mapset.  A dialog box titled Management Objectives: Location [x] Mapset [y] 
appears (Fig. 7-25).  Each numbered management objective can be described and may have 
one of the following treatment objectives: None, Prevent Mortality, Protect Foliage, Reduce 
Nuisance, or Minimize (Insect) Population.  These can be prioritized according to the need 
for treatment by assigning a priority number next to that objective.  Once this dialog box is 
edited, click Accept to accept the changes or on Cancel to discard any edits made. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-25.  Management Objectives: Location [x] Mapset [y] dialog box. 
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The Window Menu 
 
Use this menu option to select, view, and format map layers within GypsES Work Windows. 
Pull Down Menu: 
��Tile Work Windows  (8-1) 
��Work Window 1  (8-1) 
��Work Window 2  (8-1) 
��Work Window 3  (8-1) 
��Work Window 4  (8-1) 
��Build/Update Map  (8-2) 
��Change View  (8-11) 
��Clear Window  (8-12) 
��Redraw Window  (8-12) 
 
I. Tile Work Windows 

You can choose between two modes for displaying Work Windows each time a GypsES session 
is started. (1) The four Work Windows can be “tiled” (all four are displayed on the screen with 
the currently selected Work Window outlined in yellow), or (2) each Work Window can be 
individually displayed in a full screen.  This mode is defined in the “Window Display Mode” 
section within the Edit menu / Administrative Profile option / User Profile option.  If you have 
chosen Full Screen, for example, the initial Work Window appears in a full screen.  To tile the 
four Work Windows after starting GypsES, click on Tile Work Windows.  To toggle back to the 
full screen mode, click on Make Work Windows Full Screen (this now appears in the top line of 
the Window pulldown menu where Tile Work Windows used to be).  If you have chosen �Tiled 
Screen,� all four Work Windows appear initially in the tiled mode. 

 
II. Work Window 1 - 4 

Work Windows are areas where image backdrops, Vector, SiteData, and Raster map layers can 
be displayed, saved as Composite files, or sent to a graphics output device.  You are provided 
with four Work Windows that are numbered 1 through 4.  Work Windows can contain one or 
more layers that are available within the current location.  If you are working in the full screen 
mode, choosing a specific Work Window from this menu makes it the current window and 
displays the Work Window on the full screen.  Any layers chosen are displayed in this Window. 
If you are working in the tiled mode, the newly selected Work Window is outlined in yellow. 
Change the current Work Window right on the GypsES main screen in either mode by clicking 
the current Work Window number button at the bottom of the screen and choosing a new Work 
Window number. 
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III. Build / Update Map 
Use this option to add, modify, or remove map layers and select mapping options within the 
current Work Window through an interactive screen display.  When this option is selected, a 
Build / Update Map dialog box appears (Fig. 8-1). 

 

 

 

 

User Tip: Map Background Color 
 
Before any map layer is drawn on a Work Window, GypsES fills the window with the map 
background color. The default for the background color is black. You can change the background 
color by clicking Modify on the Map Background Color line in the �Current Map Content� list. 
 

Figure 8-1. Build / Update Map dialog box. 
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You can build a map composed of any number of existing Raster, Vector, SiteData, and 
Composite map layers within the current location. The area on the right side of the dialog box 
(under “Current Map Content”) lists all map layers actively selected for the map (including the 
default Map Background Color). To select a map layer of a given type (Raster, Vector, SiteData, 
or Composite), click on the push button for that type on the left side of the dialog box.   

 
A. Selecting a Raster Map Layer 

When you click on Raster Layer, a Raster File Choice dialog box appears. You can select 
one or more Raster map layer files from all available files by clicking on the filename. The 
filename is highlighted in black and also simultaneously appears in the “Current Map 
Content” list to the right. [Hint: To deselect the file, click the mouse button on the filename a 
second time.] Click on Done to close this dialog box. [Note: If a Raster map is already 
drawn on the screen and another Raster map is selected, the new Raster map is drawn ONLY 
in the areas of the original map which are classified as “no data.”] 

 
B. Selecting a Composite Map Layer 

The selection of a Composite map layer follows the same procedure used in selecting a 
Raster map layer. 

 
 

C. Selecting a Vector Map Layer 
When you click on Vector Layer, a Vector File Choice dialog box appears.  When a Vector 
map layer is chosen, one of two things can happen:  

 

 

User Tip: Work Window Composite Files 
 
GypsES saves the content of each Work Window as a composite file in the current output mapset. The 
Work Window files are labeled WORK_WINDOW1, WORK_WINDOW2, etc.  To copy the contents 
of one Work Window to another, just retrieve the Work Window composite file for the window. Note 
that if you have told GypsES to draw the contents of the Work Window last used each time you start 
GypsES (see User Profile options under the Edit menu / Administrative Profile option on page 7-39), 
GypsES draws these Work Window composite files. Also note that each mapset has its own set of 
composite Work Windows that are retained from the last time that mapset was the output mapset. You 
may have problems deleting a layer because GypsES says it is being used in a composite file. It may 
be that the layer is listed in a composite file for another mapset. 
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1. A Vector Display Options dialog box appears (Fig. 8-2).  You can choose the Vector line 
width, color, and style, and whether or not to display Vector line labels.   

If you want labels displayed, click on the square toggle button beside “Display Vector 
Label.”  A Vector Label Definition dialog box with two tabs (dialog boxes) appears: 

 
a. Label Font (Fig. 8-3): Use this dialog box to edit the label font style, size, and color. 

 

Figure 8-2.  Vector Display Options dialog box. 

Figure 8-3.  Vector Label Definition: Label Font dialog box. 
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b. Label Options (Fig. 8-4): Use this dialog box to choose the label type (polygon or 
feature) and content (category number or description).   

 

Click on Accept to accept the display options in either the label font or options dialog 
box. If you want to change the vector label options once they’re defined, click on Modify 
Vector Label  to the right of “Display Vector Label” in the Vector Display Options dialog 
box. Then click on Accept to complete the edits or on Cancel to not make any changes.  
 
 

2. If the Vector file chosen already has color-coded categories (i.e., its lines can be 
displayed in different colors that are already defined), GypsES displays a dialog box that 
states, “This Vector file has cataloged color assignment [...] Do you wish to modify?” If 
yes, click on Modify Colors to bring up the Edit Categories dialog box described starting 
on page 7-36 to change the color assignment.  The line width and style (solid or dashed) 
can still be changed using the Vector Display Options dialog box described on page 8-4. 
Click on Just Display to display the chosen Vector file as is. 

Click on Done to close the Vector File Choice dialog box and complete the selection of a 
Vector map layer. 

 
D. Selecting a SiteData Map Layer 

When you click on SiteData Layer, a SiteData File Choice dialog box appears. Once a 
SiteData file is chosen, a Site Display Options dialog box (Fig. 8-5) is brought up with the 
following options: 

Figure 8-4.  Vector Label Definition: Label Options dialog box. 
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1. Database: The “Database” section in the upper left corner of the dialog box lists all 
database fields within the file. Choose the field you want by clicking on the choice button 
to the right of “Database Field” (the current database field being used is shown in the 
dialog box). This field contains the data used to determine the shape, color, and size of 
the site symbol for that SiteData point. 

 
2. Labels: The “Labels” section in the upper right corner of the dialog box provides the 

option of displaying labels next to each site symbol.  Click on Display Site Label (the 
square toggle button to the left appears indented) and the Label Options push button to 
the right becomes active. Clicking on Label Options brings up a Site Label Options 
dialog box that has three tabs: Font, Label Source, and Orientation.  [Note: Once these 
three dialog boxes are edited, click on Accept or Cancel to return to the Site Display 
Options dialog box.] 
a. Font: Use this dialog box to choose the site label font style (bold or normal), size, 

and color.  
 

b. Label Source: Use this dialog box to specify the database field that contains the 
numbers you want displayed next to the site in a label. Click once on the choice 
button to the right of “Database Field,” then select a field from the list of all available 
database fields.  [Note: The database field chosen may be different from that used to 

Figure 8-5.  Site Display Options dialog box. 
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determine the site symbol.] 
 

c. Orientation: Use this dialog box to specify where the site label is printed (its 
orientation) with respect to the site symbol on the map.  Select a site label orientation 
by clicking on one of the eight buttons arranged in a square on the left side of the 
dialog box.  You can also specify how far the site label is offset from the site symbol 
by selecting a distance (in pixels) just to the right of “Site Symbol Offset.” 

 
The middle of the Site Display Options dialog box contains two sections: the area on the 
left lists all unique site symbols and their attributes, and the area on the right below 
“Variable Display Definition” is where you define the parameters for the site symbols 
listed.   

3. SiteData Symbols: Each site symbol is listed on its own line.  To change the site symbol 
size or style (illustrated below “Symbol”), click on the numbers in the line just below the 
“Size” and “Symbol” headers.  Clicking in either place brings up the same dialog box 
(Site Symbol Selection, Fig. 8-6): choose the symbol style (click on the symbol 
illustration you want), color (click on the choice button to the right of the color bar and 
select a color), and size (in pixels, feet, or meters).  Click on Accept to accept the edits or 
Cancel to remove the Site Symbol Selection dialog box with no changes. 

 

User Tip: Fixed and Variable Site Display 
 
Display of site data may be “fixed,” i.e., a single symbol shape, color, and size is used to indicate the 
location of each record in the SiteData file on the map. This is the default mode when a SiteData file is 
displayed for the first time.  If you want the color, shape, or size of the symbols to vary based on the 
content of the database, you must first select the database field you want. Clicking on Insert then 
changes site display to the variable mode. Note that any database records that do not meet the criteria 
in the variable site data specifications are displayed in the original shape, color, and size specified in 
the “fixed” mode. To make changes to the “fixed” (default) display of SiteData files, choose Default 
under the “Variable Display Definition” section / Define Range option of the Site Display Options 
dialog box (described on page 8-9). 
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Each unique site symbol represents a range of the data in the database field being used. 
The first three columns of each site symbol line (“Form,” “Minimum,” and “Maximum”) 
refer to relational parameters that define what data are represented by that site symbol. 
For example, a site symbol may be defined as a solid red triangle that represents all 
pheromone trapping sites that have greater than 50 male moths per trap.  The site symbol 
line (reading from left to right) would have a greater than (>) symbol under “Form,” no 
value under “Minimum,” a value of 50 under “Maximum,” and a solid red triangle 
indicated. 

 
Site symbol lines are selected by clicking on the line.  Site symbol lines can be added or 
subtracted by clicking on Insert and Delete, respectively. 

 
4. Variable Display Definition: This section is used to edit the parameters of either a newly 

inserted or existing site symbol.  “Define Range” lists the relational parameters you can 
use to define a site symbol (click once on the choice box to the right of “Define Range” 
to produce a list). [Note: Other boxes below “Define Range” are activated depending on 
which parameter is selected.] Relational parameters include: 

Figure 8-6.  Site Symbol Selection dialog box. 
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a. # to # :  This specifies a range of values between two numbers (i.e., from 10 to 20); if 
this is chosen, the “Minimum” and “Maximum” boxes below are activated for 
entering the two numbers that define the range. 

 
b. >= :  This means greater than or equal to; if this is chosen, the box immediately 

below changes to “Grter-Equal” for entering the appropriate value. 
 

c. <= :  This means less than or equal to; if this is chosen, the box immediately below 
changes to “Less-Equal” for entering the appropriate value. 

 
d. > :  This means greater than; if this is chosen, the box immediately below changes to 

“Greater” for entering the appropriate value. 
 

e. < :  This means less than; if this is chosen, the box immediately below changes to 
“Less” for entering the appropriate value. 

 
f. = :  This means equal; if this is chosen, the box immediately below changes to 

“Equal” for entering the appropriate value. 
 

g. Chr.eq.: This means character equal; if this is chosen, the “String” box at the bottom 
becomes activated for you to type in the appropriate character string. 

 
h. Chr.ne: This means character not equal; if this is chosen, the “String” box at the 

bottom becomes activated for you to type in the appropriate character string. 
 

i. Default: Use this option to set a default [site symbol] shape, color, and size for any 
data value that is not covered by other definitions. 

 
Clicking on a site symbol line’s “Minimum” or “Maximum” value changes the “Variable 
Display Definition” boxes to the current setting of the site symbol parameters. After 
making any additions, deletions, and edits to this box, click on Accept to accept the 
option edits or click on Cancel to cancel the option edits. You are now back to the 
SiteData File Choice dialog box and can click on Done to complete the selection of a 
SiteData map layer.  
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E. Map Scale 
You can add a map scale by clicking on Scale in the upper left corner and selecting a color 
for display. The unit of measurement used for the scale (English or metric) is the same as 
what you specified in the Edit menu / Administrative Profile option / User Profile option / 
Default Unit of Measure option described on page 7-39. 

 
F. Map Grid 

You can overlay a grid of lines on the working map by clicking on Grid. Grid options 
include grid line color (click on the choice box to the right of the color bar for color choices), 
placement (either the edge of the map or as specified by UTM Northing and Easting 
coordinates), and grid size (in meters).   

 
G. Image Backdrop 

Click on Image Backdrop to add a 7.5-minute quadrangle topographic map or other image 
backdrop in the background of the GypsES Work Window.  A Select Image Type dialog box 
appears (Fig. 8-7); select the backdrop you want and click on Done to exit this dialog box. 

 

Figure 8-7.  Select Image Type dialog box within the 
Build / Update Map dialog box. 
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Once all map layers and components are selected, click on Accept to re-draw the GypsES 
screen with the updated map, click on Reset to cancel the current edits, or click on Cancel to 
cancel the Draw / Update Map function. 

 
IV. Change View  

Pull Down Menu: 
��Set Mask  (8-11) 
��Full View  (8-11) 
��Zoom In  (8-11) 
��Zoom Out  (8-12) 
��Recall View  (8-12) 
��Change Resolution  (8-12) 

 
A. Set Mask 

A special kind of data layer, called a Mask, can be used as a “cookie cutter” to display only a 
selected portion of a location while “hiding” the rest of the map layer.  This function applies 
only to Raster layers.  When you have a Mask activated, not only is the selected portion of 
the map the only portion displayed, it is also the only portion used to perform calculations. 
This can be useful if, for example, you select a forest cover Mask in combination with a 
rasterized spray block layer; you can then generate a raster area report of acreage that is both 
forested and sprayed.    

 
Once you click on Set Mask, a Select Raster file for Mask dialog box appears.  Click on a 
Raster file to use as a Mask; its filename is highlighted as well as appears under the 
“SELECTED” heading below.  To remove a selected Mask, click on Clear and the filename 
is removed from the selection list.  Click on Accept to accept the Mask file selection or 
Cancel to cancel the selection process. 

 
B. Full View 

This option displays the map layer using the default View for the current location. 
 

C. Zoom In 
Use this option to focus in on a particular section of the current View. Click once to establish 
a corner, release the mouse button, then stretch the box in any direction by moving the mouse 
pointer to the opposite corner to define the rectangle that represents the new View. When you 
click a second time, GypsES prompts you to accept or cancel the new View. If the new View 
is accepted, the current map is redrawn showing the area selected. 
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D. Zoom Out 
Use this option to “zoom out” to view a larger area of the current map layer. You see a blank 
screen representing the default View with a colored rectangle representing the current View. 
Click the first corner of the new View rectangle, then release the mouse button and drag the 
mouse pointer to the opposite corner of the new View. Click a second time; if this is the new 
geographic View you want, click on Yes. [Note: When zooming either in or out, GypsES 
prompts for confirmation that you want to change the View.  In addition, GypsES asks you if 
the other three Work Windows should be changed with respect to the View. This feature gives 
you the same exact view in all four Work Windows.] 

 
E. Recall View 

Use this option to select a View that has previously been saved. Clicking on this option 
brings up a Select View dialog box to select a saved View file. Click on the View file you 
want, then click on Accept for GypsES to draw this View on the screen. 

 
F. Change Resolution 

There are two types of resolution: Raster File Resolution and Viewing (Screen) Resolution. 
Raster File Resolution refers to the resolution of the Raster map layer as it is created (the 
dimension of each cell that represents a square on the Earth’s surface) and is expressed in 
meters; it can never be smaller than what it was at the time of creation.  Viewing (Screen) 
Resolution refers to the resolution of the map layer that is displayed on the screen and is also 
expressed in meters. It can be larger or smaller than the Raster File Resolution. Click on 
Change Resolution to specify the Viewing (Screen) Resolution value in meters. This comes 
into play when you convert a Vector map layer into a Raster map layer. When a new Raster 
layer is created by calculations in the GypsES system, the resolution of the resulting new 
layer is the same as the viewing resolution of the current layer. If the resolution is relatively 
large, newly created Raster layers look “boxy.” If the resolution is very small, the look of the 
Raster layer is “smoother,” but it also takes longer to create and draw a new layer since a 
larger number of cells must be processed in calculations. 

 
V. Clear Window 

This function works in either the full-screen or tiled Work Windows mode. Selecting this option 
clears all map layers from the Work Window. 

 
VI. Redraw Window 

This function redraws the GypsES screen. 
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The Forest Menu 
 
This menu helps you predict damage following gypsy moth defoliation and calculate a hazard rating 
for forest stands in the path of gypsy moth. 
Pull Down Menu: 
��Hazard (9-1) 
 
I. Hazard  

Use the Hazard option to define and calculate variables that GypsES uses to create a series of 
Raster map layers; a Hazard Rating layer for the location is then calculated using these variable 
layers.  Variables used to calculate Hazard include tree species composition, forest vigor and 
health, and past forest disturbance history.  These and other variables are used with user-defined 
management objectives to help identify where forest conditions occur that are conducive to 
extensive gypsy moth damage (and therefore may potentially require treatment).  The Hazard 
Rating layer GypsES creates is used within the Survey/Suppression and Treatment menu 
options.  To assure the most accurate Hazard Rating layer, all data values that you have should be 
assigned to the appropriate input layers for variable calculation; the more “real world” data you 
have, the more accurate the resulting Hazard Rating layer is.  Hazard Rating layer variables 
include: 

 
��Species Susceptibility (9-2) 
��Stand Age (9-3) 
��Susceptibility (9-3) 
��Defoliation (9-4) 
��Drought (9-5) 
��Silviculture (9-5) 
��Other Disturbance (9-6) 
��Disturbance History (9-6) 
��Site Factors (9-7) 
��Stocking (9-7) 
��Stand Condition (9-8) 
��Vulnerability (9-8) 
��Management Objectives (9-9) 
��Hazard Rating (9-9) 
��Risk (9-10) 

 
 

Up to three functions are listed by clicking on the (>) to the right of each menu option; what 
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functions are listed changes depending on the nature of the map layer (i.e., whether it has been 
previously linked to a data file or previously calculated). These functions include View, 
(Change) Link, and (Re-)Calc. 

 
��View: Use this option to view (look at) the map layer of interest. If a map layer is already 

drawn in the current GypsES Work Window, GypsES alerts you that this is the case; click on 
Replace to replace the current map or click on Cancel to retain the current map in the Work 
Window. 

 
��(Change) Link:  Use this option to set, change, or view a link between a data file and the 

map layer of interest.  Selecting (Change) Link produces a dialog box (Set Link for [map 
layer name]). What menu options appear at this point depends on whether a data file is 
already linked to the map layer.   If a data file is already linked to the map, Change Link 
appears as a menu option and the file type and file selected for linking are displayed on the 
linking dialog box.  You can change the linked data file by clicking on the box that has the 
filename on it to reach a listing of other data files available within GypsES for linking to that 
map layer.  Click on Accept to set the link and click on Cancel to end the linking function. If 
a data file is not linked, the submenu reads Link only; the same linking dialog box described 
earlier in this paragraph can be used to establish a link. 

 
��(Re-)Calc:  There are two types of layers within the Hazard function: (1) input layers (those 

layers that are supplied by you and can’t be calculated), and (2) calculated layers (those 
layers that GypsES calculates using rule-based logic when combining input layers). Selecting 
the Calc option calculates a given map layer within Hazard; if that layer has never been 
calculated for that location, only Calc appears in the submenu.  If a given layer has been 
calculated before, then Re-Calc appears to allow you to re-calculate the map layer; this 
would be chosen if the map layers that made up the calculated layer contained new or 
different data. 

  
A. Species Susceptibility  

The Species Susceptibility layer is the layer that depicts forest cover types (unique 
combinations of tree species).  Some tree species are more susceptible (likely to be 
defoliated) than others; this map layer reflects feeding preferences by the gypsy moth based 
on what tree species are present in the forest.  To use species susceptibility, you must create a 
forest cover type map.  This can be done from previously identified and mapped forest types. 

 
B. Stand Age  

Stand Age is defined as the year a stand was established.  GypsES expects each stand to have 
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an establishment year.  An algorithm (set of rules) within the system uses the establishment 
years to create the following Stand Age categories: 

 
��No Data 
��Less Than 5 Years 
��5 to 20 Years 
��21 to 40 Years 
��Greater Than 40 Years 
 
Younger stands are believed to be the least susceptible to gypsy moth defoliation. This could 
be due to inadequate structural features for gypsy moth shelter.  Stands above the age of 40 
are susceptible to gypsy moth defoliation but it is not yet known at what point between the 
ages of 20 and 40 years a forest stand makes the transition from resistant to susceptible 
(Gottschalk 1988). 
 

C. Susceptibility 
The Susceptibility layer depicts the likelihood that a stand will be defoliated (Gottschalk 
1986).  It is derived from both the Species Susceptibility and Stand Age layers.  Figure 9-1 
illustrates a sample susceptibility map layer.  Susceptibility layer categories include: 

 
��No Data 
��Very Low 
��Low 
��Moderate 
��High 
��Very High 
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D. Defoliation �    Year 0 (yyyy) 
       Year 1 (yyyy) 
       Year 2 (yyyy) 
       Year 3 (yyyy) 
       Year 4 (yyyy) 
 

Use this option to work with defoliation layers for the past 5 years. The vulnerability (the 
likelihood that mortality will occur given that defoliation has occurred) of a stand varies with 
the defoliation history of the stand. Defoliation of greater intensity or frequency results in 
higher vulnerability of the trees (Gottschalk 1986) as well as higher mortality of dominant 
and co-dominant trees. Defoliation stress can cause decline and dieback in an otherwise 
healthy tree (Houston 1981). After defoliation, there may be complete or partial recovery. 
Repeated defoliation (2 to 3 years in succession) causes increasing degrees of stress. 

 
 
 
 

Figure 9-1.  Sample Susceptibility map layer. 



GypsES User’s Manual v1.0     Section 9: The Forest Menu 

 9-5 GypsES: Decision Support and Project Mgt.  

A stand's vulnerability can be decreased if defoliation events subside.  In terms of growth, it 
takes about three (3) years for a stand to recover from a single year of defoliation (Twery 
1991).  Trees can recover from defoliation if other stress-related incidents are minimal and 
the trees are not subjected to secondary organisms (Houston 1981). 

 
Insect defoliation alone may not be enough to kill a tree, but it predisposes trees to secondary 
organisms that can be fatal.  Among others, Armillaria (shoestring root rot) and the two-lined 
chestnut borer (Agrilus bilineatus) are associated with weakened trees caused by gypsy moth 
defoliation.  Although either of these organisms can exist within the tree prior to defoliation, 
their survival and growth is enhanced by the chemical and physical changes that occur after 
defoliation (Wargo 1981). 

 
E. Drought       Year 0 (yyyy) 

      Year 1 (yyyy) 
      Year 2 (yyyy) 

 
Drought layers depict annual precipitation by stand. Drought layer categories include: 

 
��No Data 
��None 
��Moderate 
��Severe 

 
Drought increases vulnerability by increasing the degree of tree stress (Gottschalk 1986). 
Severe drought by itself can cause or contribute to tree mortality (Tryon and True 1958). 
Drought and other adverse environmental conditions predispose trees to attack by secondary 
organisms (Hursh and Haasis 1931). 

 
F. Silviculture 

The Silviculture layer represents any forestry activity that modifies existing forest conditions 
(thinnings, clear cuts, spraying, etc.).  Each stand should be categorized by the year of its 
most recent silvicultural treatment event.  GypsES then processes the stands and produces the 
following categories: 

 
��No Data 
��Treatment Within the Past Five (5) Years 
��No Treatment Within the Past Five (5) Years 
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Silvicultural treatments, such as thinning and salvage operations, can increase vulnerability. 
Broken limbs, soil compaction, and bark destruction to residual trees caused by logging or 
other treatments can be a source of tree stress (Gottschalk 1986).  Although silvicultural 
treatments increase stress, they may be important in controlling gypsy moth populations. 
Herrick (1982) summarized two objectives of silvicultural treatment: 

 
��To modify the behavior and survival of gypsy moth larvae while increasing the 

effectiveness of their natural enemies. 
 

��To create forest stands that are less vulnerable to mortality after defoliation. 
 

G. Other Disturbance      Year 0 (yyyy)  
        Year 1 (yyyy)  
        Year 2 (yyyy)  
        Year 3 (yyyy)  
         Year 4 (yyyy)  
 

The Other Disturbance layers contain information about the occurrence of such events as ice 
storms, windstorms, and floods that may result in increased tree stress. There are separate 
layers for the past five (5) years.  Other Disturbance categories include: 

 
��No Data 
��Undisturbed 
��Disturbed 

 
Other disturbances, such as ice and windstorms and flooding, cause increased stress and thus 
increased vulnerability to attack by secondary organisms (Manion 1981).  Any such stress 
can cause dieback of trees, depletion of root starch, and production of small, off-colored 
leaves (Houston 1981). Because succession tends to create less susceptible stands, 
disturbances may set back succession, creating more susceptible stands (Gottschalk 1986). 

 
H. Disturbance History 

The Disturbance History layer represents all events that could have caused a change in stand 
vulnerability (i.e., defoliation, drought, silviculture, flooding, ice storms and windstorms, 
etc.).  Disturbance History categories include: 

 
��No Data 
��Low 
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��Moderate 
��High 
��Very High 

 
The Disturbance History layer is calculated by GypsES using the past three (3) years of 
Drought History, the past five (5) years of Silvicultural activity, the past five (5) years of 
Defoliation History, and the past five (5) years of Other Disturbances.  Defoliation History is 
the most important element of the Disturbance History calculation.  The Disturbance History 
layer helps to determine the amount of pre-existing stress within a stand. 

 
I. Site Factors 

The Site Factors layer depicts soil types by drainage class.  Site Factors categories include: 
 

��No Data 
��Dry 
��Good 
��Wet 

 
Site factors affect vulnerability by influencing the amount of stress.  Dry ridges or sandy sites 
tend to produce susceptible forests of slow growing, scrubby oaks that, due to less than 
optimal conditions, contain a greater degree of structural features for gypsy moth life stages 
(Houston 1981, Montgomery 1991).  In contrast, mesic sites tend to be relatively undisturbed 
areas that produce resistant stands with few structural features.  The percentage of defoliation 
on ridge tops is 17 times greater than on mesic sites (Jones 1991).  Although this seems to 
indicate that vulnerability would increase on adverse sites, studies reveal otherwise. 
Although susceptibility is higher on dry ridges, vulnerability tends to be higher in wet stands 
and on mesic slopes.  This may be an indication of hardy survivors of extreme conditions on 
poor sites (Houston 1981). 

 
J. Stocking 

The Stocking layer represents basal area and number of trees per acre.  Stocking layer 
categories include: 

 
��No Data 
��Good (Less than 80 Percent Stocked) 
��Fair (81 to 99 Percent Stocked) 
��Poor (Greater than 99 Percent Stocked) 
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Pre-existing stand conditions are directly related to stand vulnerability.  The purpose of the 
stocking map (which indicates a measure of stand density) is to determine the level of stress 
contributed by the condition of the stand prior to defoliation.  If stocking is high (= Poor) and 
therefore the trees are more stressed because they have less growing space and other 
resources for growth and survival, stand vulnerability will be higher. 

 
K. Stand Condition 

Stand condition refers to tree crown condition (vigor).  If this layer is not available, GypsES 
assumes good crown condition. 

 
L. Vulnerability 

 
The Vulnerability layer represents the probable degree of mortality given that defoliation has 
occurred (Gottschalk 1986, Mason and Gottschalk 1986).  Figure 9-2 illustrates a sample 
Vulnerability map layer. 

Figure 9-2.  Sample Vulnerability map layer. 
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Vulnerability layer categories include: 
 

��No Data 
��Very Low 
��Low 
��Moderate 
��High 
��Very High 

 
The Vulnerability layer is derived from the Susceptibility, Disturbance History, Site Factors, 
Stand Condition, and Stocking layers.  The level of stress that a tree is subjected to is directly 
related to its level of vulnerability. Vulnerability can be affected by a number of variables, 
including drought, silvicultural activities and other disturbances, defoliation history, 
stocking, site factors, and susceptibility. Attack by secondary organisms (i.e., two-lined 
chestnut borer or Armillaria) may also increase vulnerability. 
 

M. Management Objectives 
The Management Objectives layer represents the purposes for which an area is being 
managed.  The categories in this map layer are defined by the resource manager using the 
land use codes and treatment objectives defined in the Management Objectives dialog box 
(see the Edit menu / Administrative Profile option / Management Objectives option 
described on page 7-43). Management objectives are weighted by priority in terms of 
treatment. Certain areas, such as residential or recreational areas, may have a greater need for 
treatment while other areas may be perceived as having less of a need. 

 
N. Hazard Rating 

The Hazard Rating layer identifies gypsy moth hazards that exist when forest conditions 
prevail that are conducive to extensive damage from gypsy moth (Hicks 1991). The Hazard 
layer is calculated from the combination of the Management Objectives and Vulnerability 
layers. Hazard Rating layer categories include: 

 
��No Data 
��Very Low 
��Low 
��Moderate 
��High 
��Very High 
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The Hazard Rating system is designed to predict where gypsy moth infestations are likely to 
occur and the degree of potential damage.  Hazard rating is based on the suitability of forest 
conditions as habitat for gypsy moth and is related to tree health and the purposes for which 
the trees are being managed. 

 
O. Risk 

Combining the Hazard Rating layer with gypsy moth defoliation prediction derives the Risk 
layer; in essence, Risk adds a time factor for damage to a forest stand.  If defoliation is 
imminent, then the Risk to a given area identified as high in the Hazard Rating layer is 
subsequently high.  Risk layer categories include: 

 
��No Data 
��Very Low 
��Low 
��Moderate 
��High 
��Very High 

 
When a map layer is drawn that has been created by combining one or more other layers 
(antecedents) using the Hazard option, an Antecedents push button appears on the bottom of the 
GypsES main screen just to the right of the geographic coordinate display.  If you click on this 
box, GypsES prompts you to click on the map layer for antecedent information at that point and 
to click the right mouse button to quit the Antecedents function.  Clicking on any part of the map 
layer brings up a dialog box (Antecedent Display) (Fig. 9-3) that breaks out all map layer values 
associated with the clicked point.  For example, while looking at a Vulnerability layer, clicking 
on a point brings up a list of point values and color coded boxes related to each of the four map 
layers that comprise the Vulnerability layer: Disturbance History, Susceptibility, Stand 
Conditions, and Site Factors.  Click on Show Another Antecedent to choose another set of 
antecedent values to view or click on Quit to end the antecedent display. 
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Figure 9-3.  Sample Antecedents dialog box. 
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The Survey Menu 
 
This menu aids you in the planning and data management of egg mass surveys (Suppression), 
pheromone trapping (Eradication). 
Pull Down Menu: 
��Suppression (10-1) 
��Eradication (10-3) 
 
I. Suppression 

This option is designed for use in areas of high gypsy moth populations where defoliation 
prevention is a significant management objective.  You can record and/or edit egg mass survey 
data and predict defoliation from that data. 
Pull Down Menu: 
��Egg Mass Survey Sites (This Year) (10-1) 
��Defoliation Prediction (10-2) 

 
A. Egg Mass Survey Sites (This Year)  

Use this option to view and/or edit egg mass survey data.   
Pull Down Menu (variable): 
If a datafile is linked:   Change Link  (10-1) 

 MapEdit  (10-1) 
 Database Edit  (10-1) 
 View  (10-1) 

If no datafile is linked:  Link  (10-2) 
 

1. Change Link: Use this option to change the linked file. 
 
2. MapEdit: If a datafile is linked to the Standard Name EM_SVSITES_YR0, GypsES 

automatically brings up the linked file within MapEdit if this option is chosen. 
 
3. Database Edit: If a datafile is linked to the Standard Name EM_SVSITES_YR0, GypsES 

automatically brings up the linked file within Database Edit if this option is chosen. 
 
4. View: The View option displays the linked file on the screen. 
 
5. Link: If no file is linked, you are prompted to choose a datafile for linking.  A Choose 

Egg Mass Data File dialog box appears.  Select the appropriate mapset on the left side of 
the dialog box under “Select Mapset” and select a file from the list on the right under 
“Select File.”  Click on Accept to close the dialog box, on Clear to clear the selection, or 
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on Cancel to end the egg mass data file selection process. 
 
If the data is not in a file yet, first enter the data using the Edit menu / Database option / 
Create New or Modify Existing Data File option of GypsES. Then link this datafile to the 
Standard Name EM_SVSITES_YR0 (see the Edit menu / Standard Name Linkages option 
description on page 7-38 for more information). Then edit the data in the Survey menu. If the 
database file selected contains no data, GypsES asks you if you want to add a data record. 
Clicking on Ok moves you into the database-editing environment (the DataBase dialog box 
appears). See the Edit menu / Database option / Edit/View Data File option description on 
page 7-24 for information on how to work within the DataBase dialog box. 

 
B. Defoliation Prediction  

Pull Down Menu: 
�� Egg Mass Surface (10-2) 
�� Defoliation Prediction (10-3) 

1. Egg Mass Surface 
Pull Down Menu: 
��Re-Calc  (10-3) 
��View  (10-3) 

 
This option produces a Raster layer of egg mass values from SiteData map layer points. 
a. Re-Calc:  This option re-calculates the Raster layer when egg mass values are 

changed (i.e., the linked database file changes).  When you choose Re-Calc, you are 
prompted to select the database field that represents egg mass counts per acre in the 
SiteData file currently linked as the Egg Mass Survey Sites (This Year). 

 

 

User Tip:  “What is a surface?” 
 
In many cases, pest management involves sampling (pheromone traps, egg mass counts, etc.). Where a 
systematic sampling layout has been used over an area, this information can be used to make 
assumptions about the entire area.  The conversion of point data (site data) to a Raster layer is called 
surface generation, and the Raster layer is called a surface.  The raster cells that coincide with the 
sample points are assigned the values of the actual samples.  The values of those raster cells that fall 
between sample points are estimated using a least squares interpolation method using all sample points 
surrounding them.  Once a Raster surface layer has been generated, it can be used in conjunction with 
models (such as Defoliation Prediction) or rule bases (such as Risk). 
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b. View:  This option displays the egg mass Raster surface layer in the Work Window. 
 

2. Defoliation Prediction: This option produces a map layer of predicted defoliation based 
on egg mass counts using models developed by USDA Forest Service researchers David 
Gansner and Michael Montgomery. (See the Edit menu / Administrative Profile option / 
User Profile option / Pest dialog box description on page 7-42 for information about 
selecting a defoliation prediction model). 
Pull Down Menu: 
��Re-Calc  (10-3) 
��View  (10-3) 

 
a. Re-Calc:  This option re-calculates the defoliation prediction map layer with new egg 

mass survey data. 
 

b. View:  This option displays the defoliation prediction map layer in the current Work 
Window.  [Note: You must have generated the egg mass surface layer.] 

 
II. Eradication 

This option is designed for use in areas outside of the gypsy moth generally infested area where 
management goals include detection using pheromone traps and eradication. 
Pull Down Menu: 
��Create Trap Placement (10-3) 
��Edit Trap Placement  (10-5) 
��Edit Trap Database  (10-13) 
��Last Year’s (-1) Trap Data (10-21) 

 
A. Create Trap Placement 

Use this option to create an eradication database (pheromone trapping) file for the current 
output mapset. This is a fixed database within GypsES with a Standard Name of 
TRAP_SITE_DATA. This file can not be edited within either the Edit menu / MapEdit 
option or the Edit menu / Database option; it can only be altered within the Survey menu / 
Eradication option / Edit Trap Placement option or Trap Database Display/Update option. 
 
Pull Down Menu: 
�� Generate From Imported Database  (10-4) 
�� Define Using Placement Edit  (10-5) 

 
1. Generate From Imported Database: Use this option to create an eradication database 

file from an imported database (*.dbf) file by linking the imported file fields to those in a 
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standard eradication database file. At a minimum, the trap ID, UTM Easting, and UTM 
Northing fields must be available in the imported database file. In addition, the following 
information can be extracted from the imported database: the date the trap was set or a 
count was taken, the initials of the person setting the trap or taking the count, or the trap 
moth count. You can also assign default values to data fields for dates and trappers’ 
initials by clicking on the appropriate text entry window and typing. To assign a default 
value for the trap type data field, click on the choice button to the right of “Trap Type” 
and choose either Delta or Milk Carton. 

 
Choosing this option brings up an Import Trap Data From Database dialog box (Fig. 10-
1).  The imported data file must first be selected by clicking on the box to the right of 
“Data File for Import.”  A new dialog box (Choose Database file for Trap Import) 
appears; select the appropriate mapset on the left under “Select Mapset” and filename on 
the right under “Select File.”  Click on Accept to finalize the selection, on Clear to clear 
the selection, or on Cancel to end the file selection process. 
Once a file is selected, you need to link imported database fields to the new eradication 
file fields, generally listed on the left side of the dialog box. Click on the choice button to 
the right of the box beside each field to produce a list of all available fields within the 
imported database file. Click on the field you want to link it to the new file field. Click 
on Accept once the data field links are complete or on Cancel to cancel this function. 

 

Figure 10-1.  Import Trap Data From Database dialog box. 
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2. Define Using Placement Edit: If you choose this option, GypsES first checks to see if an 
eradication database file has already been established (the Standard Name is 
TRAP_SITE_DATA).  If one exists, GypsES then asks if the new information should be 
merged or if a new file should replace the current file.  If no eradication database file has 
been established, GypsES prompts you for a filename, then displays the message 
�TRAP_SITE_DATA linked to [filename]; Invoking Trap SiteData Edit with an empty 
trap file.  This option invokes the “Trap Placement Edit” palette of functions. 

 
B. Edit Trap Placement 

Use this option to either replace or overlay the currently displayed map with Eradication site 
data as well as add, delete, or change trap locations.  A �Trap Placement� palette of options 
appears on the left side of the screen (Fig. 10-2) and includes: 

 
�� Set Options  (10-6) 
�� Exit Trap Placement  (10-7) 
�� Select Single Trap  (10-8) 

Figure 10-2.  Trap Placement palette of functions. 
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�� Select Multiple Traps  (10-8) 
�� Clear Selected  (10-8) 
�� Move Selected Traps  (10-8) 
�� Add Single Trap  (10-8) 
�� Add Delimiting Grid Area  (10-8) 
�� Add Traps in Polygon  (10-11) 
�� Label Selected Traps  (10-12) 
�� Delete Selected Traps  (10-12) 
�� Un-do Last Delete  (10-12) 
�� Save Selected Traps  (10-13) 
�� Save All Traps  (10-13) 
�� Show History for Area  (10-13) 
�� Switch to Database Palette  (10-13) 

 
[Note: A line indicating the total number of traps and the number of traps currently selected 
is located below the “Trap Placement” heading at the top of the functions palette.] 

 
1. Set Options: Selecting this option brings up an Eradication Edit Options dialog box (Fig. 

10-3) with the following options:  [Note: Once these options are defined, click on Accept 
to close the dialog box.] 

 
a. Highlighted and Selected Traps: Use this option to modify the display properties 

applied to highlighted and selected traps. Click on the box to the right labeled Modify 
Display to bring up the Site Display Options dialog box. (See the Selecting a 
SiteData Map Layer option under the Window menu / Build /Update Map option 
described on page 8-6 for more information about this dialog box). 

 
b. Trap Locations: Use this option to modify the display properties applied to the entire 

eradication site data display (all trap locations). Click on the box to the right labeled 
Modify Display to bring up the Site Display Options dialog box. (See the Selecting a 
SiteData Map Layer option under the Window menu / Build /Update Map option 
described on page 8-6 for more information about this dialog box). 
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c. Trap Choice Method: There are two methods available to either select or add 
individual trap locations one location at a time: using a mouse click (By Mouse 
Click) or using the keyboard (Enter Via Keyboard). If the mouse click method is 
chosen, click on the trap location you want to select it; if the keyboard method is 
chosen, a text entry window appears for you to enter a trap ID. These two trap 
selection methods can also be used to select trap sites for viewing or editing database 
values (see the Trap Database Display /Update function within the “Trap Database 
Palette” described on page 10-19). 

 
d. Multiple Trap Selection Method: There are two methods available to select multiple 

trap locations: by defining either a rectangle (Define Rectangle) or a polygon (Draw 
Polygon) around the traps of interest.  (See Select Multiple Traps on the following 
page for an explanation of both options.) 

 
2. Exit Trap Placement: This option closes the “Trap Placement” palette and returns you to 

the GypsES main screen Work Window.  Upon exit, you are asked whether you want to 
save any changes made.  If you respond Yes, then GypsES lists the current eradication 
database filename, if it exists.  Choose either Save to use the same filename or click on 
New Name to specify a new eradication database filename. 

 
3. Select Single Trap: You are prompted to use a left mouse click (or to type in a trap ID if 

using the keyboard selection option) to select traps one trap location at a time.  A right 

Figure 10-3.  Eradication Edit Options dialog box. 
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mouse click (or <ENTER> when no trap ID is entered) ends the selection process; all 
trap locations selected up to that point are highlighted as specified in the Eradication Edit 
Options dialog box.   

 
4. Select Multiple Traps: There are two modes to select multiple trap locations: by defining 

a rectangle or drawing a polygon around the traps of interest.  If traps are being selected 
using a rectangle (Define Rectangle), GypsES prompts you for a click of the left mouse 
button to establish a corner, then prompts you to move the mouse to the opposite corner 
of the rectangle.  Another left mouse click defines the rectangle and selects all traps that 
fall within it.  If traps are being selected using a polygon (Draw Polygon), GypsES 
prompts you for left mouse button clicks to define nodes of a polygon.  A right mouse 
click after three or more left mouse clicks closes the drawn polygon and highlights all 
trap locations that fall within it. 

 
5. Clear Selected: This option de-selects all traps currently selected. 

 
6. Move Selected Traps: To move all selected traps, GypsES first prompts you to click and 

hold the left mouse button down while dragging the mouse; this moves the traps as a 
group. A “shadow” image of all selected traps moves as the mouse moves.  Releasing the 
left mouse button causes a message to appear asking if the move is complete. The move 
can be completed (click on Complete), continued (Continue), or canceled (Cancel). 

 
7. Add Single Trap: This option adds single trap locations using either the mouse or 

keyboard modes. After selecting this option in the “mouse click” mode, you are prompted 
to click the left mouse button on the screen where you want the new trap. GypsES 
prompts you for a trap ID, then draws the new trap in the highlight color.  If you are in 
the “keyboard” mode, GypsES prompts you to enter the UTM Easting coordinate, UTM 
Northing coordinate, and the trap ID.  Clicking on the right mouse button stops the Add 
Single Trap option in either mode. 

 
8. Add Delimiting Grid Area: Use this option to add a grid of traps in the Work Window. 
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Choosing this option brings up a Define Delimiting Grid dialog box (Fig. 10-4): 

 

 
a. Grid Type: This can be either a fixed grid (a single trap density for the entire area) or 

a variable grid where you specify different trap densities within a single grid 
definition. 

 
b. Grid Dimensions (Width & Height): Specify a grid width and height in either square 

miles or square kilometers. 
 

 

User Tip:  “What is a delimiting grid?” 
 
The purpose of a delimiting grid is to determine if an infestation is present and the size of the 
infestation.  This is accomplished by laying out a systematic sampling grid of pheromone traps based 
on previous years’ trap catch information.  When no previous survey has been done, but the presence 
of the pest is suspected, a Detection Grid, usually involving a fairly low density of traps over a large 
area, can be used. 
 

Figure 10-4.  Define Delimiting Grid dialog box. 
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c. Grid Density: If you chose a fixed grid type, choose a grid density by clicking on the 
choice button to the right under “Grid Density.” A list of available densities is 
displayed; click to select the trap density you want. If you chose a variable grid type, 
the box below “Grid Density” changes to an Edit Variable Grid push button; clicking 
on this brings up a Variable Grid Definition dialog box (Fig. 10-5).  [Note: This 
option works only if the Grid Dimensions are defined at greater than 1 x 1 square 
mile or kilometer.] 

 

A group of squares representing the entire grid appears in the upper left corner of the 
dialog box; for example, if you have chosen grid dimensions of 5 x 5, then a grid of 5 
x 5 (25) squares is illustrated.  To assign a grid density to a given square within the 
grid, first click on the density you want in the list to the right, then click on the grid 
square.  The square is highlighted in the appropriate density color.  When all grid 
square densities are selected, click on Accept to close the dialog box. 

 
d. Define Labeling: Once the grid is defined, you can specify the following options: 

 
 

(1) Labeling Sequence: This option is used to define the order used to number 

Figure 10-5.  Variable Grid Definition dialog box. 
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(label) traps.  The labeling sequence is defined in the box below “Define 
Labeling.”  Options include Sequential - Left to Right (traps are labeled from left 
to right), Sequential - Serpentine (traps are labeled in a serpentine (back and 
forth) fashion), and Sequential - As Selected (traps are labeled in the order in 
which they were selected). 

 
(2) Label Prefix: Use this option to specify a label prefix. Using trap label prefixes is 

optional, but it may make it easier for you to keep track of different blocks of 
trapping sites (e.g., the traps within one block can be labeled A-1, A-2, and A-3, 
and traps in the next block can be labeled B-1, B-2, B-3, etc.). 

 
(3) Label Start[ing] Number: Use this option to specify the starting number for 

labeling trap locations. There cannot be duplicate trap ID’s in the same 
eradication file. If any newly defined trap label numbers are already in use, 
GypsES warns you that “Adding this grid would duplicate trap ID’s - Please 
change labeling options and re-try.” 

 
When Accept is clicked, you are prompted to place the grid on the Work Window by 
holding the left mouse button down and moving the grid outline from the upper left 
corner of the Work Window to where you want it. As with the Move Selected Traps 
function, you are asked after releasing the left mouse button if grid placement is 
complete, with options to continue or cancel. 

 
9. Add Traps in Polygon: Use this option to place traps within an irregular area at a specific 

density. First, GypsES prompts you to define a polygon with the left mouse button. If 
three or more points have been specified when the right mouse button is clicked, GypsES 
closes the polygon and displays a dialog box (Add Traps in Polygon: define density & 
Trap ID’s, Fig. 10-6). 

 
Sections of this dialog box include “Grid Unit” (select square miles or kilometers), “Grid 
Density” (select the number of traps per square unit area), and “Define Labeling” (select 
the label sequence type, prefix, and starting number).  Clicking Accept adds traps to the 
Eradication database as specified.  Cancel aborts the Add Traps in Polygon option. 

 
 
 



Section 10: The Survey Menu  GypsES User’s Manual v1.0 

GypsES:  Decision Support and Project Mgt.   10-12 

 
10. Label Selected Traps: Use this option to re-assign trap ID’s using a Trap Label 

Definition dialog box. [Note: To display the current trap ID label to see labeling 
changes, modify the SiteData layer within the Window menu / Build/Update Map option 
to display site labels; see Labels on page 8-6 for more information.] 

 
11. Delete Selected Traps: This option deletes any selected traps. 

 
12. Un-do Last Delete: This option restores the traps last deleted in the current GypsES 

session. 
 

13. Save Selected Traps: This option saves currently selected traps in a database file.  You 
are prompted to provide a filename for this file. [Note: This is a simple SiteData file.  The 

 
User Tip: Trap ID Duplication 
 
For this and all other Add operations, if a trap ID (label) specified duplicates an existing trap's ID, an 
error message appears and the trap(s) will NOT be added. 
 

Figure 10-6.  Add Traps in Polygon: Define Density & Trap ID’s dialog box.
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detail information associated with the Eradication database is not saved (e.g., the traps’ 
master record and activity information.] Once you have saved the selected traps, GypsES 
brings up a dialog box that states “[x] selected traps copied to SiteData file [y]. Note: 
detail NOT copied.” 

 
14. Save All Traps: This option saves all work done to that point for the entire database of 

traps, including all detail information.  You are given the option of using the current 
filename (if one exists) or entering a new one.  If a new name is entered, that name 
becomes the linked Eradication database filename. 

 
15. Show History for Area: This option displays past years’ positive trap counts in different 

colors by year. 
 

16. Switch to Database Palette: This option toggles you to the “Trap Database” palette (see 
Section C below for a description of available functions). 

 
C. Edit Trap Database 

Selecting this option brings up a “Trap Database” palette on the left side of the screen (Fig. 
10-7). This group of functions for editing the trap database includes the following: 

 
�� Set Options  (10-14) 
�� Exit Trap Database Edit  (10-14) 
�� Trap Setup Entry  (10-14) 
�� Trap Count Entry  (10-15) 
�� Update Setup From Imported File  (10-17) 
�� Update Count From Imported File  (10-18) 
�� Trap Database Display/Update  (10-19) 
�� Show History  (10-20) 
�� Highlight No Reports  (10-20) 
�� Highlight No Setup  (10-20) 
�� Save Highlighted Traps  (10-20) 
�� Save All Traps  (10-21) 
�� Clear Highlighted  (10-21) 
�� Switch to Edit Trap Placement  (10-21) 
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1. Set Options: See the description for Set Options starting on page 10-6. 

 
2. Exit Trap Database Edit: See the description for Exit Trap Placement on page 10-7 

(substitute Database for Placement). 
 

3. Trap Setup Entry: Clicking this push button brings up a Trap Setup Entry dialog box 
(Fig. 10-8). Use this dialog box to enter trap setup information one time (e.g., the date the 
trap was placed, the trap type, and the trapper’s initials). Assuming these setup data do 
not change, you need to only enter the trap ID and press <ENTER> to bring up the same 
setup information for other trap locations. [Note:  If any setup data changes, just edit the 
appropriate values and continue to enter the trap ID information; the new setup 
information will appear in the database dialog box.] A scrolling window displays the last 
20 traps entered. The database records are updated immediately. 

Figure 10-7.  Trap Database palette of functions. 
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4. Trap Count Entry: Clicking this push button brings up a Trap Count Entry dialog box 

(Fig. 10-9). 
 

Figure 10-8.  Trap Setup Entry dialog box. 

Figure 10-9.  Trap Count Entry dialog box. 
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This dialog box makes it easier to enter trap count data for many traps; each trap 
location’s data appears on its own line below the data entry fields in a scrolling window. 
Data entry fields include: 

 
a. Trapping Date: This is the date the trap was checked. 

 
b. Initials: These are the initials of the trapper. 

 
c. Count Type: Trap counts can be of four types, described below: 

 
(1) C:  This indicates that the data entry represents a cumulative count; any count 

data entries replace prior trap count information. 
 

(2) + :  This indicates that the data entry represents an additive count; any count data 
entries increment prior trap count information. 

 
(3) NC:  This indicates that the data entry is informational, and the trap does not 

have a report. 
 

(4) OMIT: This indicates that the trap has been omitted; although the trap does not 
have a report, it is not flagged as a missing report. 

 
d. Trap ID: This is the trap ID number (GypsES prompts you if the trap ID is 

unrecognized). 
 

e. Count: This is the male moth count for that trap location. 
 

f. Condition:  This is the trap condition.  Enter the condition of the trap by clicking on 
the choice button to the right of the “Condition” box and choosing the appropriate 
condition; choices include Good, Damaged, On Ground, Missing, Inaccessible, or 
Full of Moths. 

 
g. Final Visit: This field indicates whether this trap check was a final visit (options 

include Yes or No). 
 

h. Early Removal: This field indicates whether this trap was removed early (options 
include Yes or No). 

 
i. Comments: This field is for any comments associated with the trap location. 
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The <TAB> keys move you from data field to data field.  The <Enter> key records the 
whole entry; you should not press <Enter> until all fields have been entered.  The last 20 
trap data entries are shown in the scrolled window below.  As default, GypsES does not 
clear the data fields between data entries. Checking the toggle button to the left of “Clear 
fields between entry” causes all fields on the entry line (except the date and trapper’s 
initials) to be cleared when <ENTER> is pressed following a data entry. 

 
You can edit a previous data entry by clicking Edit next to the entry in the scrolled 
window (this button appears under the title “Modify”).  This brings up a Modify Trap 
Catch Detail dialog box to edit any data fields.  [Note: The “C/+” heading refers to the 
Count Type.]  After making the edits you want, click on Accept to update the database 
and return to the Trap Count Entry dialog box, click on Delete to delete the data entry 
line for that trap, or click on Cancel to cancel the Modify function. 

 
5. Update Setup From Imported File: Selecting this option brings up an Update Trap 

Setup from Imported Database File dialog box (Fig. 10-10) for updating GypsES 
eradication records using data from a *.dbf file created elsewhere (e.g., on a remote PC). 

 

The database file must have been previously imported using the File menu / Import 
option  / Import Data Files option (see page 6-15 for more information). To select a file, 

Figure 10-10.  Update Trap Setup from Imported Database File dialog box. 
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click on the box to the right of “Imported Data File” to bring up a Choose Database File 
for Trap Import dialog box.  Select the appropriate mapset and file, then click on Accept 
to return to the previous dialog box.  Once the file has been selected, you can link the 
Eradication data fields for Trap ID, Setup Date, and Initials with fields names in the 
selected database.  Alternatively, you can set the date and/or initials to a constant value.  
Click on Accept to complete this function or on Cancel to cancel. 

 
6. Update Count From Imported File: Selecting this option brings up an Update Trap 

Counts from Imported Database File dialog box (Fig. 10-11). Use this option to update 
GypsES eradication records using data from a *.dbf file created elsewhere (e.g., on a 
remote PC). 

 

 
The database file must have been previously imported using the File menu / Import 
option / Import Data Files option (see page 6-15 for more information). To select a file, 
click on the box to the right of “Imported Data File” to bring up a Choose Database File 
for Trap Import dialog box. Select the appropriate mapset and file, then click on Accept 
to return to the previous dialog box. Once the file has been selected, you can link the 
Eradication data fields for Trap ID, Count, Date Counted, and Initials with field names in 
the imported file. Alternatively, the date counted and initials fields can be set to some 
constant value. The Count Type, Trap Condition, and Comments fields can be set, and 

Figure 10-11.  Update Trap Counts from Imported Database File dialog box.
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apply to all matched entries in the database file. Click on Accept to complete this 
function or on Cancel to cancel. 

 
7. Trap Database Display/Update: When you click this push button, GypsES either 

prompts you to click on a trap or requests trap ID entry via the keyboard (depending on 
the trap selection option chosen).  Once a trap is identified, a Trap Database Information 
dialog box appears (Fig. 10-12) with information pertaining to that trap. You can either 
edit individual data entries using the Edit push button in the scrolled window or create a 
new entry by clicking on Enter Trap Data in the lower left corner of the dialog box. To 
exit the record and save changes, click on Accept.  To restore the trap information to its 
previous content prior to selection, click on Cancel. 

 

GypsES continues to prompt you for another trap until either the right mouse button is 
clicked (if the selection by mouse click option is being used) or  <ENTER> is pressed 
without entering an ID (if the selection via the keyboard option is being used). 
 

8. Show History: If trapping information for any of the prior 4 years is available, it is 
displayed. GypsES tries to locate the information by checking the current output mapset's 
Standard Name linkage for the four standard names: 

 

Figure 10-12.  Trap Database Information dialog box. 
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��TRAP_SITES_YR1 (previous year)  
��TRAP_SITES_YR2 (2 years ago) 
��TRAP_SITES_YR3 (3 years ago) 
��TRAP_SITES_YR4 (4 years ago) 

 
If linkage exists, AND the linked files exist and are in the proper eradication file format, 
history information on all Positive (non-zero) trap catches is extracted from these files 
and displayed.  The shape and color for the initial history display is as follows: 

 
��Previous year:  Red Open Circle 
��2 years back:  Blue Plus Sign 
��3 years back:  Green “X” 
��4 years back:  Yellow Open Triangle 
 
In addition, the counts are displayed in red. 

 
The history data are displayed in a temporary work file named E~Hnnnn, where “nnnn” 
is a number unique to this particular session of GypsES.  You can modify the display 
characteristics by choosing the Window menu / Build/Update Map option and clicking 
on Modify for this file. 

 
9. Highlight No Reports: This option highlights traps that have not had a count entry. 

 
10. Highlight No Setup: This option highlights traps that have no trap setup information 

recorded. 
 

11. Save Highlighted Traps: This option saves highlighted traps (traps with no reports or 
setup) in a database file.  [Note: This is a simple SiteData file.  The detail information 
associated with the Eradication database is not saved (e.g., the trap’s master record and 
activity information).]  Once you have saved the highlighted traps, GypsES brings up a 
dialog box that states “[x] selected traps copied to SiteData file [y].  NOTE: detail NOT 
copied.” 

 
12. Save All Traps: This option saves all work done to that point for the entire database of 

traps, including all detail information.  You are given the option of using the current 
filename (if one exists) or entering a new one.  If a new name is entered, that name 
becomes the linked Eradication database filename. 
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13. Clear Highlighted: This option clears all highlighted traps (e.g., those highlighted using 

options #9 and #10 described just above). 
 

14. Switch to Edit Trap Placement: This option toggles you to the “Edit Trap Placement” 
palette of functions. 

 
D. Last Year's (-1) Trap Data: This option displays last year's trap data if the file is linked 

through the Standard Names linkage table. 
Pull Down Menu: 
�� Link  (10-21) 

 
1. Link:  After selecting this option, a Set Link for Last Year’s (yyyy) Trap Data dialog box 

appears (“yyyy” refers to last year).  The file type and selected file for linking (if one 
exists) are listed.  To change or set a linked file, click on the box to the right of “Selected 
File;” this brings up a file selection dialog box.  Select the appropriate mapset and 
filename for linking.  Click on Accept to set the link, on Clear to clear the file selection, 
or on Cancel to cancel the linking function. 
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The Treatment Menu 
 
Use this menu to manage aerial spray operations, including planning the timing of aerial spray, 
laying out spray lines, and evaluating spray results. 
Pull Down Menu: 
��Spray Blocks   (11-1) 
��Phenology   (11-10) 
��Spray Modeler  (11-14) 
 
I. Spray Blocks  

Pull Down Menu: 
��Import Vendor Block Files  (11-1) 
��Export Treatment Blocks  (11-3) 
��Import Flight Lines  (11-8) 
��Post Treatment (Egg Mass Difference)   (11-9) 

 
A. Import Vendor Block Files 

If you are using either AgNav or SatLoc spray block file formats (NO1 and JOB files, 
respectively), use this option to bring spray block information into the current GypsES output 
mapset as vector files. When you click on Import Vendor Block Files, an Import Vendor 
Spray Block File(s) dialog box appears (Fig. 11-1). 
 
First choose the vendor file format being imported (AgNav or SatLoc) by clicking on the 
diamond toggle button next to the vendor name. Then click on Select Files to bring up a File 
Selection dialog box (Fig. 11-2).  Select the drive(s) the spray block files are stored on by 
clicking on the choice button to the right of the drive box. A list of all files on that drive 
appears in the box below “Files.” Select files to import by clicking on the filename; selected 
files are highlighted with a black bar the first time they are selected.  To de-select a file, click 
on it again.  Filenames are listed in the “Files Selected:” box as you select them. Click on 
Accept to close the dialog box and keep your selections, on Clear to clear your selections, or 
on Cancel to abort the file selection process. 
 
Now type in a filename for the GypsES vector file being created in the text entry window to 
the right of “Output File Name.”  All imported spray blocks are grouped into a single output 
vector file. Click on Accept to import or on Cancel to quit the import process. 
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GypsES imports spray blocks in the files specified, including any exclusion areas. [Note: 
Exclusion areas are defined within the Satloc JOB file. They exist as separate XXX.XCL files 
associated with XXX.NO1 files within the AgNav NO1 file.  Both types of exclusion polygons 
are imported automatically.  You do not need to select the AgNav *.XCL files.] GypsES 
assigns a sequential category number to imported blocks.  The category description for the 
imported blocks is the name of the file they were imported from.  For SatLoc JOB files that 
contain more than one block, the block number and the JOB filename appear in the 
description.  Exclusion areas are imported with no label. 
 
For AgNav NO1 files, only the Clarke_1866 and WGS_84 ellipsoid types (line 20) are 
accepted at this time. GypsES handles either Latitude/Longitude or UTM coordinates in 
AGNAV files. The information in Lines 1 (Coordinate System) and 20 (Ellipsoid) are used to 
determine the coordinate conversion.  SatLoc JOB files always use Latitude/Longitude. 

Figure 11-2. File Selection dialog box. Figure 11-1. Import Vendor 
Spray Block File(s) dialog box. 
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B. Export Treatment Blocks 
This option specifies a spray block layer file to export to the GPS system of a spray aircraft. 
[Note: GPS stands for Global Positioning System, a satellite-based navigational tool used by 
pilots to keep track of where the plane is over the Earth’s surface.  DGPS, or Differential 
Global Positioning System, is a GPS system that uses a ground station or satellite signal to 
correct for selected availability (a scrambled signal) so the pilot knows precisely where the 
plane is while spraying.  Because GypsES receives a DGPS record for aerial spraying, all 
aircraft must use DGPS.]  If a spray block layer has been selected for export in a previous 
session, GypsES produces a message box that lists the spray block layer filename as the 
source of spray block information.  Click on Yes to accept the filename or on Choose to 
choose another map layer.  If you select Choose or no file has been chosen for export, a 
Select Spray Block Layer for Export dialog box appears.  Select the appropriate mapset and 
filename; click on Accept to select the file, click on Clear to clear the selection, and click on 
Cancel to cancel the selection. 
 
Choosing Yes brings up a Vector Display Options dialog box.  You can specify the Vector 
line width, color, and style as well as specify the Vector line label display (check the 
“Display Vector Label” square toggle button and then fill out the Vector Label Definition 
dialog box that appears).  Click on Accept to close the dialog box once edits are completed, 
click on Reset to cancel all edits since the last save, and click on Cancel to cancel the 
function. 

 
As the spray block Vector layer is then re-drawn in the Work Window, a dialog box appears 
on the left side of the Work Window titled Export Spray Blocks to GPS (Fig. 11-3).  There 
are several functions within this dialog box to guide you in exporting spray block boundary 
information for use by pilots.  These include: 
 
1. Select Block: If this option is chosen, GypsES prompts you to select spray block(s) for 

exporting by clicking once inside the blocks. You are then prompted to enter a block 
number and descriptor for each block.  As blocks are selected, they are simultaneously 
listed in an area in the middle of the box by block descriptor and acreage. A running total 
acreage is also tallied just below the block selection list.  De-select selected spray blocks 
by clicking inside the block a second time. Click the right mouse button to end the 
selection process. [Note: Spray blocks can be removed individually from the selection list 
by clicking once with the left mouse button on the spray block line itself.]  Spray block 
polygons should be labeled with unique block numbers. If a block is not labeled, GypsES 
prompts for a number. 
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2. Select All Blocks: This option selects (and lists) all spray blocks in the file. 
 

3. Clear Blocks: This option clears all spray block selections. 
 

4. Area Units: This is the spray block area unit of measurement. This is initially set to either 
acres or square kilometers depending on the default unit of measure settings in the Edit 
menu / Administrative Profile option / User Profile option (see page 7-39).  To choose 
another area unit of measurement, click on the choice button to the right and choose 
between square kilometers, square meters, square miles, acres, or hectares. 

 
5. Block Select Color: This option sets the color of selected spray blocks. 

 
6. Point Weed Tolerance: Use this option to modify the Point Weed Tolerance (expressed 

in meters).  GypsES can only export a fixed number of points within a spray block line. 

Figure 11-3. Export Spray Blocks to GPS dialog box. 
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When a spray block is exported that contains curved boundary lines, for example, there 
may be more points along the curved line than the system can deal with. To reduce the 
number of spray line points exported, GypsES draws a line from one point to a third 
point. If the perpendicular distance between the line drawn between these two points and 
the point in between is less than the point weed tolerance value, the point is eliminated, 
or “weeded out”  (Fig. 11-4).  If the perpendicular distance is greater than the point weed 
tolerance value, the point is retained. 

 

7. Format: This is the commercial DGPS data format used by pilots for navigation.  
Options include AgNav, SatLoc, SoftNav, and Trimble.  GypsES prompts you for all 
information required to use each data format chosen.  If you choose the AgNav export 
format and click on Export, you are then asked if you want to change the AGNAV 
parameters. If you click Yes, an AgNav Spray Block Setup Parameters dialog box appears 
(Fig. 11-5).   

 
Entering information in this dialog box may provide additional information formerly 
provided by the “ENTRY.NEW” file and possibly eliminate further editing of the 
AGNAV “NO1” block files that GypsES creates.  GypsES edits the values entered in this 
dialog box and displays error messages in the empty box below the parameter values. 
When you accept the AgNav parameters, the values are saved for that output mapset 
and are used the next time you export in the AgNav format in that output mapset. 

Figure 11-4.  Illustration of the Point 
Weed Tolerance concept. 
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The following describes each of the AgNav parameters:  [Note: For most parameters 
listed, consult the AGNAV User’s Manual.  The explanations provided here define the 
defaults and the editing GypsES performs on them.]  

 
a. Waypoints: You can enter as many as 19 waypoints in the scrolling window 

provided.  Enter the Latitude and Longitude as degrees:minutes:seconds.  If you do 
not provide a name and/or comments for a waypoint, GypsES assigns a name 
“WPT#” and a comment, “Way Point #”, where # is the waypoint number.   
Waypoint names and comments can not contain commas or the pipe (|) symbol.  The 
first waypoint placed on each block (NO1) file is the first corner of the block.  The 
first corner of any block is always the point first digitized.  To clear a waypoint, just 
blank out the Latitude field; it will not be used. 

 
b. Max[imum] Cross Track:  Any number is accepted; the default value is 300. 

 

Figure 11-5.  AgNav Spray Block Setup Parameters dialog box. 
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c. First Line Number: The default value is 1. 
 

d. MasterPoint [and Grid] / Heading: This is a toggle between “Longest Side” (the 
master point and heading are automatically assigned as the longest side of each 
block) and “Set for Each Block” (GypsES prompts you for the master point and 
heading as the blocks are created). 

 
e. Spray Side: Valid entries are C (center), L (left), and R (right); the default is C. 

 
f. [Spray Line] Log Dir[ectory] Prefix:  GypsES uses the 2-character code supplied 

here as a prefix for the name of the directory where spray line files are placed.  The 
actual directory is <PFX>NNN, where NNN is the block number. 

 
g. No. [of] Aircraft: The number of aircraft to be used; the default is 1 and the 

maximum is 10.  
 

h. Swath Width (ft): This is the swath width of the aircraft in feet.  No default is 
provided, but this must be entered or the parameters are not accepted.  The maximum 
value is 1000. 

 
i. Offset [of] Master Line: Valid entries are 0 (no offset) and 1 (half-line offset); the 

default is 0. 
 

j. Spray On [Option]: Valid entries are 1 or 2; the default is 1. 
 

k. Magnetic Variation: Valid entries are between -50 and 50; the default is 0.  
 

l. Race Track: Entries can be negative; the default is 5. 
 

When you have set up your parameters, click Accept to have GypsES create your spray 
block files.  If you have specified the “Set for each Block” option for the master point 
and heading, you are prompted to click to provide a master point, and again to provide a 
heading for each block.  GypsES then asks you to put a diskette in the drive and places 
the block files on it.  If you click on Reset to Defaults, the waypoints are cleared and the 
parameter values are reset to the specified default values.  If you click Cancel, the export 
operation is aborted and the parameters are not saved. 
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8. Drive: This is the drive to which the DGPS spray block data are sent (exported); choices 
include A: and B:. 

 
When the Export Spray Blocks to GPS dialog box options are set, click on Export to export 
the spray block data.  GypsES prompts you to insert a diskette in the specified drive.  

 
C. Import Flight Lines (from DGPS) 

Use this option to import spray flight line data from an aircraft’s DGPS system into GypsES 
after aerial spraying is completed.  An Import Spray Lines from GPS System dialog box 
appears on the left (Fig. 11-6) and has the following options: 

 
1. Format: This is the DGPS data format used by the pilot for navigation; options include 

AgNav, SatLoc, SoftNav, and Trimble. 
 

Figure 11-6. Import Spray Lines from GPS System dialog box. 
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2. Select File: This option is used to select a spray line file (“source file”) for importing into 
GypsES. A File Selection dialog box appears; choose the appropriate drive letter and file 
you want to import. Click on Accept to complete the selection or on Clear to clear the 
selection. You are then returned to the Import Spray Lines from GPS System dialog box; 
the selected file is listed in a box just below “File Selected.” 

 
3. File Name Prefix: Click on the text entry window to the right of this option to specify a 

prefix for the GypsES filename. The prefix can be up to 10 characters long. If you are 
importing many files, it helps to be systematic in naming files so that you can easily 
identify and retrieve files in GypsES. For example, your file naming system might 
include references to the pilot, the tail number of the plane, the date and time sprayed, 
etc., to help you keep track of what imported spray line file belongs to what spray block. 
GypsES imports both “spray on” and “spray off” flight line data. GypsES automatically 
adds an *.spy extension to the filename for “spray on” flight line data only, and adds an 
*.all extension for all spray data (both “on” and “off”). 

 
4. Display Type: This option specifies which flight lines are displayed on the GypsES 

screen: Spray On Only (displays only those flight lines during which the spray nozzles 
were on and dispensing spray material) or Spray On/Off (displays all flight lines, 
including those where the spray nozzles were off). 

 
5. Spray On/Off Color: These options are used to specify flight line screen display colors 

for both Spray On and Spray Off. Click on the choice buttons to the right to pick a color. 
 

Once these options are set, click on Import to complete the import process or click on 
Cancel to end the process. 

 
D. Post Treatment (Egg Mass Difference)  

Use this option to evaluate treatment efficacy and compare egg mass differences between 
years. This option takes the egg mass surface layers from the past two years and subtracts 
them, producing an egg mass difference layer. The difference layer is displayed with negative 
values beginning in blue and positive values ending in red, showing the decrease and 
increase, respectively, in egg masses over areas that may or may not have been treated. Link 
the first (current) year egg mass surface file in the Standard Names table to 
EM_PA_SURF_YR0; link the second (previous) year file to EM_PA_SURF_YR1. 
Pull Down Menu: 
��Re-Calc  (11-10) 
��View  (11-10) 
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1. Re-Calc: This option recalculates the egg mass difference layer if new egg mass surface 

data are available (and linked). 
 

2. View: Use this option to view an egg mass difference layer if egg mass surface files exist 
for the last two years.    

 
II. Phenology  

This option contains variables to calculate gypsy moth phenology using GMPHEN, the gypsy 
moth phenology model developed by researchers at U.S. Forest Service laboratories.  (For more 
information about the model, see Sheehan 1992.)  Phenological prediction is potentially valuable 
for timing spray applications and other gypsy moth management activities. 
Pull Down Menu: 
��Elevation   (11-10) 
��Temperature   (11-11) 
��Observed Egg Hatch   (11-12) 
��Target Event   (11-13) 
��Phenology    (11-13) 
��Group Phenology    (11-13) 

 
A. Elevation  

Elevation refers to the elevation layer for the current location; you can either select a data 
layer to represent the elevation for the location or display the currently selected layer.   
Pull Down Menu: 
��Link   (11-10) 
     
1. Link: Selecting the Link option brings up a Set Link for Elevation dialog box that lists 

the file type and file selected for linking (if one is linked).  To set or change a link, click 
on the box to the right of “Selected File.”  Select the appropriate mapset and filename, 
then click on Accept to complete the selection, click on Clear to clear the selection, and 
click on Cancel to cancel the selection.  GypsES alerts you if a map is already drawn in 
the Work Window with options to either re-draw the Work Window with the selected 
(elevation) map layer or retain the current map layer. 

 
 

B. Temperature 
Use this option to enter minimum and maximum temperature data for the current year on the 
right side of a Temperature Data dialog box (Fig. 11-7). Select the temperature scale 
(Fahrenheit or Celsius) you want in the upper right corner of the dialog box. 
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All days in the calendar year are listed for reference on the left side of the dialog box with 
historical average temperature data for each date (the temperature scale chosen is reflected in 
these average temperature data as well).  The historical average temperature data displayed 
reflects a 30-year average; however, this average temperature data can be edited in mapset 
PERMANENT to reflect the best historical data for the weather station being used. 

 
To scroll through the database one page at a time, click on Down or Up in the lower left 
corner.  The elevation (in feet) is displayed at the bottom center of the dialog box. [Note: It is 
important to make sure that the same weather station (and therefore elevation) is used for 
both the average temperature data and new temperature data you enter.] To enter 
temperature data, click on the appropriate cell within the temperature table and enter the 
number.  The <Tab> key moves you through the table.  Click on Exit when data entry is 
complete.  GypsES prompts you to save changes if any have been made by clicking on Save; 
the dialog box then closes.  Click on Cancel to close the dialog box without retaining any 

Figure 11-7.  Temperature Data dialog box. 
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edits. 
 

C. Observed Egg Hatch 
Choosing this option brings up a dialog box (Observed Egg Hatch Data, Fig. 11-8) for 
entering information about gypsy moth egg hatch.   

 

 
1. Percent Egg Hatch: This is the percentage of egg hatch within egg masses already 

considered “hatched.” 
 

2. Site elevation: This is the elevation of the site in feet. 
 
3. Date Observed: This is the date the egg hatch observation was made. 
 
Click on the box(es) to the right of the appropriate category to edit its value.  Click on Accept 
when all edits are made or on Cancel to cancel any edits. 

D. Target Event 
Choosing this option brings up a dialog box (Larval Instar Target Event) for indicating the 
larval instar target (1 through 4) you want and percentage of the population in that instar. 
Click on the box to the right of the appropriate category to edit its value. Click on Accept 
when all edits are made. 

Figure 11-8.  Observed Egg Hatch Data dialog box. 
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E. Phenology  

Pull Down Menu: 
��Re-Calc   (11-13) 
��View   (11-13) 

 
1. Re-Calc:  The Re-Calc option re-calculates the gypsy moth phenology Raster map layer 

using the temperature data file.  The Standard Name in the linkage table is 
PHENOLOGY.    If the data within the temperature file changes, click on Re-Calc to 
have the phenology map layer re-calculated and displayed. 

 
2. View: Use this option to view the gypsy moth phenology Raster map layer. If a Raster file 

of gypsy moth phenology is linked to the Standard Name PHENOLOGY, it is drawn in 
the Work Window when the View option is chosen. 

 
F. Group Phenology  

Pull Down Menu: 
��Re-Calc   (11-13) 
��View   (11-13) 

 
Gypsy moth phenology is calculated on a daily basis; the Group Phenology function can be 
used to group daily phenology data into specified time intervals (e.g., one week).  The 
Standard Name of the grouped phenology map layer in the linkage table is PHEN_GROUP.   
1. Re-Calc: Use this option to change the number of days used for grouping, then enter a 

new grouped phenology filename. This file then becomes the linked file to 
PHEN_GROUP. 

 
2. View: Use this option to view the currently linked grouped phenology file.  
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III. Spray Modeler 
Use the Spray Modeler option to predict spray deposition within treatment blocks (or from actual 
spray flight lines) under specified meteorological conditions and with specified aircraft, spray 
systems, and spray materials.  The Spray Modeler option brings up a “Spray Advisor” (Spray 
Model System Advisor, or SMSADV). SMSADV uses a verified near-wake computer model 
called AGDISP (Version 7.0) (for more information, see Bilanin and others 1989.) AGDISP 
predicts spray dispersion and deposition. Spray material from every nozzle on the aircraft is 
tracked by its own set of equations from release to groundfall. The spray material is divided into 
discrete drop size categories (drop size distribution) and each drop is followed as it is influenced 
by the wake of the aircraft, the ambient crosswind, and evaporation. 
 
When Spray Modeler is clicked, you are first prompted to indicate whether spray blocks or spray 
lines will be used for the analysis:   

 
��If the spray blocks option is chosen, GypsES checks to see if any Vector files are drawn in 

the current Work Window, then asks you if you want to use the file drawn as a source of 
spray blocks (Yes) or choose a spray block layer (Choose).  Clicking on the latter option 
brings up a dialog box titled Select Spray Block Layer for Spray Deposit. Select the 
appropriate mapset and filename, then click on Accept to select the file, click on Clear to 
clear the selection, or click on Cancel to cancel the selection process. You are then prompted 
to choose the display parameters for that layer in the Vector Display Options dialog box; 
when these have been set and accepted, the chosen Vector layer is drawn in the Work 
Window. 

 
��If the spray lines option is chosen, GypsES asks you to select one or more spray line files for 

analysis in a Select spray line file(s) for analysis dialog box.  Select the appropriate mapset 
and filename(s), then click on Accept to select the file(s), click on Clear to clear the 
selection, or click on Cancel to cancel the selection process.  [Note: At this time the 
deposition analysis only works with a single set of lines which are contiguous and all in the 
same direction.]   
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The “Spray Advisor” palette now appears in the upper left corner of the Work Window (Fig. 11-
9).  Its functions include: 
 

A. Select Block 
This option is activated only if spray blocks are being analyzed.  When this push button is 
clicked, GypsES prompts you to click inside the block you want to analyze (it must be a 
closed polygon); the selected block is then highlighted. 

 
B. Run Spray Advisor 

After you have selected a spray block, use this option to specify a flight direction. [Note: If 
flight lines are being analyzed, you are not prompted to specify a flight direction.] Click 
once on the screen and then click again in the appropriate direction from the first click to 
show the direction of the flight lines you want to analyze. [Note: As the mouse cursor is 
moved to the second point, a line is simultaneously drawn between the first point and the 
mouse pointer to indicate the flight line.] Clicking the right mouse button cancels the flight 
direction function. Click on Accept to confirm the correct flight direction or on Cancel to 
cancel the flight direction function. If the flight direction is correct, the Spray Advisor 
(SMSADV) dialog box appears (Fig. 11-10). Spray block data are transferred to SMSADV 
from GypsES in a separate filename beyond your control. This file contains both the flight 
line direction and spray block boundaries (and exclusion zones) or details GPS flight line 
data. 

Figure 11-9.  Spray Advisor function palette. 
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Following a brief explanation of aerial application definitions (starting on page 11-17), each 
section of the Spray Advisor (SMSADV) dialog box is described. 
��Aircraft  (11-18) 
��Spray System  (11-19) 
��Spray Lines  (11-19) 
��Meteorology  (11-20) 
��Nozzles  (11-20) 
��Output  (11-21) 
��Calculation Control  (11-22) 
��Return to GypsES  (11-22) 
��Spray Advisor Menu Bar Options  (11-23) 
1. Aerial Application Definitions: SMSADV assumes that you have a basic knowledge of 

Figure 11-10. Spray Advisor (SMSADV) dialog box. 
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aerial application theory and practices, including some understanding of aircraft and 
forests.  For a point of common reference, the following definitions and concepts used in 
SMSADV are summarized:  

 
a. Aircraft: helicopter or fixed wing. 

 
b. Canopy: the vegetative material (trees, shrubs, crops, etc.) that captures a portion of 

the released material before it intercepts the ground. 
 

c. Default Values: current input variables (from SMSADV or an input file) before 
being modified by you. 

 
d. Deposition: amount of spray material per unit area collected. 

 
e. Dispersion: spreading of the released material due to atmospheric turbulence and 

wind. 
 

f. Flight Line: spray path of the aircraft. 
 

g. Isopleth: line of constant value (in the case of spray deposition, an isopleth would 
represent a constant value of deposition). 

 
h. Near Wake: the AGDISP aircraft wake model used to calculate spray swath widths. 

 
i. Receptor Grid: points at which spray deposition is predicted.  As a general rule, this 

grid should encompass and extend beyond the flight lines, especially downwind in 
those model runs where a crosswind is used. 

 
j. Release Height: aircraft height measured from the ground when spray material is 

released. 
 

k. Swath Width: anticipated width of the spray swath to achieve the amount of spray 
material you want on the ground. 
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2. Aircraft 
 

a. Aircraft Name: The name of the aircraft currently selected is shown in the box to the 
right of “Name.” Clicking on Select brings up a library of applicable aircraft names 
accessed by SMSADV in a Select Aircraft dialog box (Fig. 11-11). These data are 
arranged in alphabetical order by aircraft name. Your selection brings in all input 
parameters needed to run AGDISP, including the wingspan (or rotor diameter), swath 
width, boom length, and the vertical position of the spray boom relative to the 
wingtips (for a fixed-wing aircraft) or rotor plane (for a helicopter). 

 

b. Airspeed: The flight speed of the aircraft is shown to the right of “Airspeed.” Choose 
the unit of measurement you want by clicking on the choice box to the right and 
selecting a unit. 

 
c. Wingspan or Rotor Diameter: The wingspan (or rotor diameter) is shown to the right 

of “Wingspan or Rotor Diameter.” This value describes the size of the aircraft and 
can be adjusted by the user with caution. Choose the unit of measurement by clicking 
on the choice box to the right. 

 

Figure 11-11. Select Aircraft dialog box.
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3. Spray System 
 

a. Spray System Name: The spray system name is shown to the right of “Name.” 
Clicking on Select lists a library of applicable spray systems accessed by SMSADV 
in a dialog box (Fig. 11-12). A selection includes (from left to right) nozzle type, 
spray material, nozzle angle to the wind stream (or atomizer rpm), and aircraft speed 
(mph). All data in this library are arranged in alphabetical order by nozzle type first 
and then by the other variables. Each selection has its own spray drop size 
distribution needed to run AGDISP, including the nonvolatile fraction (see below for 
a description). 

 

b. Nonvolatile Fraction: The nonvolatile fraction is shown to the right of “Nonvolatile 
Fraction.” The nonvolatile fraction is the fraction of tank mix that cannot evaporate; 
values range from 0.0 to 1.0. It is an extremely important parameter. Changing the 
nonvolatile fraction value inserted from the spray system library should be done by 
the user with caution. 

 
4. Spray Lines: Use this section to set flight line information for spraying. Each variable 

has a text entry window for entering the appropriate number for that variable. A choice 
box for selecting a unit of measurement is to the right of the text entry window. 

Figure 11-12. Select Spray System dialog box. 
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a. Release Height Above Ground: This is the flying height of the aircraft; it is 
measured from the ground to the spray boom. 

 
b. Canopy Height: Canopy height is measured from the ground to the top of the canopy. 

AGDISP calculations stop when the canopy height is reached. An entry of 0 gives 
you information about deposition on the ground. 

 
c. Emission Rate: This is the total system flow rate through all nozzles on the spray 

boom. Changing measurement units in this variable does not change the value of the 
emission rate entered because conversion between units of measurement depends on 
other inputs that may be changed before AGDISP calculations are invoked. 

 
d. Swath Width: This is the distance between spray lines (sometimes called lane 

separation or bout width). This variable is used to set the number of flight lines 
needed to spray the block transferred to the Spray Advisor from GypsES. This value 
is automatically written in as 1.2 times the wingspan or rotor diameter when an 
aircraft name is selected. 

 
5. Meteorology  

 
a. Temperature: This is the average temperature during spraying. Choose either the 

Fahrenheit or Celsius degree scale. 
 

b. Relative Humidity: This is the average relative humidity during spraying expressed 
as a percentage. 

 
c. Wind Speed: This is the average wind speed during spraying presumably recorded 2 

m above the ground. Choose the unit of measurement to the right of the choice box. 
 

d. Wind Direction: This is the average wind direction during spraying expressed as 
degrees. Wind direction is measured from north, i.e., a wind blowing from the north 
would be entered as “0” degrees and from the south as “180” degrees. This variable is 
also presumably recorded 2 m above the ground. 

 
6. Nozzles 

 
a. Number of Nozzles: This is the number of nozzles on the spray boom. Nozzles are 

equally spaced along the boom length. 
b. Boom Length: This is the length of the spray boom. This value is written in as 75 
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percent of the wingspan or rotor diameter when an aircraft name is selected. Choose a 
unit of measurement by clicking on the choice box to the right. 

 
7. Output 

 
a. Contour Levels: This is where you specify the contour levels for spray deposition 

results calculated by AGDISP. There are two options for defining spray deposition 
contour levels. If the choice box by “Auto” is selected (indented), SMSADV 
automatically generates three deposition contours at 0.1, 0.01, and 0.001 of the 
maximum value predicted within the spray block. When Auto is not selected, five 
contour level text entry windows are activated and you must enter deposition contour 
levels consistent with the units specified (Fig. 11-13). You can specify up to five 
contour levels, although using more than three levels may clutter your deposition 
contour plot. 

b. Units: Select the units for displaying deposition contours predicted by AGDISP by 
clicking on the choice boxes and selecting the units you want (for example, grams per 
square meter, or g/sq m). The numerator choice box is on top and the denominator 
choice box is below. The predicted deposition includes all released spray material 
that has not evaporated and generally contains more material than just the nonvolatile 
amount because some water binds to the nonvolatile material. Nonvolatile 
mass/volume and drops are conserved by the calculation. 

 
 

Figure 11-13. Spray Advisor (SMSADV) dialog box: Output 
section, user-defined contour deposition levels. 
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8. Calculation Control 
 

a. Run Calculations: This push button starts the AGDISP prediction model; inputs to 
the model and program status are displayed in an SMSADV Calculations dialog box 
(Fig. 11-14). The model generates spray deposition for a single flight line, then 
overlays this information for multiple flight lines on a grid designed to predict 
deposition within the spray block and downwind of the flight lines. 

 

 
b. Check Inputs Only: This push button checks all inputs to the AGDISP model and 

displays them in an SMSADV Calculations dialog box (Fig. 11-15). 
 
9. Return To GypsES: If you have not run the model, this option returns you to GypsES. If 

you have run the model, this option writes the predicted deposition results into a file for 
recovery and plotting by GypsES, then takes you back to GypsES. 

 

Figure 11-14. Sample SMSADV Calculations dialog box: Run Calculations option. 
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10. Spray Advisor Menu Bar Options 
 

a. File 
 

(1) New: Use this option to select a set of default data that is built into the program. 
 

(2) Open: This option opens a previously saved set of input data needed to run 
AGDISP. This brings up an Open dialog box to choose a directory and data file to 
bring into SMSADV (Fig. 11-16). 

 
(3) Save: This option saves the present input data in the current file. 

 
(4) Save As: Use this option to save the current input data under a new filename. A 

Save dialog box appears (Fig. 11-17). 

Figure 11-15. Sample SMSADV Calculations dialog box: Check Inputs Only option.
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(5) Exit and Return to GypsES: This option exits SMSADV and returns you to 

GypsES whether or not you have run the model. GypsES automatically saves the 
last SMSADV setup information in the active mapset. SMSADV brings up the 
last setup information used for a given mapset each time you run it. Deposition 
results files are automatically saved in memory and ready to be displayed in 
GypsES. When you exit SMSADV, you are asked if you want to save either the 
spray contour lines or spray deposition grid (see Exit Spray Advisor on page 11-
26 for more information).  

 
b. Edit: Use these functions to cut, copy, paste and clear the contents of individual text 

entry windows. 
 

(1) Cut: This option deletes highlighted data and stores it in the Windows clipboard.  
 

(2) Copy: This option leaves highlighted data in the text entry window but also stores 
it in the Windows clipboard.  

 
(3) Paste: This option pastes data from the Windows clipboard to a text entry 

window. 
 

  

Figure 11-16. Open dialog box. Figure 11-17. Save dialog box. 



GypsES User’s Manual v1.0 Section 11: The Treatment Menu 

 11-25 GypsES: Decision Support and Project Mgt.  

 
(4) Clear: This option clears highlighted data from a text entry window and does not 

store it in the Windows clipboard.  
 

c. Run 
 

(1) Run Calculations: This is the same option as described on page 11-22. 
 

(2) Check Inputs Only: This is the same option as described on page 11-22. 
 

d. Help: This provides the version number of SMSADV. 
 
After the model has been run and you have clicked on [Exit and] Return to GypsES, the 
remaining push buttons in the “Spray Advisor” palette now apply (Fig. 11-9 on page 11-15): 
 

C. Display Contours: This option displays spray deposition contour lines, color coded for 
different levels of deposition in the units specified in the Spray Advisor (SMSADV) dialog 
box. A temporary file for the deposition contour display is listed in the Window menu / 
Build/Update Map option in the “Current Map Content” list as “SiteData [x] in [mapset y].” 
Click on Modify to change the symbol, symbol color, or data ranges for each symbol (see a 
description of the Site Display Options dialog box starting on page 8-6 for more 
information).  

 
D. Show Dep[osition] Grid: This option displays a grid of SiteData points, color coded for 

different levels of spray deposition. A temporary file for the deposition grid display is listed 
in the Window menu / Build/Update Map option in the “Current Map Content” list as 
“SiteData [x] in [mapset y].” Click on Modify to change the symbol, symbol color, or data 
ranges for each symbol (see a description of the Site Display Options dialog box starting on 
page 8-6 for more information). 

 
E. Show Contour Legend: This option displays a legend for the spray deposition contour lines 

below the “Spray Advisor (SMSADV)” palette.  You can remove it by clicking on Hide 
Legend in the lower right corner of the legend. 

 
F. Show Dep[osition] Legend:  This option displays a legend for the SiteData deposition grid 

points below the “Spray Advisor (SMSADV)” palette.  You can remove it by clicking on 
Hide Legend in the lower right corner of the legend. 
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G. Clear Contours: This option removes any currently drawn contour lines. 
 

H. Clear Grid: This option removes any currently drawn grid. 
 

I. Print SMSADV Inputs: This option sends SMSADV input information to the GypsES 
system default printer. 

 
J. Exit Spray Advisor: This option exits the Spray Advisor option. Upon exiting, GypsES asks 

you if you want to save either the spray contour lines (if displayed) as a Vector file or the 
spray deposition grid before closing the Spray Advisor function.  In either case, click on Yes 
and a text entry window appears to type in the new filename. Click on No to exit without 
saving. 
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Appendix A: Standard Names List 
 
The following table lists the Standard Names used by the GypsES system. Descriptions and 
explanations of each Standard Name as well as the menus in which it is used are included. If a 
Standard Name represents a file that is created by GypsES, it is designated. 
 

Standard Name Description Explanation Reference Menu 
CROWN_COND Crown Condition Raster layer used to 

determine Stand 
Condition. 

Forest/Hazard 

DEFHIST_YRn Defoliation 
History for Year 

n (n=0-4); 
n = 0 for current 

year, 1 for 
previous, etc. 

Raster layer used to 
determine Disturbance 

History. 

Forest/Hazard 

DEFOL_PRED Predicted 
Defoliation 

Raster layer calculated 
from Egg Mass Site Data. 

 Also used with the 
Hazard layer to calculate 

Risk. 

Survey/Suppression/ 
Defoliation Prediction 

 
Forest/Risk 

DISTURB_HIST Disturbance 
History 

Raster layer calculated 
from Defoliation History, 

Drought and Other 
Disturbance layers. 

Forest/Hazard 

DROUGHT_YEARn Drought for Year 
n (n=0-3); 

n = 0 for current 
year, 1 for 

previous, etc. 

Raster layer used to 
determine Disturbance 

History. 

Forest/Hazard 

ELEVATION Elevation Raster layer where 
categories represent 

elevation (m). Used to 
estimate temperature over 
a landscape from a single 
temperature monitoring 

location. 

Treatment/Phenology 

Standard Name Description Explanation Reference Menu 



 

 

EM_PA_SURF_YR0 Egg Mass per 
Acre Surface 

Layer 

Raster layer calculated 
from the current Egg 
Mass Site Data file 

(EM_SVSITES_YR0). 
Used in calculation of 
Defoliation Prediction. 

Survey/Suppression/De
foliation Prediction 

EM_PA_SURF_YR1 Previous Year's 
Egg Mass per 
Acre Surface 

Layer 

Raster layer used in 
calculating the Egg Mass 
Difference layer.  Usually 
linked from the previous 
year's Egg Mass Surface 

layer. 

Treatment/Spray 
Blocks/Post-Treat-

ment 

EM_PACRE_DIFF Egg Mass 
Difference Layer 

Calculated at each cell as: 
EM_PA_SURF_YR0 - 
EM_PA_SURF_YR1 

Treatment/Spray 
Blocks/Post-Treat-

ment 
EM_SVSITES_YR0 Egg Mass Site 

Data Layer 
Site Data layer of Egg 

Mass information for the 
current year. Used in 

calculating the Egg Mass 
Surface layer. 

Survey/Suppression 

HAZARD_RATING Hazard Rating 
Layer 

Raster Layer calculated 
from the Vulnerability 

and Management 
Objective layers. 

Forest/Hazard 

MANAGE_OBJ Management 
Objectives Layer 

Raster layer whose 
categories are tied to 

the Management 
Objectives information in 

the Administrative 
Profile/Management 

Objectives screen 
(MAN_OBJ_DATA). 

Forest/Hazard 

MAN_OBJ_DATA Database file 
which is tied to 

MANAGE_OBJ 

Raster layer. Edit/Administrative 
Profile 

Standard Name Description Explanation Reference Menu 
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OTHR_DIST_YRn Other 
Disturbance for 
Year n (n=0-4) 

Raster layers describing 
other disturbances: 

n = 0 for current year, 1 
for previous year, etc. 

Forest/Hazard 

PHENOLOGY Phenology Layer Raster layer calculated 
from temperature and 

elevation data in which 
categories represent dates 
of estimated user-defined 

target events. 

Treatment/Phenology 

PHEN_GROUP Grouped 
Phenology 

Raster layer calculated 
from PHENOLOGY; 

groups phenology for a 
user-specified number of 
days so that categories 

represent a period of time 
rather than a single date. 

Treatment/Phenology 

RISK_ASSESS Risk Assessment Raster layer calculated 
from the Hazard and 

Defoliation Prediction 
layers. 

Forest/Hazard 

SILVICULTURE Silvicultural 
Activity 

Raster layer in which 
categories represent years 

in which silvicultural 
activity occurred.  Used in 

calculating Disturbance 
History. 

Forest/Hazard 

SITE_FACTORS Site Factors Raster layer describing 
soil types.  Used in 

calculating the 
Vulnerability layer. 

Forest/Hazard 

SPECIES_COMP Species 
Composition 

Raster layer which is 
linked to a stand database. 
 Used only in conjunction 

with National Forest 
databases at this point. 

Forest/Hazard 

Standard Name Description Explanation Reference Menu 
SP_BLKS_VECT Current Year's Vector layer of spray Treatment/Spray 



 

 

Spray Blocks block polygons. Blocks 
SP_BLKS_DATA Database for 

Spray Blocks 
 Treatment/Spray 

Blocks/Data Entry 
SP_SUSCEPT Species 

Susceptibility 
Raster layer representing 
Species Susceptibility to 

gypsy moth.  Used in 
calculation of 
Susceptibility. 

Forest/Hazard 

STAND_COND Stand Condition Raster layer calculated 
from the Crown 

Condition and Stocking 
layers.  Used to calculate 

Vulnerability. 

Forest/Hazard 

STAND_ESTAB Date of Stand 
Establishment 

Raster layer with 
categories representing 

the year a stand was 
established.  Used in 

calculating Stand Age, 
which is used in 

calculating Susceptibility. 

Forest/Hazard 

STAND_MAP Stand Map Raster layer in which 
categories represent stand 
numbers which are tied to 

a stand database.  Used 
only with National Forest 

Databases. 

Forest/Damage 
Prediction 

STOCKING Stocking Raster layer representing 
tree density.  Used in 

calculating Stand 
Condition. 

Forest/Hazard 

SUSCEPTIBILITY Susceptibility Raster layer calculated 
from Species 

Susceptibility and Stand 
Age.  Used in calculating 

Vulnerability. 

Forest/Hazard 

Standard Name Description Explanation Reference Menu 
TRAP_SITE_DATA Trap Site Data Site Data layer used for 

traps in the Eradication 
Survey/Eradication 
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Module. 
TRAP_SITES_YRn Trap Site Data for 

nth Previous Year 
(n=1-4) 

Usually linked from the 
previous year's eradication 

file. 
Used in displaying history 

information. 

Survey/Eradication 

VULNERABILITY Vulnerability Raster layer calculated 
from Susceptibility, 

Disturbance History, Site 
Factors and Stand 

Condition.  Used in 
calculating Hazard 

Rating. 

Forest/Hazard 
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Red, Green, Blue color values for
selecting colors in GypsES

GypsES User’s Manual v1.0 Appendix B

GypsES: Decision Support for Project Mgt.

Each square in the color chart below lists the values (from top to bottom) of red, green, and blue to
create the color illustrated. Sixteen colors are available; you can select and/or customize these using
the menu / option/ option / dialog box /

option described on page 7-42.
Edit Administrative Profile User Profile Global Set Color

Selection

Appendix B: Color Values Chart

B-1
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Software Credits: GypsES utilizes software from the following sources: 
 
X-Windows: 
 GypsES utilizes the X-Windows, XToolkit, and Motif libraries for all graphical interface.  
 
 Xlib & XToolkit: 
   Copyright 1985, 1986, 1987, 1988, 1989 by the Massachusetts Institute of Technology. 
  Copyright 1987, 1988 by Digital Equipment Corporation, Maynard, MA. 
 Motif: 
   Copyright 1989, 1990, 1991, 1992, 1993, 1994  
  OPEN SOFTWARE FOUNDATION, INC.  
     
GRASS:  
 A product of the U.S. Army Corps of Engineers Construction Engineering Research Laboratory 

(USACERL). GypsES utilizes many GRASS file formats and the GRASS file organization 
for GIS data. GypsES also uses GRASS executable programs for file manipulation.  

 
CODEBASE:  
 CodeBase(TM) (Sequiter Software) routines are used to access database (.dbf) files. 
  Copyright Sequiter Software, Inc., 1988-1991.  All rights reserved. 
 
TIFF:    
 Tag Image Format (TIFF) subroutines are used to manipulate and read image information.  TIFF 

Copyrights: 
      Copyright (c) 1988, 1989, 1990, 1991, 1992 Sam Leffler 
      Copyright (c) 1991, 1992 Silicon Graphics, Inc. 
 
JPEG:  
 The JPEG software distributed by the Independant JPEG Group is also used to manipulate and 

read image information. 
  Copyright (C) 1991, 1992, Thomas G. Lane. 
  
MOTIF:  
 Motif Widget code was obtained from various sources, and the following 
 copyrights apply: 
 
 XPM library:    
  Copyright (C) 1989-95 GROUPE BULL developed by Arnaud Le Hors. 
 Smart Message Box: 
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   Copyright 1994 John L. Cwikla (Wolfram Research Inc.) 
 
 AppPlusS:   
  Colormap Initialization & handling: 
   Copyright 1994,1995 John L. Cwikla 
 
 CaptionWidget:  
   Copyright(c) 1992 Bell Communications Research, Inc. (Bellcore).  All rights reserved. 
    Author: Andrew Wason, Bellcore 
 
 ComboBox Widget: 
  Copyright 1993, 1994 Harald Albrecht 
   Institut fuer Geometrie und Praktische Mathematik 
   RWTH Aachen, Germany 
   albrecht@igpm.rwth-aachen.de 
 
 Directory:  Directory Content reader: 
   Author:  Brian Totty 
       Department of Computer Science 
       University Of Illinois at Urbana-Champaign 
       1304 West Springfield Avenue 
       Urbana, IL 61801 
 
 ListTree Widget: 
   Copyright (c) 1996 Robert W. McMullen 
 
 TabsMenu:  
  xvertext 5.0 Copyright (c) 1993 Alan Richardson  
 
  Cell:  
   Copyright(C) Q. Frank Xia (qx@math.columbia.edu), 1994.  
 
   MatrixWidget: 
  Copyright(c) 1992 Bell Communications Research, Inc. (Bellcore).  All rights reserved 
   Authors: Andrew Wason, Bellcore, aw@bae.bellcore.com 
   Andrew Lister (28 Jan, 1996) 
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Glossary 
 
Antecedent: The category value or map layer used to calculate the currently displayed/selected 

category value. Antecedent values are retrieved from the map layers used to create the current 
map layer and can be displayed using the Antecedents button in GypsES. 

 
Back-Up: A copy of (a) files for sake keeping in case the original file is lost or damaged. Back-up 

copies should always be stored away from the original computer. 
 
Category Description: A data value or text description associated with a category number. 
 
Category Number: An integer value associated with a geographic object.  For Raster files, the 

“object” is a cell. For Vector files, the “object” may be a polygon or a feature line.  
Associated with the category number is a line of text or a data value (the category 
description). 

 
Cell: A square within a Raster map layer. Each cell represents an area on the surface of the Earth and 

all cells are arranged in rows and columns. 
 
Closed Polygon: A polygon that is bounded by lines joined ONLY at nodes. 
 
Composite Map: A special type of map layer that may contain multiple map layers, labels, and other 

displayed attributes, including grids and scales. 
 
Contours: After the FSCBG model is run, GypsES can display the spray deposition results for an 

area by use of color-coded contour lines. 
 
Current (Output) Mapset: The selected mapset in the location in which you are working. All files 

created will be stored in this mapset. You can only modify files from this mapset. 
 
Degenerate Line: A line whose individual points (and associated segments) are all within the node 

consolidation distance of each other. 
 
Deposition Grid: A grid of SiteData points, color coded by spray deposition levels.  
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DGPS:  Refers to Differential Global Positioning System, a GPS system that uses a ground station 
or satellite signal to correct scrambled satellite signals so that the pilot knows where the 
plane is while spraying. 

 
Dialog Box: A box on the computer screen that explains information and/or prompts you to choose 

options for carrying out a function in GypsES. Dialog boxes can be moved around the screen, 
but you cannot continue with the GypsES session until the dialog box prompts have been 
completed and the box is closed. 

 
Feature Line: A line that represents a linear feature, such as a road, power line, river, etc. 
 
Font: A set of printable images specified by a collection of attributes. 
 
FSCBG: An aerial spray deposit and drift model; its acronym comes from a combination of the 

agency responsible for funding the model (USDA Forest Service) and the names of the 
primary developers (Cramer, Barry, and Grim). 

 
Full Screen Mode: A window display mode where the current Work Window is displayed on the 

entire creen; other Windows are only visible when they are made the current Window. 
 
Full View: A view of the entire location. 
 
Geographic Coordinate: A pair of numbers that identifies a specific point on the Earth. 
 
Geographic Information System (GIS): A system for preparing, presenting and interpreting data 

that pertain to the surface of the Earth.  GypsES uses a version of GIS called GRASS. 
 
Geographic Layer: A single map file representing specific data. A geographic layer is much like a 

conventional map, a flat drawing indicating the nature, form, and relative position and size of 
selected conditions, but a geographic layer displays only one characteristic. A geographic 
layer can be stored in Raster, Vector, or SiteData format. 

 
Geographic View: Either the entire location or a specified portion of a location that you have 

defined for viewing. 
 
GPS: Refers to Global Positioning System, a navigational tool used by pilots to keep track of where 

the plane is over the Earth’s surface; satellite signals are scrambled and therefore 
uncorrected. 
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Graphical User Interface (GUI): The communication link between you and a software program. 
You decide what to do and communicate this to the computer by moving the mouse pointer 
(arrow) over the option you want on the computer screen and clicking once with the left 
mouse button. 

 
GRASS: This is the GIS used by GypsES; it is a public-domain GIS system under development by 

the U.S. Army Construction Engineering Research Laboratories (USACERL). 
 
Grid: A network of uniformly spaced lines drawn over a map layer to aid you in locating positions. 
 
Hazard (Rating): The probability that forest conditions exist that would result in damage if [gypsy 

moth] defoliation occurred. 
 
Iconify: To reduce the contents of a window to a symbolic representation (icon) located at the 

bottom of the screen. Once a window is iconified, double click on the icon to restore the 
window. 

 
Image Backdrop: An image that is drawn in the background of a Work Window to provide a 

reference point (i.e., a 7.5-minute quadrangle topographic map may be added to help you 
locate points and areas within the location). 

 
Label: Labels can have text, numbers, or both, and are used to display information about polygons 

or feature lines within a map layer. Labels can also be used in a map layer to label points of 
interest. 

 
Layer:  A logical collection of mapped information according to theme for a given location. 
 
Legend:  The part of the map that defines the meaning of the symbols, colors, or both, that are used 

to represent map layer elements. 
 
Line: A line is defined by two or more points; lines consist of segments connected by points. 
 
Location:  Geographically, a location represents a rectangular region on the Earth’s surface, defined 

by the UTM coordinates of the four sides of the rectangle. You can work with any number of 
map layers within a given location. 

 
Map Layer: See Layer.  Map layers may be of four types: Raster, Vector, SiteData, or Composite. 
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Mapset: A working directory within a location. The PERMANENT mapset for every location 
contains static data (data that is not likely to change), such as elevation, soils, roads, 
waterways, etc. Other mapsets contain more dynamic data and can be set up by user, year, 
etc. 

 
Mask:  A special kind of data layer that is used as a “cookie cutter” to display only a selected portion 

of a location (the rest of the location appears in black). When a mask is activated, not only is 
the selected portion of the map the only portion displayed, it is also the only portion used to 
perform calculations. 

 
Menu: A list or series of options in a computer software program from which you select the action 

you want. 
 
Node:  A node is the first or last point of a line. 
 
Node Consolidation: The consolidation of nodes that are within the node consolidation distance of 

each other. 
 
Node Consolidation Distance: The node consolidation distance is a linear distance used by the 

Vector functions in MapEdit to determine when two nodes are close enough that they should 
be treated as the same node.  When a Vector layer is first loaded into MapEdit, nodes are 
consolidated if they are within this distance. This helps close polygons, but if the distance is 
too large, you may have a loss of precision. The proper distance to choose must be 
determined for each layer, usually by experimentation. 

 
Open (Unclosed) Polygon: A polygon bounded by lines that end in a node with no other lines 

attached.  
 
Output Mapset: See Current (Output) Mapset. 
 
Overlay: An overlay allows you to display more than one Raster map layer on the screen at a time. 

Once the first Raster layer is drawn, the next layers will be drawn ONLY in those areas 
where the first map layer was coded as having “no data.” 

 
Pixel: The computer screen, like a Raster map layer, is divided up into very small cells called pixels. 

Pixel is an acronym for Picture Element. 
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Point: A point represents a specific location on the surface of the Earth.  It is defined by a 
geographic coordinate. 

 
Polygon: A polygon is an area on the surface of the Earth defined by one or more lines. For the 

polygon to be closed, the lines must attach to each other at their end points (nodes) and must 
NOT intersect anywhere else. 

 
Polygon Line: A line used to define a closed area on the surface of the Earth. 
 
Raster: The raster (cell) is the basic unit used by the GRASS GIS when working with Raster map 

layers. It represents a square on the surface of the Earth; the dimension of this square is 
called the resolution. 

 
Raster Map Layer: This is a map made up of a regular array of cells (representing rows and 

columns of the display). 
 
Reclass: This is a new Raster map layer based on the association of categories from an existing 

Raster map layer to new category values. The new Raster layer is stored as a reference to the 
original layer with references between the new and old categories. 

 
Record: A set of related data in a data table; each record contains all defined data fields. 
 
Resolution: This is the dimension of a raster (cell). Resolution represents a measure of image 

sharpness. 
 
Resultant: A Raster map layer that results from the combination of input (antecedent) Raster map 

layers. 
 
Risk: The probability that stand damage will occur due to defoliation. 
 
Scale: A representation of the relationship between the size of elements on a map and the real world. 
 
Segment: A segment is a part of a line that falls between two points.  A segment is always a straight 

line. 
 
Silviculture: The art and science of tending forest crops; this includes any forestry activity which 

modifies existing forest conditions, i.e., thinning, clearcutting, spraying, etc. 
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SiteData Map Layer: A map layer that has data values associated with points. 
 
Stand: A forested area that is managed as a unique entity; stands may be delineated by tree species, 

age, forest structure, disturbance history, or management objectives, among other criteria. 
 
Standard Name: A unique filename that is used for specific internal calculations by GypsES; its 

name does not change. If a map layer file is linked to a Standard Name, this file is used by 
GypsES in performing calculations. 

 
Surface Map Layer: A surface map layer is a Raster layer created from a SiteData layer by 

assigning Raster category values that correspond to SiteData values at or near the Raster cell. 
 
Susceptibility: The likelihood that a forest stand will be defoliated. 
 
Tile Mode: A Work Window display mode where each of the four Work Windows are 

simultaneously displayed on one quarter of the work area and the current Window has a 
yellow outline around it. 

 
US Geological Survey DLG: Refers to US Geological Survey Digital Line Graphs, which are 

digital representations of cartographic information.  Features include roads, hydrology, and 
rail lines; these graphs are free via downloading from the Internet.   

 
UTM (Universal Transverse Mercator) Coordinates: UTM coordinates are often referred to as 

“Northing” and “Easting.” They represent the distance north and east, respectively (in 
meters) from the corners of a series of rectangular zones on the face of the Earth. 

 
Vector Map Layer: A map layer that contains lines (feature and polygon). 
 
View File: This is a file that saves a specific geographic view for you; the view file may be retrieved 

later within GypsES. 
 
Volatile Fraction: The fraction of spray material that can evaporate; values range from 0.0 to 1.0. 
 
Vulnerability: The likelihood of mortality given that defoliation has occurred. 
 
Zoom: The capability for enlarging or reducing the scale of the map layer being displayed. 
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